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There are battery packs, there are Qi charging mats, and there are wireless streaming devices. 

Well, GoSpace is all three in one. It creates its own wireless network, so you can stream files 

to eight devices at once using 5GHz Wi-Fi, or connect it to Google Drive and Dropbox. It contains 

a 5,500mAh battery, and you can charge your devices either wirelessly or using the USB-A 

and USB-C ports. There’s even an SD card slot. GoSpace’s combined talents make it ideal 

for travelling, saving you space (and money) when you’re out and about.

 From $99 (about £71)  WEBSITE getgospace.com

 INCLUDES GoSpace drive, USB-A to USB-C cable

GoSpace

 iOpener
Game-changing tech from the world of Apple and beyond

A 3-in-1 device that’s great for frequent travellers

The GoSpace drive creates its own 
wireless network to transfer  

files and stream content.
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With GoSpace, 
there’s no monthly fee 
like you get with some 

cloud-based storage.

You can charge 
devices using Qi 

wireless, USB-C or 
regular USB-A.
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 We know you’ll be eager to get 

outdoors and enjoy the world away 

from screens this summer. But, you 

have things to do on your Mac and 

iOS devices – so why not get them 

done faster with this issue’s massive 

collection of timesaving tips!

For the short time it’ll take you to 

read them, the shortcuts and clever 

techniques you’ll learn will help you 

to use your Apple kit more efficiently, 

with the knock-on effect of getting you away from the digital 

abyss to spend quality time with family and friends.

Security and privacy concerns have been in the news 

a lot recently. Well, they never really go away. So, in this issue 

we also explain the features Apple has baked in to your Mac 

and iOS devices, and what extra steps you should take to 

bolster the basics. You’ll certainly want your iPhone and iPad, 

at the very least, to be locked down like Fort Knox when you’re 

soaking up the summer sun!

While you’re doing that, you’ll almost certainly be taking 

photos of the great outdoors with a smartphone. The iPhone 

is excellent for this, but there’s always room for improvement. 

This issue’s MacFormat Investigates looks at recent advances 

in phone camera tech. Also check out this issue’s round-up 

of travel accessories for your summer jaunts on page 86. 

Remember to send us your iPhone snaps, too – see page 104.
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Apple designs circular Watch

erhaps one of the defining features 

of the Apple Watch is its shape, 

which differs significantly from 

most of its smartwatch rivals. Where many 

other watches have opted for a traditional 

circular face design, the Watch has steadfastly 

remained rectangular since its inception. But 

that may change in the future thanks to a 

patent recently awarded to Apple.

There are plenty of Android watches 

available with circular faces, from companies 

such as Huawei, Motorola and LG.

One reason Apple might have declined to 

make a circular Watch in the past, however, 

could be because rectangular pixel arrays 

do not fit efficiently into a circular display – 

the company certainly noted this problem 

on its patent application. Circular displays 

can end up with notable bottlenecks where 

signal lines become overcrowded, thus limiting 

Patent details a way to overcome circuit issues

HOT TOPIC!

P

 macformat.com  @macformat
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Apple’s patent concerns 
how Watch’s interface would 
work on a circular display.
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Releasing a circular Watch 
would refocus the device back 
towards the fashion market

THE POLL

 Log on and see next 
issue’s big question!
twitter.com/macformat
facebook.com/macformat

WE ASKED… What’s your 
main messaging app on iOS?

Facebook 
Messenger

33%

2%

WhatsApp

Other

iMessage 
(including 
SMS) 

60%

5%

pple has always been hot on 

privacy, and that’s reflected 

in a crackdown on certain 

apps on the App Store. Specifically, 

Apple has begun removing those that 

share your location data with third-

parties “for unapproved purposes” and 

without your permission.

Apple is now also requiring apps 

that use your data to make it clear 

exactly where and how this information 

will be used.

If an app has been removed for this 

reason, Apple states that the offending 

code, framework or SDK must be 

removed from the app before it can 

be resubmitted to the App Store.

To control how your iOS apps 

use your location information, go to 

Settings > Privacy > Location Services.

App Store 
crackdown
Apple is removing apps that 
take liberties with location info

A

their efficiency. They also have large 

inactive areas around their edges that 

contain no pixels, and so can’t display 

anything in those regions.

Apple’s patent details a system that 

would allow the company to overcome this 

issue, essentially by building a circuit that 

utilises the inactive areas of the face using 

curved and ‘serpentine’ circuits to counter 

the curved edge of the watch.

Interestingly, the patent was filed by 

Apple in June 2015, two months after the 

first Apple Watch debuted. That suggests 

this is not an idea Apple abandoned even 

before the original Apple Watch went on 

sale. At the very least, it seems the 

company could be more open to the idea 

of ditching its rectangular design than we 

had previously thought.

Back when it was first launched, Apple 

aimed the Watch squarely at the fashion 

market. It opened exclusive Watch-only 

stores and released the expensive Watch 

Edition to try to entice high-end buyers. 

Since then, it has switched the Watch’s 

marketing to aim more at fitness-oriented 

buyers. Releasing a circular Watch would 

refocus the device back towards the 

fashion market as an option to potential 

buyers who dislike the current design.

This is the second patent that Apple 

has been granted relating to a circular 

Watch. In April 2018, it won a similar 

patent (also filed two months after the 

first Watch was released) relating to 

device displays that could be circular 

or curved. Of course, these are 

merely approved patent applications, 

but a product based on them could 

be announced as soon as September. 

The absence of parts from the supply 

chain suggests a circular Watch would be 

further off, but note that 

Apple is cracking down on 

leaks – an internal memo 

warning employees about 

them was itself leaked to 

Bloomberg News in April.
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Siri rival Google 
Assistant’s big 
step forward

> In the race for smart 

assistant dominance, Google 

has taken a big step forward. 

At its recent I/O conference, 

the company showed off 

updates to Google Assistant. 

Among the most interesting 

was its ability to conduct phone 

conversations with people on 

your behalf. During the show, 

Google Assistant was able to 

understand nuances such as 

a restaurant worker explaining 

that tables could not be booked 

for small parties.

The update puts pressure 

on Apple to bring meaningful 

improvements to Siri, which is 

widely considered to be trailing 

behind rivals’ capabilities.

Other updates announced 

at I/O included the ability to 

string multiple actions into 

a single voice command, 

something Siri 

is unable to do.

Siri needs to step 
up to compete with 
Google Assistant.

Apple is clamping down on third-party apps using 
location info without your explicit permission.



 macformat.com  @macformat
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T
he security exploit 

Spectre was big 

news at the start 

of 2018. It affected major 

processor manufacturers and 

put many devices, including 

Macs and iPhones, at risk.

Despite patches from the 

major vendors, the threat is 

not over, according to security 

researchers. Processor firm 

Intel has been notified that up 

to eight new Spectre-like flaws 

have been discovered in its 

chips. According to Patently 

Apple, Intel has rated four of 

the flaws as ‘high risk’ and 

the other four as ‘medium 

risk’. According to its own 

research, the website notes 

that one of the flaws presents 

a “significantly higher” risk 

than Spectre.

That’s because it could 

allow someone to attack a host 

system (such as a cloud server) 

from inside a virtual machine 

(VM), or attack the VMs of 

other uses on the same server. 

It’s unknown how Apple 

devices will be affected, but 

if your Mac runs on an Intel 

chip then it might be at risk. 

The specific details of the 

eight exploits have not been 

revealed; Intel is updating its 

processors to address Spectre, 

and hopefully will fix these 

bugs as well.

New chip 
exploits 
discovered
Eight new Spectre-like 
flaws found that might 
affect Apple devices

W
ith only three months left until 

Apple is expected to unveil new 

iPhones, news is emerging of a 

rumoured ‘iPhone X Plus’. Japanese outlet 

Mac Otakara reports that the larger version 

of the iPhone X will be roughly the same size 

as the iPhone 8 Plus, which has a display 

measuring 5.5 inches across.

However, it says the iPhone X Plus will 

come with a 6.5-inch display. The discrepancy 

in screen sizes between that and the iPhone 8 

Plus is due to the much larger bezel on the 

latter; by largely eliminating the bezel, 

the iPhone X Plus would be able to integrate 

a much larger display in a phone that’s overall 

Face ID, camera sensor and handset size upgrades expected Apple has announced 

that all of its facilities, 

including retail stores, 

offices, data centres 

and co-located facilities, 

are now completely 

powered by renewable 

energy. The facilities 

are located across 

43 different countries. 

As well as that, nine 

more of its suppliers 

have also committed to 

running on 100% green 

energy; 23 of Apple’s 

suppliers now do so.

 After more than a year 

of speculation, Apple 

has announced that it 

will be discontinuing the 

full range of its AirPort 

routers. It will continue 

to sell the routers on its 

websites, but only while 

stocks last. In November 

2016 it was reported 

that Apple disbanded 

its AirPort development 

team, and in January 

2018 it started selling 

third-party routers on 

its website. So, the end 

of AirPort is not much 

of a surprise.

close to the size of the iPhone 8 Plus.

Mac Otakara also reports that the iPhone 

X Plus will be slightly thicker than the 8 Plus, 

at 7.7mm thick. That’s apparently due to the 

way the camera is mounted.

The site also claims the regular iPhone X 

will be refreshed, with a larger camera sensor 

and lens. There are no details on how this will 

impact camera performance, though.

Face ID will also work in horizontal 

orientation on both the iPhone X and X Plus 

(at present it only works when  you hold the 

phone vertically). With Face ID expected to 

soon arrive on a refreshed iPad Pro, this 

improvement would make a lot of sense.

APPLE 

NEWS 

ROUNDUP

USES 100% 

GREEN ENERGY 

ACROSS GLOBE

APPLE AIRPORT 

DISCONTINUED

WILL ONLY BE 

SOLD WHILE 

STOCKS LAST

iPhone X Plus rumours swirl
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Oddmar  
£4.99

 Join the titular 

Viking on his quest 

to earn his place 

in Valhalla. Platform-based 

action and puzzles stand in 

the way of Oddmar’s journey 

to heaven for Norse heroes. 

The quality of animation here 

is great, reminding us of 

Ubisoft’s Rayman Run series.

Why you need it: Check out 

the trailer! bit.ly/oddmarvd

What’s it best for: Sheer fun, 

and gorgeously animated.

WWF Free Rivers 
FREE

 Explore the impact 

of environmental 

changes to free-

flowing rivers that arises 

from human activity. This app 

uses Apple’s ARKit tech to 

display a 3D landscape on a 

tabletop, ready for you to 

interact and learn about 

sustainable development. 

Why you need it: It’s an 

informative use of ARKit.

What’s it best for: Learning 

about our effect on the world.

 Neko Case never 

seems to be short 

of an evocative lyric, 

and her strong vocals burst 

with indelible personality – 

something that’s abundantly 

plain from her contributions 

to two New Pornographers 

albums in the five years since 

her previous solo album.  

Why you need it: To hear 

Case’s impressive voice.

What’s it best for: Glorious 

and unapologetic style.

 The fonts you choose for your 

designs can be make or break 

when it comes to effectiveness. 

Maybe you use Apple’s Font Book 

or duplicate text to compare words in different 

styles. TypeFace 2 provides you with advanced 

options for managing and comparing them.

What swings a design decision can be a 

subtle difference in a character. TypeFace can 

overlay one font over another in a kind of X-ray 

[ M O V I E ]

Black Panther 
£13.99

 Power struggles, truly 

charming characters 

relatable risk to the 

world, and a believable 

foe make this one of 

Marvel’s best films.

[ P O D C A S T ]

Data Skeptic  
FREE

 Does scientific thinking 

turn you on? This show 

puts all sorts of topics 

under the microscope, 

from game theory to 

quantum computing.

[ T V  S H O W ]

Episodes (Series 5)
£14.99

 Episodes ends its run 

on a high by ramping 

up the disregard for 

consequences shown by 

its fictionalised take on 

Friends’ Matt LeBlanc.

view to highlight these. Will your choice depend 

on a particular character’s availability? Choose 

more easily by filtering out fonts that lack it.

The app’s font management goes beyond 

the manually built and criteria-based collections 

of Font Book, giving you the ability to tag fonts, 

based on whatever subtle criteria you choose, 

to make them easier to find later on. Despite its 

capabilities, TypeFace’s window is lean, hiding 

its sidebar till you drag something.

Hell-On 
Neko Case £8.99
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APPLE 
TV
 Our top picks 

of what’s worth 
watching and 
playing this month

[ i O S  G A M E ] [ i T U N E S  S T O R E ][ i O S  A P P ]

APP OF THE MONTH

TypeFace 2 £19.99
[ M A C  A P P ]

A powerful yet easy-to-use alternative to macOS’s Font Book
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We take a look at the workings of Apple’s 
authentication feature, and face up to 
the dots, attempts and happiness counts

IN NUMBERS
FACE ID

> In a survey of iPhone X users by Experian 

and Creative Strategies, more than 90% of 

owners said they were happy with Face ID.

> If you haven’t unlocked your iPhone X using Face ID 
for more than 48 hours (or haven’t unlocked it with a 
passcode in 156 hours and Face ID in the last 4 hours), 
you’ll have to unlock it with your passcode.

> Only one person can register 

facial data with Face ID, unlike 

Touch ID, which allows you to 

register multiple fingerprints 

(up to five) from different people.

> Apple claims the chances a random person 

could fool Face ID are one in a million, and that 

the odds for Touch ID are one in 50,000.

1

> In order to accurately analyse 
your facial features, iPhone X’s 
TrueDepth camera projects over 
30,000 invisible dots to create 
a depth map of your face.

30,000

> An imposter can’t keep trying to trick 
Face ID indefinitely – your passcode is 
required after five failed attempts.

1

3

1 in 1,000,000

5x

2

5

4

6



In iOS 11, point the Camera 
app’s photo mode at this QR 
code to download our app.

*First-time digital subscribers only.

Start a 30-day  
digital trial

and get an issue for free*
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For our latest 
subscription offer 

see page 34!

WRITTEN BY ALEX BLAKE 

A
fter years of incremental changes 

and slight improvements, Apple 

came out with a radical camera 

upgrade in the iPhone 7 Plus. 

That was the first iPhone to feature two cameras 

on the back, giving it a big advantage over earlier 

models. With it came new features: a telephoto lens 

with 2x optical zoom and 10x digital zoom; Portrait 

mode, which blurs backgrounds in pictures for 

a depth-of-field effect; and a new Image Signal 

Processor to handle your photos.

The camera in the iPhone 7 Plus put Apple at 

the forefront of mobile phone camera technology. 

But since then, it’s arguable that Apple has not 

stretched that lead – rather, its competitors have 

made a serious attempt to catch up with – and 

even surpass – the Cupertino giant.

When cameras first made a splash on mobile 

phones, the immediate goal for all involved seemed 

to be increasing the megapixel (MP) count as much 

as possible. That’s not surprising – the rear-facing 

camera in the original iPhone was just 2MP – but 

since then the focus has shifted, and megapixels 

aren’t much of a selling point any more.

Beyond a point, having a higher megapixel 

count doesn’t mean you’re taking better pictures, 

just bigger pictures. For mobile phones and their 

limited storage, that’s not always a good thing. 

As well as eating up your storage space, larger 

megapixel counts also make it harder to upload 

pictures or to shoot quick bursts of shots. 

Furthermore, more megapixels means having 

to fit more information into the phone camera’s 

sensor, which itself is very limited in size. As a 

result, your pictures can end up with more noise.

These days most phone makers have settled on 

12MP or so for their rear-facing cameras. Instead, 

these companies are looking for other ways to 

differentiate their phone cameras. So what are 

they working on in their latest phones? And what 

tech is Apple developing to give its cameras an 

edge once more?

Machine learning
One way that all phone makers can advance their 

devices is through artificial intelligence (AI) and 

machine learning. These technologies are hot 

among the world’s phone manufacturers, and 

integrated cameras have not escaped their touch.

Google Pixel 2, for example, only has one 

rear-facing camera but is still able to create the 

kind of portrait mode effect the iPhone achieves 

What lies ahead for 
iPhone cameras?
Apple is facing stiff competition for the camera  
crown – is it still king of the smartphone shooters?



Fighting to get your focus… 
The tech giants are exploring 
many ways to improve our 
smartphone cameras.
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with two. It does that with what it calls dual- 

pixel autofocus, which essentially divides 

each pixel into two so that the camera can 

ascertain the depth of objects in the frame. 

Once it has done that, it automatically applies 

a blur to the background elements. This also 

means you get portrait mode on the front 

camera, which iPhone 8 and earlier do not.

Of course, imitating a dual-lens camera 

system using only one lens will not be perfect 

every time. But it’s an interesting example of 

the way the tech may be moving – if you can 

achieve a convincing portrait mode effect 

using only one lens, you can potentially save 

space inside the phone for other components, 

which Apple has always been keen to do.

Google isn’t the only company making use 

of artificial intelligence to improve its phones’ 

cameras. Huawei has done something similar 

in its new P2 Pro phone, the camera of which 

has received excellent reviews. Its Master AI 

system can detect more than 500 different 

scenarios, using this analysis to automatically 

adjust the camera’s settings appropriately. 

For example, if it detects people in the photo, 

it can activate portrait mode for you.

Huawei is an example of a company trying 

to make its phone camera easier to use – to 

instantly adjust settings and presets to predict 

what you want without you having to lift a 

finger. It shows how the improvements to 

smartphone cameras we’ve seen recently 

haven’t just come in hardware, but in how 

that hardware interacts with the phone’s 

on-board software in new ways.

Lenses in focus
Of course, hardware is still very important 

to these high-end cameras. The P20 Plus, 

for example, is one of the first to make use 

of three lenses for photography – the Lenovo 

Phab 2 Pro and Asus ZenFone AR also have 

three lenses, but they are used for augmented 

reality (AR), not photos. That trio consists 

of a 40MP colour camera with an f/1.8 lens, 

a 20MP monochrome camera with an f/1.6 

lens, and an 8MP telephoto camera with an 

f/2.4 lens (the monochrome camera is used to 

add extra light, depth and detail information).

According to Taiwan’s Economic Daily 

News, Apple could follow suit in 2019 with 

its own triple-lens iPhone, equipped with 

a trio of 12MP cameras (although what 

exactly the third lens would be used for 

remains unclear). On iPhone X, iPhone 8 and 

iPhone X is 

currently the 

only model to 

take Portrait 

mode selfies

Getting a raw deal >

More pixels doesn’t always 
mean better pictures, but it 
does mean that images can 
go bigger without too much 
loss of clarity.

Edited rawJPEG Unedited raw

One of the main limitations of 

Apple’s Camera app is that it 

can’t shoot raw files. These files 

capture much more information 

than JPEGs (they give you the raw 

sensor data) giving you more room 

to manipulate images later on.

Of the three images shown on 

the right, the left section shows a 

JPEG as shot by a DSLR camera. 

In the middle is an unedited raw 

file, while the right image is an 

edited raw file, showing how 

much scope there is to alter it.



Phone camera tech APPLE CORE

JULY 2018 | MACFORMAT | 17

8 Plus, the rear-facing cameras are all 12MP.

Apple’s main rival Samsung, however, is 

doing things a little differently. In its flagship 

Galaxy S9 Plus phone, it’s stuck with two rear 

cameras, but has an interesting trick up its 

sleeve: the main camera has a dual-aperture 

lens. This means that in low light conditions 

the phone automatically switches to an f/1.5 

aperture, letting more light hit the sensor in 

order to make up for the darkness. In more 

favourable lighting, the lens switches to an 

f/2.4 aperture, which enables it to focus on 

achieving high levels of sharpness in the 

images it produces. Consequently, reviewers 

have lauded the S9 Plus’s photographic 

performance, especially in low light. In tests 

by reputable imaging website DxOMark, the 

S9’s camera received a score of 99, the highest 

score of any phone camera the website has 

reviewed – in fact, it scored 104 for its photo 

capabilities and 91 for video.

Sony, meanwhile, is also making headway 

in low-light photography, making use of its 

expertise in the DSLR arena to improve its 

smartphone cameras. In its new Xperia XZ2 

Premium phone, for example, you can shoot 

photos at up to ISO 51200, giving it a big boost 

in low light conditions.

The question now is whether Apple is 

going to replicate – or surpass – the features 

that have already made it into its competitors’ 

impressive cameras.

Apple’s patent plans
While these developments from its rivals 

appear to leave Apple in the dust in some 

regards, there are plenty of reasons to be 

hopeful for Tim Cook and co. A number of 

patents relating to Apple’s camera technology 

might provide us with some interesting hints 

as to what Apple is planning.

A patent published by the US Patent and 

Trademark Office (USPTO) in March 2017 

suggests that Apple might be working on 

a system to create 3D images using your 

iPhone. The patent shows that the system 

would compile “a relatively small number 

of basis images” to create a 3D image, rather 

than the dozens of pictures that are normally 

required. The patent also notes that the new 

system might be able to simulate “shadows 

and parallax artifacts” in some instances.

That’s not the only interesting camera 

patent from Apple that has recently emerged. 

A patent published by the USPTO in October 

2017 suggests that Apple is developing a 

camera lens made up of six layered lenses. 

This would allow it to greatly reduce – or even 

totally eliminate – lens flares in your photos.

Further Apple patent applications for 

enhancing smartphone cameras include its 

own accessory system to augment a phone’s 

built-in lenses. That’s something third parties 

already cater to, but Apple’s proposed system 

would use a ‘Sensing Technology Interface’ 

to analyse the alignment of an accessory 

and adjust the phone’s built-in lens to match. 

Naturally, Apple continues to look at ways 

to improve existing features. An application 

from February 2017 talks about using shock 

absorption components as a physical method 

of assisting optical image stabilisation.

With the first generation of Face ID’s 

depth-sensing camera only on iPhone X 

at present, expect front-facing camera 

tech to evolve rapidly too, especially 

as more models gain this hardware. 

Tim Cook has made his excitement 

clear for what AR might enable in 

the future – surely more than Apple is 

currently doing, with novelties such as 

Animoji and the Clips app.

DSLR or iPhone?
Apple has come a long way since 2007’s 2MP 

iPhone camera. These days its smartphone 

shooter is, in some ways, able to compete 

with entry-level DSLRs for casual use.

Of course, there are plenty of reasons to 

buy a dedicated camera instead of relying on 

a phone – high-quality, changeable lenses and 

manual controls, say – but the camera tech 

in smartphones continues to advance apace. 

Apple and its rivals are doing great work 

here, and that competition, and applications 

such as AR, are sure to keep it going for years.
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The limitations of iPhoneography >

Is Apple going 

to replicate – or 

surpass – the 

features of its 

competitors’ 

cameras?

The iPhone helped kill off feature 

phones, and it also seems to have 

done a number on DSLR cameras. 

Still, despite sales plummetting, 

there are still reasons to purchase 

a mirrorless camera or DSLR.

For one thing, you get a much 

broader choice of lenses with a fully 

fledged digital camera. Whether 

you want a macro lens or one with 

a high telephoto rating, you’re 

much better served with a DSLR.

You’ve also got a far greater 

range of shooting options with a 

dedicated camera. You can lower 

the f-number in order to get better 

low-light performance, or adjust 

the white balance to suit your 

surroundings. While iOS apps can 

do some of these things, they are 

still very limited compared to 

mirrorless cameras and DSLRs.

Smartphone camera tech is 
moving fast but DSLRs continue 
to provide more finite control.
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Looking for a database? Need it to work with macOS, 
iOS and even watchOS? TapForms has you covered.
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Apple price drop?
 We’ve all grown used to paying a premium 

price for Apple products here in the UK, 

especially so after the price hike a couple 

of years ago after the Brexit referendum.

It was encouraging to note recently 

that the greenback was exchanging above 

1.40 to the pound, very close to early 2016 

levels. If this trend continues, it’d be really 

nice if Apple would consider reducing its UK prices once again, perhaps in 

September with product upgrades, as a bonus to those of us who are still 

loyal to the brand but unlucky enough not to be able to benefit from the 

recently announced share buy-back. Or is this just wishful thinking?

B Y  J O H N  F R A S E R

ALAN SAYS… I was fortunate to avoid the price hike on my iPad Pro, 

but will definitely share your pain if I need to replace my iMac all of 

a sudden. The good news is there are small signs of favourable price 

adjustments already. The latest 9.7-inch iPad shaved £20 off the price 

of its predecessor, and Apple Pencil is now bang in the middle of the 

price at its 2016 introduction (£79) and last year’s peak (£99).

Apple sets prices according to expectations in the long term, and 

though sterling has indeed strengthened in recent months, the ongoing 

Brexit issue, the emerging threat of a broader trade war, and that (at 

the time of writing) the pound isn’t quite 

back to where it was two years ago make 

it seem likely we’ll see slow, steady 

concessions until the economic outlook 

becomes more predictable.

WIND IT BACK
 Your response to Jason Vaughan’s inquiry 

about a consumer-focused database might 

have mentioned TapForms (tapforms.com).

When FileMaker discontinued Bento, 

I discovered and was blown away by the 

power and simplicity of this software!

It works seamlessly on the Mac, iPad and 

iPhone – I use Dropbox to sync the data. 

Might be a welcome suggestion – you gave 

it your highest rating in March 2014!

B Y  D R  J O H N  M  B O N N

ALEX SAYS… Thanks for reminding us 

about TapForms, which totally slipped our 

 LETTER OF THE MONTH!

Have your say on all things Apple!

 LETTER OF 

THE MONTH

minds when replying to Jason’s letter. 

TapForms is still actively maintained, having 

received a mix of fixes and small but handy 

features in recent updates. Perhaps it’s time 

we took another look at how useful it is, this 

time in our Apple Skills section.

INTO THE SUNSET
 Great to read the newsletter in my email 

box today. However, after reading about 

Apple scrapping AirPort routers. I’m very 

disappointed. I’ve been using Time Capsule 

for quite a while and love it.

I’m now a bit confused as to what I can 

do to back up all my devices to one device. 

Do I go down the route of using Apple’s 

server? Or have multiple disks everywhere 

to back up to. I’m hoping you can shed some 

light on my options, as I haven’t a clue! 

B Y  A L E X  B E S N I E R - C H A M B E R L A I N

JO SAYS… I’m also sad about this, though it 

frustrates me that AirPort doesn’t cater to 

iOS backups (which require iTunes or iCloud).

AirPort kit hasn’t stopped working just 

because of this news, but you’ll need to know 

about fallbacks in case yours does down the 

line. This sounds like a group test to us!

Features in macOS Server are changing, 

but Time Machine appears not to be one due 

for the chop; so, Server remains an option 

for backups, if you’ve a spare Mac to run it.

Win yourself a 
BentoStack XL
 The author of our Letter 

of the Month gets a prize: 

a BentoStack XL to keep 

cables safe and tidy on 

a desk or in a bag. Learn 

more at function101.com 

and get 30% off until 

19 November by entering 

promo code FORMAT.



Affinity Photo COMPETITION

Win! 

 macformat.com  @macformat

 To enter, you can visit our website at bitly.com/affinityipad (web address is case sensitive).

  For full terms and conditions, go to bitly.com/affinityipad. By sending your entry, you 

agree to these competition rules and confirm you’re happy to receive details of future 

offers and promotions from Future Publishing Limited and carefully selected third parties. 

 This competition closes on 2 July 2018. Over 18, GB residents only.

  Email addresses of the winner and runners-up will be shared with Serif Labs to enable it 

to provide prizes. Serif Labs will not use them for marketing purposes.

HOW TO
ENTER…

  For editing photos on an iPad using 

a powerful and professional toolset, 

look no further than Affinity Photo. 

Also available for the Mac and 

Windows PCs, Affinity Photo received 

five stars and an Editor’s Choice award 

in our review (see MF #317). We praised 

the way the app, originally made for the 

Mac, has been adapted to a touchscreen, 

the software’s responsiveness, and the  

comprehensive toolset it offers.

Affinity Photo for iPad includes 

everything you’d expect of a great image 

editor: an unlimited number of layers; 

masks and blending modes to enable 

creative interactions between layers; 

a healing brush that removes defects 

using data sampled from elsewhere in 

an image; the ability to refine selections 

to capture fine details, and many other 

impressive capabilities.

Serif Labs, which develops Affinity 

Photo, has provided a bumper prize 

bundle for us to give away. The overall 

winner will receive a brand-new 9.7-inch 

iPad, Affinity Photo to run on it, and an 

Apple Pencil. We also have 10 runner-up 

prizes of a copy of Affinity Photo – and 

you get to choose whether you receive 

the Mac, iPad or Windows version. 

The new iPad, Apple 
Pencil & Affinity Photo!
Get creative with a 9.7-inch iPad 
and the best photo editor for it!

£620

PRIZES 
WORTH
OVER

PLUS

10
runners-up
win Affinity 

Photo
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> THE QUESTION
We’ve got a 9.7-inch iPad with an 

Apple Pencil and Affinity Photo for 

the overall winner, plus 10 runner-up 

prizes of Affinity Photo. For your 

chance to win, answer this question:

For how many platforms is 
Affinity Photo available?
A) 2

B) 3

C) 4

For more information about the 

Affinity family of apps for Mac, iPad 

and Windows, visit affinity.serif.com.



MATT BOLTON…

A lot of tech companies have a big blind spot when it comes to 

design. Steve Jobs famously said that Microsoft’s problem 

was that “they just have no taste”, a barb that felt almost 

cruel in its precision. In the era of tech firms getting into 

interior design, effectively, by creating smart home 

products, it now fits more as a jab against a whole 

industry than one against Redmond.

Recently, I saw a template design from Amazon of a 

possible smart lamp with Alexa built in. It was basically 

an Echo Plus, but the top three quarters are a tube of 

light instead of silver plastic. And it was exactly as ugly 

as that sounds. The Amazon Echo is, subtly, an excellent 

piece of technical design that actually avoids some pitfalls 

that Apple itself fell into, even though it had the Echo 

around for two years to learn from. I’m mostly thinking of 

the indicator light – the HomePod’s is only visible from above, 

whereas the ring of lights indicating 

Alexa activity runs around the top 

corner of the Echo, so it can be seen 

from any angle. It’s built really well 

as a tech product… but it also looks 

like a tech product. The second-gen 

version added a cladding of fabric 

or wood veneer to fit in better, but 

the end result was, still, very techie; 

a faintly monolithic tower that appeals to the sci-fi fan in all of 

us, but less so the home makeover show fan. 

I think the HomePod is the best-looking smart speaker not 

because it is an especially pretty design, but because it is the 

most innocuous. That’s less of an endorsement of Apple as it is 

an indictment of the rest. Smart hubs are often hunks of plain 

plastic, cameras are shiny eyesores, air quality sensors 

foul up the place… there have been some great smart 

home designs, though they’ve often been from Yves 

Béhar, and he can’t design literally everything.

I think part of the problem is that they’re still 

designed with the tech in mind first, then a nice veneer 

is added. But if you want to sell an air quality monitor to 

someone, maybe it should be something they want to 

have visible in their home first. I remember, back when 

Habitat was an upmarket store, it collaborated with 

shoe maestro Manolo 

Blahnik on a striking 

metal shoehorn. It was 

almost impossible to 

APPLE CORE Opinion

Adding a wood veneer to the Echo 
doesn’t suddenly make it homely – 
the stark straight lines and sharply 
drilled holes are borderline brutalist.

Mondaine’s Connected Wall Clock is a classic 
design (that Apple once emulated for the 
iPad’s clock), updated with Bluetooth smarts.
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ABOUT MATT BOLTON

 Matt is the editor of Future’s flagship

technology magazine T3 and has been

charting changes at Apple since his

student days. He’s sceptical of tech

industry hyperbole, but still gets warm

and fuzzy on hearing “one more thing”.

Smart tech is still 
designed with 
tech in mind, and 
a veneer added

HAS A HOUSE HE’S WORKED HARD 
TO MAKE PRETTY, SO WHY WOULD 
HE WANT TO FILL IT WITH UGLY 
SMART HOME TECH?

get hold of, and not because there was 

a sudden need to subdue stubborn footwear. 

It was an objet d’art in its own right, and 

people wanted to display it.

Mondaine, a famous Swiss clockmaker, 

just released a wall clock in its minimalist 

style, with connectivity and sensors built in. 

This is more like it – I want the clock anyway, 

and the extras just push it over the top.

You might have already spotted the 

contradiction: having declared that too many 

companies have no taste, I’m now suggesting 

they create actual art. But maybe that’s a 

reminder that if tech products are going to be 

in more areas of our lives, they’ll need the 

input of more than coders and engineers.



APPLE CORE Split view

JONY IVE

apple.com

“Since the 1970s 
[Apple] has 

made difficult- 
to-comprehend 
and inaccessible 
technology easy 
to understand.”

Design chief explains one 

of Apple’s key successes 

since its founding

TIM COOK

apple.com

“If you begin to 
merge the two… 

you begin to make 
trade-offs and 
compromises.”
Apple doesn’t want to 

merge iOS and macOS, 

says company CEO

asymco.com

“It set a standard 
for novelty, 

creativity and 
dynamism.”

The iMac was the first 

device to make consumer 

computing cool

HORACE DEDIU

 The MacFormat team debates the hot Apple  
issues of the day, using their iPhones of course!

SPLIT VIEW

“I’VE BEEN THINKING OF GETTING A 

SMART TV. SHOULD I GET APPLE TV?”Alex says…

Alan says…

I’ve had loads of TV show recommendations 

from friends, but I don’t have a smart TV or 

a box to get them. Which should I get? 

You’ve had several models, haven’t you? 

If Apple TV 4K isn’t hugely impressive, why 

haven’t you saved             with Chromecast?

That’s not something I’d thought about. It’s 

not explicitly noted on Apple TV’s web page!

Tim Cook said the future of TV is apps – is 

that future here? How do the apps you get 

on Apple TV stack up against its rivals?

Well, my TV being smart is part of it. I mostly 

use Apple TV for work purposes, and I like 

extending my           desktop onto my TV.

To do that with Chromecast needs third-party 

software. It’s not all good news – Apple TV 4K 

still tops out at a 1080p extended desktop.

There are a lot of media services and games, 

much like other boxes. It’s worth checking 

each one’s store to see what’s included. I’m 

happy that several of my iOS games came 

with a tvOS version for free.

My TV is a smart TV in and of itself, so I get 

apps like iPlayer and All 4 through that. I have 

Apple TV 4K too, but have mixed feelings.
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Hey Siri, tell me a joke

I got my friend a fridge for her birthday. I can’t 

wait to see her face light up when she opens it.

Siri...ously? tap to edit

Turn to page 34

SUBSCRIBE 
TODAY! 

SAVE UP TO

57%
TIM COOK

APPLE
IN QUOTES

apple.com

“In every way and 
every turn, the 
question is not 

what can we do, 
but what should 

we do.”
Apple CEO on the company 

holding privacy sacrosanct



our Mac, iPhone and 

iPad help you to get 

things done, but are 

you using them as 

efficiently as possible? Does 

the number of open windows make 

you avoid Mission Control in favour  

of a less graphical but reliable way 

of switching windows? When you 

need to focus, do you scroll up in 

Notification Centre and turn on 

Do Not Disturb’s switch? Do you 

waste time formatting text copied 

and pasted from elsewhere to get 

it to match your documents?

We picked three Mac and iOS 

experts to tell you how to do these 

and dozens of other tasks more 

quickly. Their advice will save you 

time across many aspects of your 

Apple devices – from improving the 

Dock to window management on the 

Mac; and from accessing key features 

of apps in an instant to taking notes 

with a tap on the Lock screen on your 

iPhone and iPad.

You’ll soon be blazing through 

work, enabling you to get even more 

done – or just finish your day earlier 

and enjoy a well-earned rest.

 macformat.com  @macformat

About the writers
Adam Banks
Remember the great 

MacUser magazine? 

Adam had two turns in 

its editor’s chair, and 

latterly designed it, 

too – so, he has plenty 

of document creation 

timesavers to share.

Tim Hardwick
Formerly MacFormat’s 

operations editor, 

Tim broke out into the 

freelance world and 

he now writes about 

Apple and wider tech 

industry news for 

Mac Rumors.

Alex 
Summersby
Long-term readers 

might remember Alex 

from his days editing 

MacFormat back in 

the 90s. That’s a lot 

of years of acquired 

knowledge to pass on.
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Discover smart shortcuts 

Unlock secret features

Be more productive
Written by

Adam Banks, Tim Hardwick

& Alex Summersby
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Workspace makeovers

1Squeeze out more space
Many windows only extend behind the 

Dock if you drag them. To make full use 

of the desktop, set the Dock to hide – 

≈-click the divider for this option. It will 

reveal itself when the pointer hits the 

edge where it lives. Do the same for the 

menu bar in System Prefs’ General pane.

4Quickly block intrusions
Your workspace is your space, even 

if those pesky notifications that pop up 

at the top right would have you believe 

otherwise. The quickest way to shut them 

out is to hold å and click Notification 

Centre’s icon (top right), so it becomes 

dimmed. This hides incoming items until 

the next day or you repeat the action.

2Desktop a bit cramped?
Need a larger desktop? If your Mac 

has a Retina display, choose a higher 

‘looks like’ resolution in System Prefs’ 

Displays pane. Window furniture shrinks; 

use an app’s zoom feature to keep your 

docs readable. Use EasyRes (free, Mac 

App Store) to do this from the menu bar.

5Make System Prefs lean
Do you find it hard to pick out the 

pane you need in System Preferences? 

If you only regularly use a few of them, 

choose View > Customise and then clear 

the checkboxes next to panes you use 

rarely. Those panes remain accessible in 

the View menu, or by clicking and holding 

the button that shows a grid of dots.  

3Turn off toolbars
If you can memorise key combos or 

menu items’ locations, hiding toolbars 

can give more room to what you’re 

working on. Usually done in an app’s View 

menu, some apps don’t allow it – if you 

find the icons easy to tell apart, choose 

Customise Toolbar and hide text labels.

6Don’t lose the pointer
It’s easy to lose track of the pointer 

against a busy desktop. Remedy this in 

System Prefs > Accessibility > Display: 

turn on ‘Shake mouse pointer to locate’. 

Shake the pointer and it will grow in size 

temporarily. If you use this a lot, consider 

dragging the ‘Cursor size’ slider right to 

make the pointer larger all the time.
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Spotlight and Siri shortcuts
Make the Mac’s search engine and personal assistant truly work for you

our Mac’s Spotlight search 

engine (opened by pressing 

ç+[spacebar]) is a great way 

to find your files and open apps. Siri, 

added in macOS Sierra, has a few tricks 

up its sleeve, too. Here are our favourite 

tips for making the most of both features.

 

1 Get word definitions 
If you enter ‘define:’ (without quotes) 

as your first term in Spotlight and then 

type a word, the first result will be from 

your Mac’s dictionary. 

2Relocate Spotlight
If Spotlight’s results are getting in 

the way of what you’re comparing them 

with, move them to a convenient location 

by dragging from the magnifying glass in 

the window. (To reset the position, click 

and hold on Spotlight’s menu bar icon.)

3Jump categories
After typing in Spotlight, quickly 

move down the results without reaching 

for your mouse or trackpad by pressing 

ç+æ to jump a category at a time.

4Summing up
The Calculator app has been a 

stalwart of macOS for many years, but 

you don’t have to open it to perform quick 

calculations – type in Spotlight instead. 

Spotlight respects operator precedence  

(multiplication before addition, say), and 

you can use brackets to override this.

 

5Avoid repeating
If Siri misinterprets what you’ve 

said, just click the words it thought you 

said and edit them using your keyboard 

to correct it. Press ® and Siri will 

reprocess your command.

6Hands-on Siri
In cafés, offices and libraries, to 

name a few places, it’s more discreet to 

type commands and questions to Siri 

rather than speak them. To do this, you 

will need to change a setting in System 

Preferences’ Accessibility pane: select 

Siri in the left-hand column, check the 

box next to Enable Type to Siri, and the 

next time you invoke Siri using its Dock 

icon, menu bar icon or keyboard shortcut, 

it’ll expect you to type instead.

FEATURE Timesaving tips 

Spotlight is always on hand to help 

you open apps, but sometimes its 

efforts to intelligently anticipate 

what you’re looking for mean the 

app you want is bumped down the 

list of results, which wastes your 

time in having to find and click it.

If that’s familiar, try opening 

apps using Launchpad instead. Its 

search bar has the keyboard focus 

as soon as you open it, waiting for 

you to type an app’s name, at 

which point it quickly filters the 

listed apps. Select one using the 

arrow keys and use ® to open it.

Open apps faster

If your Mac lacks a dedicated Launchpad key, assign 
a key combo in System Prefs > Keyboard > Shortcuts.

In Siri’s window, click the words the personal assistant thinks you said to make corrections.

Need help?
If you open an app’s Help menu, the 

input focus is immediately placed 

in its search field, so you only need 

to type the name of the menu item 

you’re looking for. Use the arrow keys 

to select a suggestion below and then 

press ®. For direct access to the field 

in many apps, press ß+ç+/.



1The path bar
When moving files around in Finder, 

it’s often helpful to reveal the path bar 

(View > Show Path Bar). The breadcrumb 

trail of folders leading right to the top of 

your drive is interactive, so you can drag 

and drop items onto one of those folders, 

or double-click a folder to jump to it.

4Column view
In Finder’s Column view, file and 

folder names can often get concealed. 

Double-click the dividing line to the right 

of a column to resize that column to fit 

the longest filename contained in it. 

Holding down å when you do this will 

additionally resize all other columns to 

match their respective longest filenames.

2Open folders faster
When you drag and hold a selection 

of one or more items over a folder in 

Finder, you’ll notice it takes a moment 

for the folder to open. Fortunately, you 

can speed up the process by pressing 

the space bar as soon as the folder’s 

icon becomes dimmer.

5Tag items
Tags can help you find files later on. 

To tag a file in Finder, ≈-click it and pick 

one of the coloured tags shown near the 

bottom of the menu. The seven defaults 

may be all you need; you can assign them 

labels with personal meaning: in Finder > 

Preferences > Tags, select a tag’s row, 

then click its label and type a new one.

3Save at the start
When starting a document, be sure 

to save it immediately. At the very least, 

this ensures Time Machine can back it up 

hourly. If the app has a File > Revert To 

submenu, it supports Auto Save and 

Versions (bit.ly/asver), saving time if you 

change your mind about excised material.

6Create new tags
To replace the menu’s shortcuts, 

in Finder > Prefs > Tags, drag a tag from 

the top list to a spot in the bottom area. 

You can create your own tags – say, to 

label saved or scanned receipts with 

‘Tax return’. ≈-click a file, pick Tags, type 

a label, press ® once to tag the file with 

that label, and again to close the pop-up. 
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Fast file management
Browse drives, find files and move things around in quick time

Timesaving tips FEATURE 

Swiftly switch devices

Tag your files and you’ll be able to find in an instant all those on your Mac that relate to a project or category, even if they’re spread among various folders.

C
ontinuity is a suite of 

features in macOS and 

iOS that save you time 

when working across devices. 

The devices must be signed in 

to the same iCloud account, 

have Bluetooth and Wi-Fi on, 

and (in some cases) Handoff 

too – look in General settings. 

With Universal Clipboard, 

you can copy text, images or 

videos from one device, then 

paste on your nearby devices.

For many 

apps, Handoff 

enables you 

to move a 

task between 

devices. To move to your Mac, 

click the icon left of Finder in 

the Dock. On iOS, open the app 

switcher and tap the banner at 

the foot of 

the screen.

You can 

use AirDrop to 

share directly 

to a nearby Mac or iOS device. 

Tap a recipient in the top row of 

iOS’s Share sheet; they’ll need 

to set who to receive from: in 

Control Centre’s top-left group 

on iOS, or the AirDrop window 

on a Mac. You can send directly 

from many Mac apps by 

choosing File > Share > AirDrop.
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Hide apps temporarily
You can hide an app’s windows without 

quitting it: ≈-click its Dock icon and pick 

Hide, press ç+H, or hold å when you 

click another app’s icon to switch to it. 

Or, use ç+å+H to hide all other apps.

Jump between windows
Save time jumping between windows in 

the same app: press ç+` (the key next 

to Z); repeat to go to the next or press 

ß+ç+` to go to the last – helpful when 

repeatedly going between two windows.

Quickly maximise windows
Clicking a window’s green button (top 

left) ‘zooms’ to what’s thought to be 

the best fit for its contents. To make a 

window fill the desktop instead, hold å 

and then double-click one of its corners.

Tim’s 
favourite 
timesaver 
Quick Look
If you have a lot of 

windows open, the 

thumbnails in Mission Control (and 

App Exposé) can be small. To check 

which is the window you want, use 

Quick Look – move the pointer over 

a thumbnail and press the space bar 

to see a larger preview. Press again 

to close it. This works even if you’ve 

turned on Mission Control’s ‘Group 

windows by app’ preference, which 

stacks up each app’s windows.
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Mission Control
Master the pre-eminent timesavers for multitaskers

C
onstantly switching apps? 

Screen cluttered? Take charge 

with Mission Control. Press its 

dedicated key or ≈+…, double-tap two 

fingers on a Magic Mouse, or swipe three 

fingers upwards on a trackpad to open it.

1Group app windows
By default, Mission Control spreads out 

the windows of all your open apps (but 

FEATURE Timesaving tips

Working with windows

not hidden or minimised ones, or those 

in any additional workspaces you’ve 

created). If you turn on ‘Group windows 

by application’ in its System Prefs pane, 

it’ll stack windows belonging to the same 

app together – easier to navigate if you 

have many windows open in many apps.

2One app at a time
Mission Control can get crowded. 

To view only the current app’s windows,  

either: press ≈+æ; ≈-click an app in 

the Dock and choose Show All Windows; 

double-tap two fingers on a Magic Mouse; 

or turn on the special trackpad gesture in 

System Prefs > Trackpad > More Gestures. 

In this mode, press † to cycle through 

open apps in turn, or click one’s Dock 

icon to see its windows immediately.

3Recent documents
Instead of using an app’s File > Open 

Recent list or  > Recent Items to reopen 

what you were working on earlier, enter 

App Exposé and look to the row of 

thumbnails shown across the foot of the 

screen. They represent recently opened 

files and minimised windows; click one to 

reopen that item/restore the window.

4 Faster app switching
You don’t have to hold ç and then 

repeatedly press † (or ß+†) to reach 

the app you want in the app switcher – 

just move the pointer over an app icon, 

then release ç to switch to that app.

5More quickly quit apps
With an app selected in the switcher, 

press q to quit it. You can repeat this 

while ç is held – a fast way to quit several 

apps safely. The previous tip, about what 

is under the pointer, also applies to this.
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Minimised windows
A window’s yellow button shrinks it into 

the Dock’s right side; for tidiness, turn on 

‘Minimize windows into app icon’ in the 

Dock’s prefs. Click and hold a Dock icon 

(or use App Exposé) to get windows back.

Merge windows
Want to turn an app’s windows into tabs? 

In some apps, drag one window onto 

another; in others, use Window > Merge 

All Windows. To revert, drag a tab out or 

use Window > Move Tab to New Window.

Reopen windows
In High Sierra, by default, opening an app 

restores its windows. Tick ‘Close windows 

when quitting apps’ in System Prefs > 

General to change it. Or, hold å and Quit 

becomes ‘Quit and Close All Windows’.
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Hot Corners

Quick Calendar tips

> An alternative to using keys to invoke 

features is Hot Corners. You can set 

each screen corner to trigger an action 

when the pointer reaches it – say, to open 

Mission Control, move windows aside to 

access the desktop, or put the display to 

sleep. In System Prefs’ Mission Control 

pane, click Hot Corners to start assigning 

actions. To avoid accidents, hold one or 

more of ≈, å, ß and ç when selecting 

an action here; you will then need to hold 

those keys as well to trigger the action.

> When looking for a gap in your 

schedule across several months, 

the Year view is a good starting 

point – and you can make it even 

better. In Calendar > Preferences > 

Advanced, turn on ‘Show events 

in year view’. The view then uses 

colour to indicate how busy you 

are on each date. In the sidebar 

(View > Show Calendar List), hide 

UK Holidays and others if they 

have no bearing on your plans.

Calendar is a great example of 

how checkboxes work together in 

apps that follow Apple’s guidelines, 

giving you the equivalent of Show 

All and Hide All in iOS: hold ç and 

click a checkbox in the calendar list 

to show/hide all calendars at once. 

Or, hold ç+å and click a box to hide 

all other calendars.
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Reopen closed tabs
Press ß+ç+t to reopen the tab you 

just closed (or window with all its tabs). 

This includes its history: click and hold 

the Back button to see it, then jump to 

an earlier page with one more click.

Tab to tab
To switch tabs without taking your hands 

off the keyboard, press ≈+† to go one 

right of the current one, or ≈+ß+† to 

go left. This also works in Finder, Pages 

and many other apps that support tabs.

Adam’s 
favourite 
timesaver 
Template files 
in any app 
Finder includes a great 

(but far too easily missed) method for 

using any file as a template. Set up a 

document as your starting point in 

any app, save it to a file, then select 

the file in Finder, press ç+I and 

check the box labelled ‘Stationery 

pad’. Now when you open that file, 

Finder creates a duplicate alongside 

the original and opens the copy in the 

respective app; the template remains 

untouched, ready for next time.
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Making documents
Take control of text, graphics, colours and changes

restling with apps like Pages, 

Numbers and Keynote? Cut 

down on wasted time with 

these techniques. Apple’s office and 

productivity apps are generally easy to 

use, yet you can get even better value 

from the time you spend with them.

1 Find keyboard characters
In System Preferences’ Keyboard pane, 

tick ‘Show keyboard and emoji viewers in 

menu bar’ – click the icon this adds to the 

right end of the menu bar and choose 

Show Keyboard Viewer to open a virtual 

keyboard. Hold ≈, å, ç and/or ß – 

individually or in combinations – to see 

which character keys you can then press 

as well in order to type special characters.

2 Find additional symbols
Press ≈+ç+[spacebar] to show a 

panel containing a whole bunch of special 

characters. Use the categories across the 

bottom to explore, or type in the search 

bar for part of a character’s description, 

such as ‘sad’ or ‘fraction’. Double-click 

any character to paste it at the insertion 

point’s position in your doc. Recently used 

Items are displayed at the top of the pane.

FEATURE Timesaving tips

Safari speed-up strategies

3Expand short keywords 
into longer phrases

In System Preferences’ Keyboard pane, 

click the Text tab. Here you can set up 

short character sequences that, when 

typed, are automatically replaced with 

longer words or phrases. To save hunting 

for symbols, you might replace (c) with ©, 

say. Set shortcuts for phrases, like #spe 

for ‘See previous email’. Add corrections, 

such as to turn ‘itouch’ into ‘iPod touch’. 

These sync to all Mac and iOS devices 

signed in to the same iCloud account.

(Note: some apps ignore these shortcuts.)

4Tidy up your type 
Font Book lets you manage fonts 

without having to move their files around. 

In Finder, drag a new font into the app to 

make it available. To organise fonts, click 

the plus at the foot of the left column to 

make a new collection, then drag fonts 

onto it. Select any font or collection and 

disable it by clicking the toolbar button 

that shows a checkbox; the tick goes away 

and the fonts won’t appear in menus, but 

they can be re-enabled. For essential 

system fonts, the tick is greyed out. 

5Ask to keep changes
Apps that don’t use macOS’s Auto 

Save feature save your work when you 

close a document’s window, or when you 

quit an app. If you’ve ever made changes, 

decided against them, closed the doc and 

then realised they were saved anyway, 

it’s because an item in System Prefs > 
Spend time with the Keyboard Viewer to learn 
which keys combine to produce special characters.



1Text navigation aids
Learn a few key combos to be 

able to move the text insertion 

point (caret) without using your 

mouse or trackpad. In TextEdit, 

Pages and many other text editors, 

use ç+… to go to the start of 

the doc or ç+æ to go to the end. 

ç+“ or ç+‘ goes to the start 

or end of the current line. å+“ 

or å+‘ moves back or forward 

by one word, å+… or å+æ or 

by a paragraph. Add ß to these 

to additionally select text between 

the start and end positions.

2Paste in style
Save yourself having to 

reformat text after you copy and 

paste it from elsewhere – a web 

page, say – into TextEdit or Pages. 

The source’s formatting is usually 

preserved, but often unwanted. 

If you use å+ß+ç+v to paste, 

the text will adopt the style at the 

position where it’s inserted into 

your document. (Some third-party 

apps have their own equivalents.)

3Keep things neat
Most apps respect standard 

keys for constraining objects when 

they are edited. Hold ß as you 

drag an object to move it vertically 

or horizontally in a straight line, or 

while dragging a corner to keep 

the object’s proportions as you 

scale it. Hold å and drag an object 

to copy it, or while dragging a 

corner to scale from the centre. 

While rotating, hold ß to turn 

in 45- or 90-degree increments.
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Monitor downloads
A new button appears at the top-right 

corner of Safari during downloads. Click 

it to monitor progress. You can drag the 

popover away to keep it visible, rather 

than having to come back and click.

Open multiple sites at once
If you often use a group of sites for a 

task, add them to a folder rather than the 

Favourites grid. Go to it in the Bookmarks 

menu or ≈-click it in the sidebar and pick 

‘Open in New Tabs’ to open all at once.
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Quick keyboard tips

General is off by default. If your app 

supports macOS’s Versions feature, you 

can roll back changes by choosing File > 

Revert To – or, save the bother: turn on 

‘Ask to keep changes when closing 

documents’ in System Prefs > General. 

6Reduce file size
Save time when sharing a Pages, 

Numbers or Keynote file using email or 

a similar method by shrinking its size. 

Choose File > Advanced > Reduce File 

Size to downscale and crop embedded 

graphics to the size at which they’re used, 

and trim audio or video clips. Don’t do this 

on the master copy of your doc, in case 

you need to change it later – make a copy 

and create an optimised version from it.

7Mix your own colours
In many apps, ß+ç+C opens the 

Colours palette. Click a colour on any tab 

and it appears in the inkwell, bottom left; 

drag this to a slot on the right; colours  

here remain available across apps and 

after restarts. In the third tab, click the 

cog, choose New, then drag colours from 

the bottom into the list. You can name 

your palette and each colour – useful for 

working on multiple projects.
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Terminal tweaks
Customise the Dock to work even more efficiently

S
urprisingly, the Dock has a 

number of options that can 

make it an even more useful 

and effective timesaver, yet these 

features aren’t available in its System 

Preferences pane. To use them, you’ll 

need to use Terminal, which you’ll find in  

/Applications/Utilities. If that intimidates 

you, we’ll introduce you to a third-party 

app that provides the same results.

Before you begin, make sure you 

have a recent backup of your entire 

system – Terminal is very powerful, and 

although you’ll be fine if you type exactly 

the commands here, it has the potential 

to royally muck things up.

As a precaution, make a backup of 

the Dock’s current settings: in Finder, 

hold å and choose Go > Library. From the 

folder that opens, copy com.apple.dock.

plist to another folder. If you later want 

to undo all changes made here, copy this 

back to the original folder, replacing the 

one you’ve changed, then open Terminal, 

type killall Dock and press ®.

1Recent items in the Dock
Ready to go? For faster access to apps 

you use often, add a ‘recent items’ stack 

to the right of the Dock’s dividing line. 

In Terminal, type defaults write com.

apple.dock persistent-others -array-

add '{"tile-data" = {"list-type" = 1;}; 

"tile-type" = "recents-tile";}'; killall 

Dock and press ®.

This adds a new icon to the left of 

the Trash icon. Click it. The stack shows 

the same number of recent apps as are 

shown in  > Recent Items; you can 

change this number in System Prefs > 

General > Recent Items.

You can ≈-click on the stack’s icon 

to set how its contents are displayed – in 

a fan, grid or list – and whether it contains 

recent apps, documents or servers, 

among other things. Want multiple stacks 

to access more than one of these things? 

Run the Terminal command again to add 

another stack, then configure it to suit.

2 Indicate hidden apps
The Dock displays a dot beneath the 

icons of apps that are open, but it doesn’t 

indicate those whose windows you’ve 

hidden by pressing ç+H. In Terminal, 

type defaults write com.apple.Dock 

showhidden -bool yes; killall Dock 

and press ®. Now when you hide an 

app’s windows, its Dock icon will become 

semi-transparent as a reminder.

FEATURE Timesaving tips

W
ant access to even more 

hidden preferences and 

behaviours in macOS? 

Marcel Bresink’s TinkerTool (free, 

bresink.com) gives access to a huge 

range of them in familiar-looking 

preference panes, without you having 

to resort to using Terminal.

You can simply click a checkbox 

to turn on each of the tweaks we’ve 

covered here. Among the many things 

it can change, our favourites include 

eliminating the brief pause before the 

Dock (when hidden) slides into view, 

disabling the Dock’s animation so it 

An easier way to tinker

TinkerTool is an easy-to-use alternative 
to entering arcane commands in Terminal.

Creating stacks at the Dock’s right end gives you 
speedy shortcuts to recent apps, files and more.

pops up/hides instantly rather than 

sliding in and out, stopping the Help 

window sitting on top of all others, 

and removing the delay between 

dragging a window to a screen edge 

and jumping to the next space.

Alex’s 
favourite 
timesaver 
Screenshots 
When capturing a 

screenshot using the 

keyboard (bit.ly/mfscrsht), it’s usually 

saved to the desktop. To use a folder 

instead, in Terminal type defaults 

write com.apple.screencapture 

location and a space, then drag a 

folder onto the window and press ®. 

(If you have a Touch Bar, you’ll then 

need to press ß+ç+4, tap ‘Save to’ 

on the bar and choose Desktop; your 

chosen location will be used, though.)

3Group icons in the Dock
You can add spacers to the Dock to 

make it easier to navigate – useful if it’s 

very busy. In Terminal, type: defaults 

write com.apple.dock persistent-apps 

-array-add '{"tile-type" = "spacer-

tile";}'; killall Dock and press ®. 

Drag the spacer where you want it, 

and repeat the command if you want 

to add more. If you want a spacer that’s 

narrower than a regular icon, type small- 

spacer-tile instead of spacer-tile, and 

if you want one in the Dock’s right side, 

type persistent-others instead of 

persistent-apps. To remove a spacer, 

≈-click it and choose Remove from Dock.
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iPhone & iPad shortcuts
Get things done fast from the moment you pick up your device

dding important 

apps to the Dock 

means they’re only 

a tap away on any page of 

the Home screen. On an iPad 

with iOS 11, the Dock is also 

only a swipe away (upwards, 

from the foot of the screen) – 

even when you’re in an app.

To add an app to the Dock, 

hold a finger on its icon until it 

jiggles, then drag it onto the 

Dock and let go; if it pings 

back to its original location, 

there’s no space left; the Dock 

can hold four items on iPhone, 

and between 11 and 15 on iPad 

(depending on the model).

You can add folders to the 

Dock, too – but to make a new 

one (by dragging one app icon 

onto another), you’ll need to 

do it in the area above, then 

move it. When done, press 

the Home button (or swipe up 

from the bottom on iPhone X).

New in iOS 11 is the ability 

to move multiple app icons at 

once. When the app icons are 

jiggling, drag one and, while 

holding it, tap additional icons 

to add them to your selection. 

Go to the page/folder where 

you want to place them and 

lift your finger; the icons are 

placed in the reverse order to 

which you picked them up.

The Lock screen offers 

shortcuts, too. Swipe left to 

use the camera in an instant. 

Swipe right to reach the Today 

view. To choose what’s shown 

here, scroll all the way down 

and tap Edit; use the + and – 

buttons to add and remove 

items, and drag the handles 

on the right so the most 

important info is shown first.

Share sheets

Multitasking  
on iPad

The Share sheet is 

available in most apps – 

its icon is a square with an 

arrow pointing outwards – 

and comes preconfigured 

with a number of options 

for sharing content from 

your iPhone or iPad. 

To save time, you can 

customise which options 

appear on the middle and 

bottom rows by tapping the 

More item (three dots), which 

is always rightmost in each 

row. In the Activities list that 

then appears, toggle the 

switches beside each item to 

indicate which ones you want 

to show in the Share sheet.

Conveniently, you can 

alter the order in which 

Share sheet actions are 

displayed. Drag on the lines 

at the right end of a row to 

move an action. The vertical 

order of items in this list 

reflects the order items will 

appear from left to right in 

the Share sheet.

Note that iOS does its 

best to hide actions that 

aren’t pertinent to the app 

you’re currently using, but it 

doesn’t always get things 

right. So, if you’re looking for 

a particular action and you 

can’t see it, that might be 

why. Unfortunately, you 

can’t set visibility and order 

on a per-app basis – we’re 

hopeful that this will change 

in a future version of iOS!

1Quick reference
In an app, swipe up from 

the bottom to reveal the 

Dock. Press on an icon till it 

grows, drag up, then let go 

to use that app in a floating 

pane. Flick the top line to 

swap sides, or to hide it off 

the right edge; swipe left 

there when needed again.

2Side by side
Again in an app, reveal the 

Dock and hold a finger on 

an app icon. This time, drag 

it to the left or right edge 

of the screen and let go to 

open it alongside the first 

app. Drag the divider to 

adjust the split, or on the 

line at the top of the right 

app to switch them around.

3Keep watching
If you’re using FaceTime or 

watching a film, say, tap the 

Picture in Picture icon to 

scale it down to a corner of 

the display. Go to another 

app and the video remains. 

You can drag it to another 

corner, pinch or spread two 

fingers to resize it, or flick it 

off an edge to hide it.
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You can change the order of most items in Control 
Centre using the handles on the right of this page.

Don’t overlook the ability to tailor iOS 11’s Control 
Centre to suit how you use your iPhone or iPad.

2Screen recording
This is useful for sharing iOS tips and 

troubles. Tap it to record to the Camera 

Roll, or press to pick one of your apps that 

can broadcast live, such as Facebook.

3Camera 

This provides a quick route to take 

a selfie, record a regular or slo-mo video, 

or take a portrait photo.

4Wallet
Wallet’s button provides a shortcut 

to your default card and, more usefully, 

an option to check your last transaction.

5Notes 
This button provides quick ways to 

start a new note containing freeform text, 

a checklist, a new photo or a sketch.

6Timer
If you dislike speaking to Siri to start 

timers, this is the next quickest method. 

Press/hold the button, slide your finger 

up/down to set a duration, then tap Start.

Super-quick controls
Don’t overlook Control Centre’s customisation options

Y
ou can change Control Centre’s 

contents in Settings > Control 

Centre > Customise Controls. 

To use the following shortcuts, apply a 

firm press if your device has 3D Touch, or 

hold a finger on the control for a moment.

1Apple TV Remote
You needn’t reach for your Siri Remote 

when your iPhone or iPad is in hand. Tap 

Control Centre’s Apple TV button for a 

touchscreen trackpad and Siri button.

FEATURE Timesaving tips

1 Settings
In iOS 11, Control Centre’s Wi-Fi and 

Bluetooth buttons merely disconnect 

from networks/devices, but the hardware 

remains available for features such as 

AirDrop to use. To turn them off to save 

power, go to their pages in Settings. 

Get there quickly on an iPhone with 

3D Touch (6s or later) by pressing firmly 

on Settings’ icon; this app’s Quick Actions 

menu also links to the Battery and Mobile 

Data pages for monitoring usage.

2Mail
Mail’s Quick Actions include a direct 

route to searching your messages – two 

interactions instead of three or more – 

and a link to whichever mailbox is listed 

just below All Mailboxes (see opposite).

4App Store
Perhaps you’ve turned off auto app 

updates in Settings > iTunes & App Store 

to choose when they install. Save a few 

taps with the store’s Update All shortcut.

3Safari
You can jump directly to your 

Reading List or Bookmarks from Safari’s 

icon, or open a new regular or private 

browsing tab, which will be ready for you 

to type an address when the app opens.

5Maps
From Maps’ icon, you can mark your 

current location (handy for later finding 

your car), send your location to someone, 

or jump straight to searching what’s near.

5 invaluable 3D Touch shortcuts 

Get info at a glance
Many apps provide widgets, which 

contain snippets of info or shortcuts 

to recently opened docs. To see if 

an app has a widget, press firmly on 

its Home screen icon. Normally they 

are only available on iPhones with 

3D Touch, yet Files, Pages, Numbers 

and Keynote have widgets on iPad.

1

4

5



Key flicks on iPad
If you’re using iOS 11 on an iPad 

(excluding the 12.9-inch iPad Pro, 

unless you’ve set its display mode 

to Zoomed), make use of the Key 

Flicks feature of the on-screen 

keyboard. It lets you type symbols 

without switching keyboard layout: 

flick downwards on a key to type 

the second character shown on it.

Clear all notifications
On an iPhone that has 3D Touch, 

you can get rid of several alerts 

in Notification Centre in one fell 

swoop: rather than tapping an ‘x’ 

to the right of a heading (such as 

Earlier Today) to clear only that 

group, press firmly on it to reveal 

a Clear All Notifications command.

Check Pencil’s battery
If you use an Apple Pencil, your 

iPad warns you when the Pencil’s 

battery runs low – which might 

happen at an awkward moment. 

Fend off this situation: swipe right 

on the first Home screen, scroll all 

the way down and tap Edit, then 

add the Batteries widget.

Tap for a new note
With Pencil, you needn’t open 

Control Centre and tap a button to 

create/resume a note. In Settings 

> Notes > Access Notes from Lock 

Screen, pick what happens when 

you tap your Pencil (handy in 

meetings), and how soon after 

Touch ID or your passcode is 

required, which can differ from the 

timer for general device security.

Special features

Find text on a page
You can search for a word or phrase on 

a web page in Safari, and there are two 

ways to get started: tap Find on Page in 

the Share sheet’s bottom row, or type in 

the search field and then tap the last item 

in the suggestions, under On This Page.

Add to the Home screen
Some online utilities and services aren’t 

available as standalone iOS apps, but 

you can add such web apps – or any 

regular web page – to the Home screen 

for quick access by tapping ‘Add to Home 

Screen’ in the Share sheet’s bottom row.

Close all tabs in an instant
It’s easy to lose count of the number 

of tabs you have open in Safari for iOS. 

Fortunately, a long press of the Tabs icon 

(two overlapping squares) reveals a Close 

All Tabs option, which indicates how 

many are open before you close them.

Bring back a closed tab
If you close a tab by mistake, there’s no 

need to go all the way into your history 

or re-enter the site’s address. On iPhone, 

first tap the Tabs icon. Next, on iPhone or 

iPad, hold a finger on the new tab (+) icon 

to open a list of recently closed tabs.

Snappy Safari techniques

Timesaving tips FEATURE 
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Small but 
useful tweaks

1. In Settings > General > Accessibility > 

Accessibility Shortcut, you can choose 

which of this practical set of features 

are listed when you triple-click the side 

button (the one that sleeps/wakes your 

device). Smart Invert Colours works as 

a dark mode for much of iOS; images in 

Mail and Safari will display as normal. 

If nothing else, it’s worth turning on 

Magnifier one level up, under Vision. 

2. In Mail, you can hide and rearrange 

items in the list of mailboxes (reached 

by tapping at the top left till you see 

something like the screen shown here). 

Tap Edit, then tap rows to toggle the 

visibility of mailboxes, and drag on the 

handles to the right to reorder things.



www.myfavouritemagazines.co.uk/mfjuicebar

It’s easy to subscribe…

SUBSCRIBE TODAY AND SAVE!

Or call: 0344 848 2852

SUBSCRIBE Never miss an issue

34 | MACFORMAT | JULY 2018  macformat.com  @macformat

SUBSCRIBE
to MacFormat and get a wireless speaker!

Juice Bar Bluetooth Speaker
The perfect combination of power and portability

£39.99

GIFT  
WORTH

YOUR MUSIC, ANYWHERE
Stream your music to 

the Juice Bar easily over 
Bluetooth, which gives it a 

generous range of 10 metres!

PLAY FOR LONGER
Juice Bar’s 1,500mAh battery  

means your music will last 
for eight hours of continuous 

playback from a single charge!

SUPER-PORTABLE
All of this comes in a compact 

15x6x5cm package that fits 
snugly into its handy carry bag,  

so you can take it anywhere!

HURRY!

TIME 
LIMITED 

OFFER



Never miss an issue SUBSCRIBE

 macformat.com  @macformat

Terms and conditions: This offer is only available for new UK subscribers. Gift is subject to availability. Please allow up to 60 days for the delivery of your gift. In the event of stocks being 

exhausted, we reserve the right to replace with items of similar value. Prices and savings quoted are compared to buying full-priced print issues. You will receive 13 issues in a year. You can 

write to us or call us to cancel your subscription within 14 days of purchase. Payment is non-refundable after the 14-day cancellation period unless exceptional circumstances apply. UK calls 

will cost the same as other standard fixed line numbers (starting 01 or 02) or are included as part of any inclusive or free minutes allowances (if offered by your phone tariff). For full terms 

and conditions please visit: www.bit.ly/magterms. Offer ends 31 July 2018. 

JULY 2018 | MACFORMAT | 35

Choose your package!

Other benefits of 
subscribing to the 
UK’s best-selling 
Apple magazine…

PRINT EDITION PRINT & DIGITAL BUNDLE

only  

£30  
every 6  
months

13 issues of  
MacFormat in print,
plus your Juice Bar  
Bluetooth speaker 

13 issues of  
MacFormat in print 

and digital, plus your 
Juice Bar Bluetooth speaker 

  Our print subscription delivers 

13 print issues of MacFormat 

a year to your door, saving 

up to 23% on the cover price

  Get our print and digital 

bundle and save up to 57% 

on the normal price

  The print and digital bundle 

costs just £2 more than print 

alone, and enables you to read 

on your iPhone and iPad

only  

£31  
every 6  
months



Stay up to date with the

latest Apple news

macformat.com
Sign up for our regular email newsletter at



 Understand iOS gestures

EDITED BY JO MEMBERY 

 When you see a shortcut like 

ç+å+C, hold all but the 

last key, then press that one.

 ç is the Command key, 

which is also labelled cmd.

 å means the Option key, 

labelled alt or opt.

 ≈  means the Control key, 

labelled ctrl, and shown as ^ 

in shortcuts in the menu bar.

 ß  is the Shift key, which is 

typically just labelled shift.

 ∫  means the Delete key, 

which deletes to the left of the 

insertion point. Press ƒ+∫ 

to delete to the right.

 † is the Tab key, which shifts 

the focus between some 

controls in windows and web 

forms. Turn on Full Keyboard 

Access in System Preferences 

to jump between all controls.

What’s inside 

38-39 
CREATIVE IMAGE 

ADJUSTMENTS    
 Miniature effects 

and haze reduction 

40-41
MANAGE YOUR 

MAC’S WINDOWS 
 Use Moom to control 

your Mac’s windows    

42-43 
AUTOMATE FILE 

MANAGEMENT 
 Set up Hazel to organise 

your files the easy way

44-45
IMPROVE YOUR 

ONLINE PRIVACY  
 Maximise security 

features in Vivaldi

46
 8 TIMESAVERS 

FOR APPLE MAIL 
 Manage your messages

48-49
MANAGE FAMILY 

PURCHASES 
 Use Apple’s Ask to Buy 

to avoid surprise charges

50-51
MAKE PAGES 

DOCS LIKE A PRO 
 Lay out facing pages

52-53
STAY IN TOUCH 
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 Master Mac keyboard shortcuts

 A tap is a brief contact of 

(usually) one finger on your 

device’s screen.

 To drag is to move a finger 

across the screen to scroll 

or pan around content.

 Swipe means move one or 

more fingers across an item 

or the screen, then let go. 

 

 A flick is like swiping, but it’s 

quicker, and is often used to 

scroll content more quickly.

 Pinch means move two 

fingers together or apart, 

usually to zoom in or out.

 Touch and hold means lightly 

rest your finger on an item 

and wait for a reaction.

Your in-depth guide to 
getting more from 

your Apple kit

NEW 
IDEAS

GET MORE
FROM PAGES

p50
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Creative image adjustments
Expand the toolset in Photos by adding extensions from Affinity Photo

IT WILL TAKE

  10 minutes

YOU WILL LEARN

  How to add 

extensions to Photos, 

then reduce haze and 

make buildings look 

like miniature toys

YOU’LL NEED

  Photos, 

Affinity Photo 

Apple’s Photos app is designed 

to help you import, organise, 

fix and share your shots. As a 

result, it’s an effective ‘one-stop 

shop’. However, while Photos enables you to 

fix common problems with colour, composition 

and exposure, it lacks some of the more 

sophisticated tools found in other apps. 

Powerful and versatile, Affinity Photo 

enables you to perform a wider range of edits 

than you can with Photos’ built-in tools. For a 

one-off purchase (£48.99), Affinity Photo 

provides many of the functions of Photoshop 

without an ongoing subscription fee. 

As well as running as a standalone app, 

Affinity Photo adds a range of extra editing 

tools to Photos. So, you can enjoy using 

more powerful tools from the comfort and 

familiarity of Photos’ workspace.

Explore extensions
In our walkthrough, we’ll show you how to 

import Affinity Photo’s extensions into Photos 

and then produce a creative and distinctive 

looking image. Our scenic example photo 

suffers from cold, drab colours. The tones 

in the distant trees are washed out due to 

atmospheric haze. 

We’ll demonstrate how to use Affinity 

Photo’s extensions to selectively adjust the 

contrast of the trees to reveal more colour 

and detail, and tease out the scene’s ‘golden 

hour’ colours for a more attractive look. We’ll 

also increase the midtone contrast to reveal 

more delicate texture in the brickwork and 

create a picture with more punch.

After enhancing the shot’s colour and 

tones, we’ll show you how to use Affinity 

Photo’s creative Miniature extension to 

selectively blur parts of the image and mimic 

the effect of a tilt-shift lens. This selective 

blurring creates the narrow depth of field 

you see when viewing a photograph of 

models or toys, which helps make full-size 

subjects look like miniatures. 

George Cairns
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 HOW TO Enhance an image 

1Add extensions
After installing Affinity Photo, choose  > 

System Preferences. Click on the Extensions 

icon and select Photos Editing on the left. 

Fill the checkboxes next to the various 

Affinity Photo extensions to activate them. 

2Access an extension
In the Photos app, double-click on an 

image’s thumbnail, then click Edit at the top 

right. Click the Extensions icon and choose 

Affinity Haze Removal. This will open the photo 

in the Affinity Haze Removal workspace. 

3 Remove background haze
The tool’s Distance slider enables you 

to target and tweak the contrast of distant 

hazy midtones without adjusting foreground 

contrast. The Strength slider enables you to 

fine-tune this. When done, click Save Changes.

4 Enhance colour
Click on the Extensions button and 

choose Affinity Develop. Drag Vibrance right 

to selectively boost weaker colours. Increase 

Saturation too. Drag Temperature right to 

warm up the colours for a ‘golden hour’ look.

5 Boost clarity
To make delicate details stand out, drag 

the Clarity slider right to increase midtone 

contrast. Click Save Changes. Click the 

Extensions icon and choose Affinity Miniature. 

By default, the Elliptical blur tools are visible.

6 Tilt-shift effect
Click on the Tilt button. Drag the Strength 

slider right to add blur to the top and bottom 

of the frame. Drag the blue control handles to 

create a narrower band of focus. Click Save 

Changes when you’re happy with the look.

Genius tip!
 The Affinity Miniature 

extension’s Elliptical 

tool enables you to 

add a romantic blurred 

vignette around the 

edge of the frame. 

Jargon buster
 Golden hour

As the evening sun 

drops towards the 

horizon, it bathes the 

subject with light that 

has a warmer colour 

temperature than 

average daylight. 
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Manage your Mac’s windows
Get full control over your workspace with personalised shortcuts in Moom

IT WILL TAKE

  30 minutes

YOU WILL LEARN

  How to use Moom to 

organise windows

YOU’LL NEED

  OS X 10.7 or 

later, Moom 

These days, macOS lets you view 

apps full screen or in Split View, 

like on an iPad. However, chances 

are you still often use traditional 

windows, and end up with all sorts of apps 

and documents spread across your screen. 

Moom is designed to bring order to that 

special kind of Mac chaos.

A window manager is not a unique concept 

on the Mac, but Moom goes further than its 

contemporaries, providing an unparalleled 

level of customisation and control. You can 

move windows by dragging them to screen 

edges, draw out the area you want a window 

to fill, or use predefined or user-defined 

keyboard shortcuts to trigger actions.

Moom is available from manytricks.com. 

The demo works for 100 uses, after which it 

costs £9.99. When you first open the app, its 

preferences window will open. In the General 

tab, you can set Moom to run as a regular app 

(in the Dock), a faceless app (open it to access 

prefs), or as a menu bar icon. We recommend 

the last of those. Craig Grannell

HOW TO Manage windows with Moom  

1Drag to snap
In Moom’s Mouse preferences, click 

Snap to Edge and Corners and ensure 

the checkbox is filled. Drag a Finder 

window, say, to a screen edge or corner 

and it’ll be resized to that half/quarter 

screen. Drag it away and it reverts.

2Configure zoom
Click Zoom Button Controls in 

the Mouse preferences tab. Ensure 

‘Pop up controls’ is ticked. Turn on the 

full-screen grid and decide how many 

divisions you’d like the screen broken 

up into horizontally and vertically.

3Use the Zoom button
Place the pointer over a window’s 

green (Zoom) button and use the icons 

to snap the window to depicted screen 

areas. Alternatively, click in the dotted 

area, then click and drag across your 

desktop to set the window’s new position.
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4Keyboard trigger
In Moom’s Keyboard preferences, 

click inside the Trigger field and press 

a memorable key combination that 

doesn’t clash with others on your system. 

≈+^ may be a good option. Add more 

modifier keys to your combo if necessary.

5Move a window
Open a Finder window and test your 

shortcut. When Moom’s logo appears on 

the screen, use the arrow keys to move 

your window around within the confines 

of your display. Use ç and arrow keys 

to snap the window like in step 1.

6Keyboard settings
Back in Moom’s Keyboard 

preferences, examine the other menus 

and options on offer. You can use 

shortcuts to quickly centre a window, 

maximise its dimensions on the screen, 

or revert to its original dimensions.

7Use custom controls
You can speed up keyboard-based 

window management even more by 

assigning window actions to key combos 

of your choosing. Start doing this in the 

Custom tab. Select and delete the demo 

actions, and click + to make a new one.

8Set up an action
The boxes at the bottom right 

determine the size of the grid you’ll be 

working with. Adjust that if you like, but 

6x4 is a decent starting point. Drag a 

rectangle to colour in the left-hand 

side of the grid.

9Define a shortcut
Click inside the shortcut field 

(which defaults to None) and press 

≈+å+ç+“ arrow. Now open a Finder 

window and try out your shortcut. The 

window should instantly snap to the  

left-hand side of the screen.

10Build a system
Add more actions, and design 

a logical shortcut system for snapping 

windows to various areas. In further 

actions, explore other menu options, 

for example to centre or revert a 

window using a keyboard shortcut.

11Save snapshots
If you often use two apps side-by-

side, set their windows so they fill halves 

of the screen. Then create an Arrange 

Windows action in Moom. When its 

shortcut is triggered, the apps (if open) 

will be positioned as per the snapshot.

12Use the menu bar
In Moom’s General preferences, 

set the app to run as a menu bar icon. 

You can then access all your custom 

setups from the menu bar – or just 

get a handy reminder regarding your 

defined keyboard shortcuts.

 CONTINUED… Manage windows with Moom 
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Organise files automatically
Use Hazel to automate managing and filing your documents

IT WILL TAKE

  30 minutes

YOU WILL LEARN

  How to use time- 

saving workflows

YOU’LL NEED

  OS X 10.10 or later, 

Hazel 4.2 or later, 

some folders and files 

Hazel ($32, about £24) 

noodlesoft.com) monitors 

folders and performs actions 

on their contents, based on 

user-defined rules. The app can be a major 

timesaver. For example, have it watch your 

Desktop folder, and move anything older than 

a week to Downloads. Then have it monitor 

Downloads, with rules that send music and 

photos to iTunes and Photos, respectively, 

before deleting the originals, and others that 

sort everything else into folders by type (using 

‘Sort into subfolder with pattern kind’). Once 

your rules are running, this is all automated. 

Our walkthrough explores two advanced 

rules. One finds text files in a folder and copies 

them to an archive. The other searches PDFs 

and renames them based on their contents. 

Use these as the basis for your own workflows. 

Think modularly, figure out what you want to 

achieve, then build your rules – and test on 

duplicate folders for safety! Note: ≈-click 

a folder in Hazel’s list to pause that item’s 

rules – ideal when editing. Craig Grannell

HOW TO Make Hazel work for you 

1Make a folder
Create a destination folder called 

Archive in your Documents folder. Go to  

Hazel. Under Folders, click +. Select the 

target folder you wish to pull content 

from. If you use subfolders, you also 

need a rule so Hazel won’t ignore them.

2 Check for folders
Click + under Rules, and call the 

new rule ‘Check for folders’. Set the 

condition to ‘Kind is Folder’, and the 

action to ‘Run rules on folder contents’. 

Subsequent rules will run on folders 

inside the one you’ve chosen.

3Add a second rule
Add a rule: Create archive. Add the 

condition ‘Kind is Text’, to match text 

documents; add a second, ‘Date Added 

is after Date Last Matched’. This stops 

Hazel manipulating unchanged 

documents it has already filed.
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CONTINUED… Make Hazel work for you 

4 Define actions
Set the first action to ‘Copy to 

folder Archive’. This will send matching 

items to the folder created in step 1. Now 

to sort them into date-based subfolders. 

Add a second action, starting with ‘Sort 

into subfolder’.

5 Choose a pattern
Click inside the ‘with pattern’ 

field. Click the ‘date created’ token to 

add it to the pattern. Click the token’s 

downwards-facing arrow and select 

Edit Date Pattern. Remove -31 (so 

folders will use YYYY-MM). Click Done.

6 Set options
Click Options and use the ‘Replace’ 

option if you want updated files to 

replace those in the archive. ‘Rename’ 

creates many copies of files that you 

actively work on – counteract this with 

a condition to ignore today’s files. 

7 Set a new folder target
We’ll now move to our second 

folder – one full of PDF invoices with 

identifying numbers comprising a word 

followed by a four-digit numerical code, 

such as macformat0001. (Adapt what 

follows to suit your own documents.)

8 Target documents
Add the condition ‘Extension is pdf’ 

to target PDFs. We now need to create 

a token to find documents that contain 

the code mentioned in the previous step. 

To start, create a second condition: 

‘Contents contain match’.

9Use a token
Click inside the match field and, 

in the pop-up, click the Custom Text 

token to add it. Give it a memorable 

name (we’re using MacFormat ID). 

We now need to define the attribute 

that Hazel will search for in the PDFs.

10 Define the attribute
For this example, we said we 

would search for the word ‘macformat’ 

followed by some numbers (which could 

be anything). In Hazel, this is achieved 

by typing ‘macformat’ into the attribute 

field and clicking the Number token.

11Add a renaming action
Now create an action, ‘Rename with 

pattern’, to prefix the existing filenames 

with the token’s value. The pattern will 

default to a hyphen followed by a name 

and an extension. Click just before the 

hyphen, then click your token to insert it.

12Adjust and test
Adjust the pattern to suit, with 

spaces and other elements. Click Done 

and OK, then test your rule. Matching 

PDFs will be renamed using your pattern. 

Now expand these concepts to other 

items you usually have to file by hand!



 macformat.com  @macformat44 | MACFORMAT | JULY 2018

Improve your online privacy
How to maximise the Vivaldi web browser’s security features

IT WILL TAKE

  15 minutes

YOU WILL LEARN

  How to protect your 

personal data, search 

without being snooped 

on, and add extensions

YOU’LL NEED

  Vivaldi

Vivaldi is a new web browser 

from Jon von Tetzchner, one 

of the co-founders of Opera. 

It offers extensive customisation, 

and access to Chrome plugins. But something 

very relevant to recent privacy concerns is 

Vivaldi’s approach to protecting personal data.

If you use a mainstream browser, you 

might want to consider switching to Vivaldi to 

gain control over how some websites access 

and potentially exploit your personal data. 

There are also some excellent interface 

features, including a helpful note-taking ability.

Safari users may also consider switching 

to Vivaldi to access extensions not available 

for Apple’s browser. But keep in mind 

the possibility that extensions may access 

personal data independently of the browser. 

One drawback of Vivaldi is the lack of 

bookmark synchronisation. It is possible 

to import bookmarks from other browsers. 

But, for the moment, there is no way to sync 

bookmarks across different devices. Now, get 

the browser from vivaldi.com. David Fanning

HOW TO Set up Vivaldi to protect your data >

1Adjusting settings
Open Vivaldi’s preferences and click 

Privacy in the sidebar on the left. This will 

show you the default privacy settings, 

which you can adjust depending on your 

needs. We will be adjusting the settings 

with two goals in mind.

2 Disable tracking
To disable tracking, check Do Not 

Track and Block Third-Party Cookies. 

This means advertisers can’t monitor 

your history. Disabling Broadcast IP will 

withhold your IP address from WebRTC 

video conferencing sites.

3 This session only
If you share your computer/user 

account, you might want to hide your 

search history from other users. For max 

security, uncheck the items under Show 

Typed History and change Save Browsing 

History to Session Only.  



Private browsing APPLE SKILLS

 macformat.com  @macformat JULY 2018 | MACFORMAT | 45

HOW TO Search without being snooped on >

HOW TO Add a Chrome extension >

1 Private browsing
Choose File > New Private Window to 

browse without recording pages you visit. 

Many browsers include this, but may still 

send info to search engines. Private 

windows default to DuckDuckGo, which 

won’t collect or share personal info.

2 Choose search engines
You can use DuckDuckGo for all 

searches, or set an alternative engine for 

regular windows and use DuckDuckGo 

only for private ones. Choose in Vivaldi > 

Prefs > Search by selecting an engine and 

setting the Default/Private Search items.

3 Stop searches
When using DuckDuckGo, searches 

are not recorded or shared by the engine. 

Using a private window means other 

users of your computer won’t get search 

suggestions or autofilled data based on 

things you were looking for. 

1 Chrome extensions
The ability to use Chrome extensions 

gives Vivaldi a variety of customisation 

options. But do choose carefully here, as 

extensions can also affect your privacy 

in a negative way. In this example, we’re 

installing DuckDuckGo Privacy Essentials.

2 Search and select
Go to chrome.google.com/webstore/

category/extensions. On the left, you can 

browse by category, score and other 

attributes. We know what we want: in the 

‘Search the Store box’ type “DuckDuckGo 

Privacy Essentials” and press ®.

3Add to Chrome
To install the extension, click ‘Add to 

Chrome’, then ‘Add extensions’. As far as 

Google can see, you’re using Chrome 

rather than Vivaldi, as it uses the same 

Chromium engine, which makes most 

Chrome extensions compatible.

Web multitasking like a pro

Easy access to security options is a welcome feature, but Vivaldi also includes 

tremendous customisation and interface options. One great feature is the ability 

to have a window that displays multiple websites in the same panel. 

Vivaldi does this by using Tab Tiling. To start, open two or more tabs by 

using ç+T. Next, drag one of the tabs over the other until the latter one dims, 

then let go. Repeat with other tabs. Once all the tabs are contained in one Tab 

Stack, ≈-click it and choose Tile Tab Stack to see the websites side by side.

Display multiple websites in one browser 
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email timesavers
Use the Mail app’s convenience features to keep things organised

The Mail app handles 

emails from all your 

accounts in one place. 

You can set up mailboxes, 

like folders, within each online account, 

or offline by hovering over On My Mac 

and clicking the +. Organise messages 

in these by dragging them manually, 

or automatically by using Mail Rules.

Using Mailbox > New Smart Mailbox, 

you can collate messages based on your 

criteria (without moving the originals). 

Mail Drop enables you to send large 

attachments that most mail servers will 

reject. Here’s how to use these features. 

Adam Banks

3Set iCloud rules
Mail Rules are only applied when Mail 

is open. With iCloud, you can also filter 

messages at source. Sign in at iCloud.com, 

go to Mail, click the cogwheel and pick 

Rules to set up rules on the server.

4Apply flags
Another way to organise messages 

is to flag them. On the Mac, you can use 

multiple colours when you ≈-click on a 

message in the list, but note that on iOS 

all flags just appear as an orange dot.

1Make mailboxes
Hover over an account name and click 

the +, or ≈-click its Inbox and pick New 

Mailbox, to add a mailbox. Click a mailbox 

to see its contents. From your Inbox, drag 

messages to mailboxes to file them.

5Add VIPs
≈-click a sender’s name in any open 

message and pick Add to VIPs, or click 

the star left of a person’s name when 

you hover over it. Messages from them 

are then included in the VIPs mailbox. 

2Set up Mail Rules
To file emails automatically, go to 

Mail > Preferences > Rules and click Add 

Rule. Set it to match a sender or subject 

you receive regularly, pick Move Message 

as the action, and choose a mailbox.

6Notify for VIPs only
Now you have the important people 

and organisations in your life set up as 

VIPs, you can go to Mail > Prefs > General 

and set new message notifications to 

appear only for those people.

7 Format conversations
Mail clumps messages that it thinks 

form a thread; select the latest one in 

your Inbox and scroll through the others 

on the right. To list all messages singly, 

untick View > Organise by Conversation.

8Use Mail Drop
In Mail > Prefs > Accounts, turn on 

Mail Drop for your iCloud and other IMAP 

accounts. When you attach large files, 

they’re sent to iCloud; a link is included 

for non-Apple devices to download them.
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Manage family purchases
Use Ask to Buy to ensure your kids don’t spend your money on virtual bling

IT WILL TAKE

  15 minutes

YOU WILL LEARN

  How to set up Ask to 

Buy and manage your 

family’s purchases

YOU’LL NEED

  Apple IDs that are set 

up for Family Sharing 

For parents who grew up in a 

simpler time, the prospect of 

kids armed with iOS devices and 

Macs is a little terrifying. These 

items are typically always online, and the App 

Store is just a click or tap away – which means 

in-app purchases often aren’t far behind.

For young kids, you’ll want to fully manage 

their devices, installing apps and games 

yourself. But when children get older, there’ll 

be a time when they want a little bit of extra 

independence – downloading things they 

themselves like the look of.

Permission before payment
Unless you hate money (or have an awful lot of 

it), you still don’t want this to be a free-for-all. 

Ask to Buy provides a middle ground. A part 

of Family Sharing (bit.ly/fmshr), it enables a 

child to ask permission when they want to 

download/buy a new app or in-app purchase.

The process for managing and using Ask 

to Buy is outlined in the walkthrough, and 

assumes you’ve already set up Family Sharing. 

If you haven’t, you can do so in Settings (iOS) 

or System Preferences (macOS). One person 

must act as the organiser, managing the 

family and providing a payment card. That 

person can then invite family members (and 

create new Apple IDs for children). Note that 

children remain with the family account until 

aged 13, and cannot be deleted earlier without 

assistance from Apple Support.

Craig Grannell
You see this sort of thing in a lot of mobile games, so you 
must be vigilant about children and in-app purchases.
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 HOW TO Set up and use Ask to Buy 

1 Get things started
On your Mac, open System Preferences, 

click iCloud and then Manage Family. In the 

sheet, select a family member and then click 

Ask to Buy. This option only exists for children, 

and is on by default for under-13s.

2Use an iOS device
If you’re on an iOS device, you activate 

Ask to Buy in the Settings app. Tap your name 

to access the settings for your Apple ID, and 

then tap Family Sharing. Select the family 

member in question, and tap Ask to Buy.

3Add more adults
If your family has more than one adult, 

the organiser alone doesn’t have to approve 

requests. Select another adult (on Mac or iOS) 

and click/tap (as appropriate) Parent/Guardian. 

They now have the power to approve.

4Make a request
To make a request, a child goes through 

the usual purchase process. However, prior 

to installing/payment, an Ask Permission 

dialog appears. They must tap Ask to send an 

adult an approval request (and only once).

5Approve on a Mac…
If you’re on a Mac when the request 

arrives, it’ll appear as a notification (top right). 

Click Details and an App Store preview page 

appears, so you can check out what’s being 

requested. Approve or decline accordingly.

6…or approve on iOS
On iOS, tap the notification to open the 

App Store, and choose to Decline or Get/Buy. 

With the latter option, you must sign in/use 

Touch ID to approve, whereupon the item will 

then appear on the child’s device.

Genius tip!
 Consider enabling 

Touch ID/Face ID for 

Family Sharing when 

prompted, and also 

for a child’s device, 

so there’s no need to 

sign in and remember 

a password.

Jargon buster
 Family Sharing is 

Apple’s system that 

enables families to 

share apps, media and 

iCloud storage, and to 

geolocate each other 

(and their devices).
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Make Pages docs like a pro
How to create a document that takes facing pages into consideration

IT WILL TAKE

  30 minutes

YOU WILL LEARN

  How to create 

a document with 

facing pages

YOU’LL NEED

  iOS 11 or later,  

Pages 

At the recent launch of the 

sixth-generation iPad, Apple 

also unveiled new iOS versions 

of the iWork apps: Pages, 

Keynote and Numbers. And Pages 4.0 

now lets you create and edit documents 

more flexibly than ever.  

Among the additions are Pencil 

annotation, leveraging the entry-level 

iPad’s support for Apple’s pressure-sensitive 

stylus; ePub templates for more ambitious 

book designs with fixed or reflowing layouts, 

inspired by iBooks Author; editable shapes 

to add quick graphics; and paragraph and 

character styles, which previously could 

only be set up in the Mac version.

Tablet publishing
First, though, let’s look at the return of 

facing pages, lamented since Pages ’09. 

Pages documents come in two flavours: 

word processing and page layout. Facing 

pages can be used with both kinds – in 

word processing documents for text-based 

printed books, where the text flows through 

the pages from beginning to end, and in page 

layout documents for printed magazines, 

and other multi-page bound or folded 

publications that have fixed page layouts 

combining text and pictures.

Facing Pages doesn’t quite work as we’d 

like yet, and Pages isn’t ready to print them 

successfully. Its absence of pre-press features 

like bleed and CMYK makes it impractical to 

prepare documents for commercial printing. 

To print them out yourself, on the other hand, 

you’d need a feature known as imposition, or 

booklet printing. Fortunately, it’s available in 

the free Adobe Reader app on the Mac or 

Vogelbusch’s Create Booklet (£4.99) on iOS. 

You’ll need to export your Pages 

document to PDF, import it into one of these, 

output as a booklet on A3 paper or scaled 

down to turn your A4 layouts into an A5 book, 

then fold and staple. We’ve glossed over the 

part where the backs may print upside-down, 

which requires some experimentation to fix.

In the iOS version of Pages, the only 

way to create a page layout document is to 

use an existing template, and the Newsletter 

templates are all in word processing mode, 

so you’ll need to… well, let us explain step by 

step. It’s a bit of a faff, but doable once you 

know how. Adam Banks

1

Double-page 
spreads

 In this format, 

pages are shown 

opposite each 

other, as they’d 

appear in a 

publication.

2

Four is a 
magic number

 If you’re 

thinking of 

printing a 

booklet, you 

need multiples 

of four pages. 

3

Get set up
 The facing 

pages magic 

happens in 

Document 

Setup, 

accessed from 

the More menu.

4

In the middle
 Now you can 

design spreads 

with elements 

crossing the 

spine! Well, with 

some jiggling. 

1

2

3

4
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 HOW TO Work with facing pages  

1Make a layout document
Open Pages and tap Create Document. 

Only a few templates are in page layout mode, 

mostly flyers. We used Tab Flyer. From More 

(the three-dot icon, top right), pick Document 

Setup. Under Document, turn on Facing Pages.

2Add some pages
Swipe inwards from the left to see page 

thumbnails, and tap the + sign at the bottom 

until you have eight pages. The first and last 

pages appear alone – these will be your front 

and back covers – and the rest as ‘spreads’.

3 Create your layouts
Double-tap placeholder text (it highlights 

pink), then type your own. Use the Style menu 

(the brush icon) to change font and size. Drag 

items to move them, or their handles to resize. 

To move several, hold one and tap another.

4 The facing pages problem
Copy and paste items or add more to 

complete your layouts. On a spread, you may 

want a big picture or graphic crossing the 

spine (where the book is bound). But if you 

try it, only the part on one page shows up.

5…and the solution
Position the item, copy and paste it, and 

line it up on the opposite page. If it jumps 

across, undo, grab it further from the spine 

and retry. Now let’s pretend we’ve finished. 

From More, go to Export > PDF > Save to Files.

6 Printing via Adobe Reader
On your Mac, open the PDF in Adobe 

Acrobat Reader DC. Go to File > Print and 

click Booklet. If your printer does duplex, set 

Booklet subset to Both; if not, set Front, print, 

feed the pages back in, then print the backs.

Genius tip!
 In View Options (the 

icon to the right of 

Documents), you can 

turn off Two Pages to 

show one page at a time 

even when working with 

a facing pages layout. 

Jargon buster
 A left and a right page 

joined at the spine is a 

double-page spread. 

Printing both pages of 

an A4 DPS at full size 

needs paper twice the 

width (A3). Pages for 

iOS can only create A4 

documents, so use an 

A3 printer or scale down 

to A5 on final output. 
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IT WILL TAKE

  30 minutes

YOU WILL LEARN

  How to use Messages

YOU’LL NEED

  Messages for iOS 

or maCOS 

Messages is one of the most 

widely used apps in iOS, thanks 

to its ability to send SMS and 

MMS messages, as well as 

those that use Apple’s iMessage protocol. 

By default, the app always tries to send using 

iMessage — for which the recipient needs to 

have a valid Apple ID and be connected to 

the internet. If that’s not possible, it will send 

messages using SMS (or MMS if it’s an image 

or video and the sender and recipient’s 

network providers allow it).

We’ve covered several less well used 

features of Messages here, including group 

conversations. Like regular messages, group 

conversations can be iMessage, if all the 

recipients meet the criteria, SMS or MMS.

We’ve focused on iOS, but most of the 

features are available on macOS. Where we 

refer to ‘i’, the Mac equivalent is ‘Details’. And 

in step 8, on a Mac, swipe right (not left) to 

hide alerts for a conversation. You can turn off 

notifications for unknown senders in Messages 

> Prefs, but there’s no filter. Kenny Hemphill

 HOW TO Make more of Messages 

1 Send a group message
In Messages, tap the Compose icon to start 

a new message. Tap the + in the To: field and 

add a recipient. Start typing and choose their 

name when it appears. Repeat to add another 

recipient. Type your message and press Send.

2Name a group message
You can only name iMessage group 

conversations. In the list of messages, tap 

the conversation. Tap ‘i’ then ‘Enter a Group 

Name’. Type in the name and tap Done. You 

should see the group name in the list.

Genius tip!
 Messages allows 

you to send money to 

friends using Apple Pay, 

though it’s not available 

in the UK yet. When it is, 

open Messsages’ app 

drawer and tap its icon.

Stay in touch with Messages
Learn how to communicate and meet up more easily
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3 Start audio or video call 
With a conversation open, tap ‘i’. If audio 

or video calls are available, you’ll see a camera 

and/or phone button. Press the camera to 

start a FaceTime video call or the phone to 

make an audio call.

4 Images and attachments
Tap on the conversation whose images 

and attachments you want to review. Tap ‘i’. 

Scroll down, tap Images or Attachments, then 

tap an item to view it and swipe left or right to 

see others. You can share the item from here.

5 Filter messages
To filter messages from people not in 

your Contacts list, go to Setting > Messages 

and turn on Filter Unknown Senders. Messages 

will create a separate list for these messages 

and you won’t get notifications for them.

6 Report spam messages
When you get an iMessage from a sender 

who’s not in your contacts list, Messages puts 

a note under it to tell you. Tap Report Junk to 

forward the sender’s details to Apple and 

delete the message from your iPhone.

7Audio messages
In a conversation, tap and hold the Mic 

icon. Record your message. Let go, then tap 

play to listen back, ‘X’ to cancel, or Send. 

Audio messages are deleted after two minutes 

(this can be changed in Settings > Messages).

8Hide alerts
In the Messages list, swipe left on the 

conversation you want to hide alerts for. Tap 

Hide Alerts to switch off alerts and banners 

for the conversation. If you have app badge 

notifications turned on, they’ll still be updated. 

Genius tip!
 There are a host 

of other apps that 

work with Messages, 

including Evernote 

and Dropbox, which 

allow you to share 

notes or files within 

conversations.

Jargon buster
 Send My Current 

Location allows you 

to share where you are 

right now. The recipient 

doesn’t receive updates 

when you move. Share 

My Location allows 

others to track your 

ongoing movements. 

It can be limited to one 

hour or the day’s end, 

or allowed indefinitely.

CONTINUED… Make more of Messages 
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USB class-
compliant 
products 
can work 

immediately, 
without drivers

Key fact
 A USB device can draw 

one unit of power from 

the host – that’s 150mA 

(100mA up to USB 2.0). 

Devices configured as 

‘high power’ can draw 

up to five units.
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How it works: USB
One simple socket that’s evolved throughout the years

YOU WILL LEARN

 Why we have so 

many USB plugs 

and standards, and 

what each of them 

means in practice

The Universal Serial Bus (USB) 

arrived on 6 May 1998, at Flint 

Center, Cupertino. Specified by an 

Intel-led industry partnership, it had 

already appeared in a few PCs, but it was only 

when Apple – not a member of the group – 

unveiled the first-generation iMac, with the 

traditional interfaces abolished, that we knew 

USB was the future.

USB 1.1, capable of speeds up to 12Mbps, 

was “the new generation of I/O”, announced 

Steve Jobs. Simple, he said. Elegant, he said. 

And he was basically right. Although, if he’d 

envisaged that 20 years later USB would cover 

two data protocols running over six physical 

connections in five speed classes, he might 

have used some different words.

The iMac’s ports were USB Type-A, 

the now familiar rectangular receptacle 

with a plastic tab across the middle. 

Its mouse and keyboard had matching 

steel-sheathed plugs attached, while 

peripherals like disk drives and 

printers would come with square 

USB Type-B ports, connecting 

with an A-to-B cable that 

established a two-way data 

flow and a one-way power 

supply, from computer 

(host) to accessory (device).

Socket to me
USB 2.0, emerging in 2001, 

boosted transfer rates to 

480Mbps, competing with 

FireWire 400, which Apple 

had added to the iMac DV 

for video transfer. Smaller 

accessories, like digital 

cameras, didn’t have room for 

the full-size Type-B socket, 

and some manufacturers had 

invented their own. Now there 

were two official solutions: 

the sharp-cornered trapezoid Mini-B, and 

Micro-B, so small and flat that mating the 

plug and socket without incident required 

the skills of a porcupine breeder.

What made USB so successful was that 

the spec covered more than just the physical 

connection and communication protocols. 

It defined device classes – printer, mass 

storage, communications (networking), human 

interface (keyboards and mice) – so that ‘class 

compliant’ products could identify themselves 

to the computer and start working, with no 

need to install software drivers except for 

esoteric features. This also meant Macs and 

Windows PCs could use the same USB devices.

Generation gain
Nearly a decade later, USB 3.0 – branded 

SuperSpeed and indicated by an SS logo and 

a blue insert in the Type-A port – multiplied 

transfer rates tenfold to 5Gbps. But with more 

pins required, Micro-B had to be upgraded to 

what looked like two plugs stuck together.

Twenty years on from the first appearance of USB, 
Thunderbolt 3 can transfer data at a rate of 5,000MB/s.

USB Type-C ports supporting 
Thunderbolt 3 allow for superfast 
data transfer and daisy-chaining.

Transfer speed (higher is better)

1.5MB/s

60MB/s

625MB/s

1,250MB/s

5,000MB/s

 

3000 4000 5000 6000200010000

Theoretical data throughput 
(megabytes per second)

USB 3.1 GEN 2

Thunderbolt 3

USB 3.0

USB 2.0

USB 1.1
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Key fact
 USB Type-C uses 

‘smart’ cables that 

route the correct 

amount of power either 

way, known as Power 

Delivery (PD).

Jargon buster
 Because USB can’t 

daisy-chain, hubs are 

often required for extra 

devices. With a passive 

(‘bus-powered’ hub), 

the USB port’s voltage 

is shared, causing 

issues with high-power 

devices and charging. 

A powered hub fixes this 

using a mains adaptor.

1 2 3 4

1

USB  
Type-A

 The original 

computer-end 

plug and socket 

only fit together 

one way.

3

USB 3.0 
Micro-AB
 Used by higher-

speed devices, 

along with the 

B-only variant, 

which has the 

corners cut.

2

USB 2.0 
Micro-B

 Found on most 

accessories, this 

plug and socket 

are compact 

but quite easy 

to damage.

4

USB Type-C
 Fitting either 

way, this 

sturdy socket 

is taking over; 

Thunderbolt 3 

also uses this 

connector.

EXPLAINED… Common types of USB 

 macformat.com  @macformat JULY 2018 | MACFORMAT | 55

USB On-The-Go (OTG) devices got the even 

more esoteric Micro-AB socket, which removed 

the corner chamfers to accommodate both 

USB 3 Micro-B and the largely mythical 

Micro-A. OTG allowed role-swaps between 

computer and device, so a phone could supply 

data to and draw power from a Mac as an 

accessory, but then connect to a camera or 

keyboard as a host.

USB 3.0 killed FireWire, but its new rival 

was Thunderbolt, an Apple-influenced copper 

version of technology first demonstrated 

by Intel over optical fibre. After the USB 

Implementers Forum (USB-IF) declined to 

back it, Thunderbolt was shoehorned into 

Mini DisplayPort instead, creating a 10Gbps 

multi-purpose connector.

USB 3.1, arriving in 2014, matched 

Thunderbolt’s speed, but only in Gen 2 ports, 

branded SuperSpeed+. Thunderbolt retained 

the advantage of daisy-chaining, allowing up 

to six devices per port, versus USB’s one.

Mobile hone
Smaller devices remained resistant to 

standardisation, and in 2003 the iPod 

switched from FireWire not to a USB port, 

but Apple’s 30-pin Dock connector. Even so, 

the interface was USB-compatible, with a 

Type-A plug on the other end of the cable.

The same arrangement was used for the 

iPhone in 2007, but when it began to feel out 

of scale with modern devices, Apple replaced 

it (in 2012) with Lightning: as compact as 

Micro-B, yet reversible and with a simpler plug, 

like the tab in USB ports, and a hollow socket.

USB Type-C emerged from the USB-IF 

(now including Apple) two years later, similarly 

compact and reversible – finally scotching the 

joke that there were four ways to insert a USB 

plug, three of them wrong – but retaining the 

form of a tab inside a receptacle, with a hollow 

plug fitting concentrically. Most Type-C ports 

are USB 3.1 Gen 1 or 2, but just to complicate 

matters, Thunderbolt 3 jumped formats and 

became a superset of USB Type-C.

Every Thunderbolt 3 port will work with 

any USB Type-C cable and device, but not 

every USB Type-C port supports Thunderbolt 

3 devices. All Thunderbolt 3 cables work with 

USB Type-C devices, and good-quality USB 

Type-C cables will work for Thunderbolt 3 

devices, but you’ll only get Thunderbolt 3’s 

maximum 40Gbps with a 0.5m or shorter 

cable, unless you buy an ‘active’ Thunderbolt 3 

cable with electronics that boost the signal. 

40Gbps should satisfy most of us for a 

while, but with Apple now sitting on the USB-IF 

board, what comes next will be interesting. 

Adam Banks



EDITED BY HOWARD OAKLEY 

What’s inside 

56
INVESTIGATE 

SLOWDOWNS

 Put an end to Mac 

performance issues 

57
iOS SOFTWARE

 Swipe away your 

touchscreen troubles

58-59
NETWORKING

 Solve Wi-Fi woes and 

connection conundrums

60-61 
macOS

 Sage advice to help 

overcome Mac maladies

Contact us

 Email your queries 

and your questions to 

genius@macformat.com

 Keep up to date by 

following us on Twitter  

@macformat

 Join the conversation 

at facebook.com/

macformat

 Get the latest 

subscription offers at 

macformat.com

Investigate and fix slowdowns
in /Library and ~/Library – the tilde (~) 

meaning the path to your user account’s 

Home folder. Filenames in those locations 

usually make it clear enough which files 

belong to which apps. Before you remove any, 

make a full backup of your Mac; if in doubt, 

check the support site for your software, as 

some developers list files made by their apps.

Once you’ve cleared out traces of your 

current antivirus products, restarted your Mac 

and restored performance, try replacements: 

Malwarebytes (free, malwarebytes.com/mac), 

DetectX (donationware, sqwarq.com) and tools 

from Objective-See (objective-see.com). These 

shouldn’t impose the same load on your Mac, 

but are well maintained and arguably provide 

even better protection from malware.

It’s also important to keep all security 

software up to date, to ensure it remains fully 

effective against malware, and to maintain its 

compatibility with newer versions of macOS.

Q
I bought a new iMac (Retina 4K, 

21.5-inch, Late 2015), which worked 

fine until I updated to macOS 10.13.3. 

Now it runs very slowly, with Microsoft Office 

apps taking two minutes to open, and Pages 

up to a minute. I also have Kaspersky and 

Avira antivirus products installed. Can you 

help to restore my Mac’s former speed?

by B R I A N  B O Y D

A
EtreCheck (free, etrecheck.com) 

is a valuable tool for resolving 

performance problems like yours, 

and antivirus software is the most likely cause 

here. Run EtreCheck and attend to anything 

it recommends, then uninstall both those 

antivirus products and run it again.

Some antivirus tools can be persistent 

and tricky to remove. Their most important 

components will be installed in the 

LaunchAgents and LaunchDaemons folders 

Our resident genius 
solves your Mac and  

iOS problems

EXPERT 
ADVICE

Activity Monitor can show you 
what’s slowing down your Mac,  
while EtreCheck should tell 
you how you can speed it up.
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iOS software 
Swipe away your touchscreen troubles and 
rekindle your love of Apple’s mobile devices

iOS software 
quick-fire 

questions 
Touch ID has 

stopped working. 
Is it broken?

> In Settings > Touch ID 

& Passcode, enter your 

passcode and check 

that your iPhone is set 

up to use Touch ID for 

unlocking, Apple Pay, 

and Apple’s various 

stores. If that looks 

okay, shut down your 

iPhone, wait a minute or 

so, turn it on and retry.

How can I keep 
private notes away 

from iCloud?
> In Settings > Notes, 

turn on the On My 

iPhone account. 

You can make this the 

default location in the 

setting immediately 

above, if you want. 

To make a private note 

in Notes, tap the item 

at the top left until you 

see the folders list, 

then tap a list in the 

On My iPhone section. 

Lists there are stored 

only on this device.

Lost access to 
vault with iOS 11

iOS devices. Further complicating matters, for 

a while iTunes hasn’t synced apps downloaded 

in iOS itself back to the Mac; with iOS 9, 

Apple introduced a set of techniques called 

‘app thinning’ to save bandwidth and storage 

by downloading only what is necessary for 

the device you’re using, which would prevent 

you transferring apps, for example, from your 

iPad to your Mac and then to your iPhone. 

Even having an iOS 10 device to hand is 

unlikely to help. At a stretch, there’s a chance 

My Photos might have stored a backup of its 

contents in a cloud-based service. You’d also 

need to be able to redownload the app from 

your past purchases. But you’ll probably find 

that My Photos stores its vault locally, and that 

you can’t transfer the vault’s contents given 

you’re unable to open the app.

Q
I had an iPad app, called My Photos, 

in whose ‘vault’ I kept photos and 

documents hidden from view and 

protected with a passcode. The app isn’t 

compatible with iOS 11, so it stopped working 

when I upgraded. It’s no longer on the 

App Store and I can’t locate its developer. 

Can I install it on another iOS device running 

iOS 10 to access my protected documents?

by H A R R Y  W I L L I S

A
A few apps have offered a vault 

feature, including Private Photo 

Vault, which is compatible with iOS 11. 

We’ve been unable to trace your app on the 

App Store – it does appear to have vanished.

For a short period after iOS 11 shipped, you 

could have returned to iOS 10 and restored 

from a backup made before upgrading. That 

depends on Apple providing that older version 

for your device, which it has stopped doing. 

You’d also have needed a suitable backup – 

local or in iCloud – from which to restore.

Often the protection provided by vault 

apps is rudimentary, only sufficient to keep 

prying eyes away, and easily bypassed when 

your iPad’s storage is accessed from a Mac. 

Try iMazing (£34.99, imazing.com – there’s a 

trial version available) to test whether it’s able 

to access the files trapped in your vault, and 

whether they’re encrypted or readily viewable.

In iTunes 12.7 and later, you can’t download 

iOS apps or manage those that are installed on 

For a short period after 

iOS 11 shipped, you could 

have returned to iOS 10
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Vault apps can protect private info on a shared iOS device, 
but make sure you have a backup of that data somewhere.
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Networking 
We help to solve your Wi-Fi woes 
and connection conundrums

Can I stop others 
accessing my Wi-Fi 

during the day?
>  If your Wi-Fi spills into 

a public area and you 

want to secure it when 

you’re out or during the 

night, some routers can 

be configured to turn 

their radio signals off 

or to low power mode 

on a schedule. Check in 

the router’s manual or  

the advanced settings 

of its admin tool.

How do I check 
my firewall blocks 
incoming traffic?

> In your router’s admin 

tool, note the router’s 

external (public) IP 

address. Connect your 

Mac to another internet 

connection, such as 

your iPhone’s Personal 

Hotspot, open Network 

Utility, then run a port 

scan on that IP address. 

You should never do 

this on another 

IP address, as it is 

considered a hostile act.

Bluetooth crisis

Networking 
quick-fire 

questions 

These features use Bluetooth to detect 

the presence of nearby devices, and establish 

a direct connection between them using Wi-Fi. 

As your iMac has its Wi-Fi turned off, this can’t 

function fully, causing the connection to drop, 

then start all over again.

This combines with a long-standing 

problem with some Macs running El Capitan 

or Sierra, whose Bluetooth has never been 

entirely stable: many people still suffer from 

sporadic spontaneous disconnect-reconnect 

cycles. When that wobbly system is then 

bombarded with proximity-based attempts 

to connect, it can be sufficient to break its 

Bluetooth service altogether. That seems 

most likely when the other Mac is a recent 

MacBook Pro updated to 10.13.4.

Hopefully, Apple will fix this in a future  

update. Until then, you have a choice between 

turning off Bluetooth on the MacBook Pro, 

preventing use of features that use proximity, 

or turning on Wi-Fi on the iMac, which may 

allow the two computers to connect fully 

for Continuity features and for everything 

to settle down again.

Q
Whenever I use my new MacBook 

Pro near my iMac, the latter’s 

Bluetooth starts to play up. At first, 

it loses its wireless keyboard and Magic 

Trackpad 2, which then reconnect. It often 

worsens to the point where I have to plug 

them both in, using their charging leads. 

The iMac is running macOS 10.12.6 and uses 

an Ethernet connection, with Wi-Fi turned off. 

The MacBook Pro runs 10.13.4, connects 

over Wi-Fi, and carries on working fine. Why?

by H A R R Y  R I C H

A
What’s most likely to be happening 

is that the MacBook Pro is trying to 

talk to your iMac due to their close 

proximity. That behaviour is extensively 

employed by the Continuity set of features; 

these are intended to make it easier for you 

to use multiple Apple devices together – 

for example, Handoff for moving a task from 

your iPhone to your Mac (or vice versa), and 

AirDrop for sending files or other info directly 

between devices, even when there’s no local 

area network available to facilitate this.
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Even if another Mac isn’t 
listed in the Bluetooth 
pane, Continuity may still 
be sending it messages.



Networking GENIUS TIPS

1Turn on the hotspot
On your iOS device, go to Settings > 

Personal Hotspot. Turn on the feature. 

When connecting over Wi-Fi, you need 

the password shown (unless your devices 

are using the same iCloud account); with 

USB you don’t need a password at all.

2Get things connected
Connect the iPhone to your Mac 

using its USB cable, as if you were going 

to sync it with the Mac. If your Mac has 

a USB-C port, you’ll need an adaptor or 

USB-C to Lightning cable to hand for this. 

If iTunes or Photos opens, quit it.

3Avoid unnecessary use
On your Mac, go to System Prefs’ 

Network pane. ‘iPhone USB’ should be 

listed on the left as a network interface. 

Turn on ‘Disable unless needed’ to use 

the iPhone as a fallback only when your 

usual connection fails or is unavailable.

 HOW TO Use Personal Hotspot as a fallback connection 

What’s fastest 
for file transfers 
between Macs?
> Use Target Disk Mode 

over Thunderbolt, which 

enables you to browse 

one Mac’s drive on the 

other. If both Macs are 

in macOS, on one go to 

System Prefs’ Startup 

Disk pane, click Target 

Disk Mode, then Restart. 

If one is shut down, 

power it on and hold T 

till a Thunderbolt icon 

appears; if a firmware 

password is set on your 

Mac, hold å instead, 

enter it, then press T.

When finished, eject 

the Mac in Target Disk 

Mode from the other 

before shutting it down.

Networking 
quick-fire 
questions 

JULY 2018 | MACFORMAT | 59 macformat.com  @macformat

iCloud is slow to sync
simultaneously downloading a large update, 

iCloud takes a back seat.

Signing out of iCloud and back in again is 

unwise once syncing has started, but may be 

helpful if it hasn’t. It will disrupt other services, 

and should be your last resort.

Q
iCloud performs poorly when 

syncing documents. How can I get 

iCloud Drive to sync immediately, 

rather than waiting until it gets round to it?

by D A V E  H A L L I W E L L

A
Apple doesn’t provide controls to 

enable you to force a Mac to sync 

with iCloud Drive manually. When 

syncing is taking place, it’s signified by a 

circular progress indicator next to iCloud 

Drive in Finder’s sidebar, and a cloud icon 

next to files that have yet to be synced.

Syncing is complex and occurs in stages. 

If it’s slow to start, hasten it by adding a small 

file transfer. If you need syncing to finish 

quickly – perhaps so you can continue work 

on another device – then pause other internet 

use while it’s in progress, as iCloud doesn’t 

contend strongly for bandwidth; if you’re 

Cirrus (free, eclecticlight.co) can 
send a 1MB test file to iCloud Drive 
in an attempt to kick-start it.

iCloud syncing gets slow when you’re also downloading 
large files. Pause other transfers to speed it up.
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macOS 
Shine a spotlight on sagacious solutions 
to your most maddening Mac maladies

macOS 
quick-fire 

questions 
How do I restore 

items in the Open 
Recent submenu?
> Occasionally, a crash 

or bug may clear the 

contents of an app’s 

Open Recent submenu. 

The list is maintained by 

Launch Services, part of 

macOS over which you 

have little control. Try 

restarting; if that doesn’t 

fix it, temporarily starting 

up in safe mode (bit.ly/

macsafemd) should.

How to find files in 
system folders?

> In Finder, choose File 

> Find. In the criterion’s 

leftmost pop-up menu, 

choose Other. In the list 

that appears, put a tick 

next to ‘File invisible’ and 

‘System files’ and click 

OK. Set up rules (click 

+ to add a second) to 

check these attributes, 

matching against ‘Visible 

or invisible’ and ‘are 

included’, respectively.

You can still restore a keychain from 

before the update, but under a different name. 

Then, use Keychain Access to copy passwords 

and other items from the old keychain and 

paste them into the current one, although 

that becomes tedious. With each paste you’ll 

normally be prompted to authenticate with 

your user account’s password.

Also check in Safari’s preferences that 

AutoFill is turned on for ‘User names and 

passwords’. (Note that in Safari 11.1 or later, 

you must interact with a form before AutoFill 

offers you a choice of data to populate it with.)

Safari can keep some usernames and 

passwords in the Local Items keychain, which 

may also be listed in Keychain Access’s left 

pane. You may also see older keychains with 

names like login_renamed, which are created 

when there are problems with the regular 

login keychain. Once your login keychain is 

up to scratch again, you should be able to 

trash all those old renamed versions.

Missing passwords after update

Copy items from a backup to rebuild 
a fresh login keychain using Keychain 
Access. Many everyday internet 
passwords are kept in Local Items. 

Q
Installing a Safari update became 

stuck, so I restarted my Mac. When 

the update completed, the new 

version couldn’t access my old passwords. 

I tried restoring my keychain, which is local 

(not iCloud), but Time Machine says it can’t 

do that. How can I get my passwords back?

by J A N E

A
Look in the Keychains folder in your 

Home folder’s Library – in Finder, hold 

å and choose Go > Library. Among 

other files, you should see a keychain there 

named login.keychain-db, which is your user 

account’s current (login) keychain. View its 

contents using Keychain Access, which you’ll 

find in /Applications/Utilities.

If that login keychain is almost empty, 

your previous keychain became damaged, 

perhaps when your Mac restarted during the 

update, and macOS has replaced the old one 

with a new, almost empty one.



Q
If I turn Time Machine backups off, 

will I lose access to earlier versions 

of my work?

by M A R C  J A M E S

A
No, macOS’s version management 

system doesn’t depend on a backup 

drive, or Time Machine even being 

configured. You can browse old backups at any 

time: hold å, click Time Machine’s menu bar 

icon and choose ‘Browse Other Backup Disks’.

If the apps you use are built to make use 

of macOS’s Auto Save and Versions features – 

check for File > Revert To – make sure you 

save new files early on; that will enable you to 

preserve milestones in your work, and to roll 

back changes even with Time Machine turned 

macOS GENIUS TIPS

Does macOS’s file versioning 
system require Time Machine?

off. However, when Time Machine is turned 

off, backups are no longer made on external 

storage, and though your work in apps that 

support versioning will be protected against 

changes made accidentally or which you 

reverse, it’s vulnerable to drive failure. 

The Revert To command displays an 

interface like that of Time Machine, enabling 

you to roll back changes made to a document. 

Their similar presentation is a cause of 

confusion, but the versioning system doesn’t 

require Time Machine to be turned on.

The Versions browser includes file versions 

from Time Machine only if your backup drive 

is available. You’ll always see those from when 

you saved manually or the app auto-saved – 

though the latter are weeded out over time.

Does High Sierra 
still leak passwords 
used for encryption?
> Versions prior to 10.13.4 

wrote some encryption 

passwords into the main 

log and install.log when 

using encrypted APFS 

volumes. Apple fixed this 

in 10.13.4, but passwords 

for such volumes made 

earlier may be readable; 

it’s worth trashing /var/

log/install.log for safety.

How can I make 
links in Finder?
> Finder’s aliases are 

preferred over symbolic 

or hard links – features 

of UNIX, on which macOS 

is built – for almost every 

purpose. They’re durable, 

continuing to point to the 

original if moved. Hold 

å+ç and drag an item; 

a curved arrow on the 

pointer means you’ll get 

an alias where you let go.

macOS  
quick-fire 
questions 

The Versions browser looks much like Time 
Machine, but doesn’t require that feature to be 
turned on. Versions are added with each save.
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Q
My MacBook Pro froze when 

installing the High Sierra 

10.13.4 update. Now it won’t 

start up properly, and just sits there 

with a dark display. What can I do?

by S T E V E  W O L F E

A
That update included an EFI 

(Extensible Firmware Interface) 

update for every Mac, which for 

some people has brought trouble and 

left their Macs in limbo.

Force your MacBook Pro to shut 

down by holding the power button, leave 

it for a few seconds, then power on and 

immediately hold ç+R to enter macOS 

Recovery. If the EFI update went wrong, 

recent models should automatically 

recover, displaying a progress bar while 

they do. Macs that still play a startup 

sound will inform you by making three 

long, three short, and three long tones. 

However, recent models of MacBook Pro 

are silent at startup.

Once in Recovery, open Disk Utility 

and run its First Aid feature on your 

startup disk. Afterwards, you should use 

Recovery’s option to reinstall macOS 

over the top of your existing installation. 

If you can’t get into Recovery, try 

resetting the SMC by following Apple’s 

steps for your model at bit.ly/mfrstsmc.

If your Mac continues to have 

problems, it’s worth running hardware 

diagnostics by following the advice given 

at bit.ly/mfappldiag or bit.ly/mfapplaht 

(depending on the age of your Mac). If all 

else fails, make an appointment at your 

nearest Genius Bar.

An update froze my MacBook Pro

If a failed update leaves your Mac in limbo, restart 
in Recovery and run Disk Utility’s First Aid tool.



Step up your

Written by Alex Blake

It can be quick and easy to secure your  
Apple kit – and the benefits are immense

SECURITY
espite its necessity, 

many of us can be a 

little reluctant to make 

our devices as secure 

as possible. We know 

we need to use strong, individual 

passwords and set up two-factor 

authentication, but we don’t always 

follow through.

But it doesn’t have to be that 

way. Safeguarding your Mac and 

iOS devices is easy, and the payoff 

is absolutely worth it every time.

That’s where we come in. We’ve 

written this guide to give you all 

the information you need to boost 

the security of your Apple kit, both 

online and offline. Read on to find 

out how to neutralise threats and 

hamstring the hackers.
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A
pple is known for the 

security of its devices, 

especially compared to 

Windows and Android. But as the 

proliferation of digital technology 

has accelerated, Apple devices have 

become more appetising targets for 

the ne’er-do-wells of the world.

That means it’s more important 

than ever to understand how to make 

your devices as secure as they can be. 

Security setbacks
Despite its long-standing reputation 

for watertight security, Apple has 

suffered a number of embarrassing 

security slips in the recent past. 

There have been a number of 

instances of simple text messages 

crashing iPhones because they contain 

a glyph the phone cannot process. 

It has been found that the all-powerful 

root user on your Mac could be easily 

accessed without a password, which 

could potentially put your computer 

at risk. And the Meltdown and Spectre 

vulnerabilities showed that Macs are 

far from infallible (although these 

exploits also affected Windows).

These stories illustrated the need 

to keep your Apple devices as up to 

Are your devices secure?

Apple’s hardware protections
Although they’re both intended as 

convenience features, not security 

features, Face ID and Touch ID are 

still very secure. That is due to the 

built-in Secure Enclave, an isolated 

hardware mechanism used to protect  

your fingerprint and facial data.

That doesn’t store that data as 

an image, but as ‘a mathematical 

representation’ that can’t be reverse 

engineered. That data is encrypted 

and is not sent to Apple, and it’s 

protected with a key that’s only 

available to the Secure Enclave.

That’s not the only method Apple 

uses to protect your data. The latest 

MacBook Pro design comes with a  

Touch ID sensor embedded in its 

Touch Bar. This was powered by a 

dedicated T1 chip, which houses the 

Secure Enclave to process your data.

The iMac Pro then introduced the 

T2 chip, the second generation of 

Apple’s secure processor. It enables 

new encrypted storage and secure 

boot capabilities in the iMac Pro, 

while also handling things such as 

the FaceTime HD camera’s image 

signal processor, used for exposure 

control, among other tasks.

date as possible and ensure that you 

don’t miss out on essential patches 

from Apple. But installing the latest 

updates is not the only way you can 

keep all of your devices safe. 

Luckily, as Apple users we have a 

lot of built-in security features at our 

disposal. Apple has been very careful 

to stop threats in their tracks, with 

features like Gatekeeper, FileVault 

and the Secure Enclave coming as 

standard in Apple’s latest kit.

In fact, the recent security scares 

were, in a way, exceptions that proved 

the rule of Apple security. The fact that 

they generated so much press was due, 

in part, to the rarity of such serious 

exploits in both Macs and iOS devices. 

Generally speaking, as an Apple user 

you are much more resistant to hacks, 

exploits and vulnerabilities than your 

friends on Android and Windows.

Sandbox safety
On your Mac, one reason for that 

excellent security is the way Macs 

handle and install apps. Each app is 

‘sandboxed’, meaning its privileges 

are limited to ensure it behaves only 

as you expect. That makes it much 

harder for malicious code to exploit 

apps and put your computer at risk.

It’s also very easy to see what apps 

are able to access on your computer. 

For example, go to System Preferences 

> Security & Privacy > Location 

Services to see which apps can find out 

about your location. On your iPhone, 

you can get the same information in 

Settings > Privacy > Location Services.

Still, there are plenty of things you 

can do to strengthen the security of 

your devices. Over the next few pages 

we’ll take you through the key steps to 

boosting your protection.

Touch ID combines security and convenience: a short press of your fingertip and access is granted.

Step up your security FEATURE 
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HOW TO Secure your Mac in six simple steps 

A few simple settings to keep your Mac safe

O
ne of the major advantages of 

macOS is the system’s raft 

of built-in security features. 

From FileVault to Gatekeeper, Apple has 

integrated features that can stop threats 

before they get started.

Generally speaking, you should stick 

to downloading Mac apps from the Mac 

App Store. However, sometimes you 

may want to download an app from a 

third-party developer that you trust. 

Apple can give developers a unique ID 

for their apps – Gatekeeper uses this to 

recognise legitimate apps, and can block 

those that don’t have a valid ID.

Another useful feature is FileVault. 

This lets macOS automatically encrypt 

your Mac’s startup disk, thus preventing 

Protect your Mac
It’s best to stick to apps 
from the Mac App Store, 
or at least those from 
‘known’ developers.

unauthorised access to key areas of your 

computer by malicious actors.

You should always protect your Mac 

with a strong password that you don’t 

use anywhere else. If you’re unsure how, 

use the password generator in Keychain 

Access, in File > New Password Item and 

click the button that shows a key.

Finally, it’s a good idea to create two 

user accounts. Make a standard account 

for everyday use, separate from the 

powerful access of your admin account, 

the latter being the kind you made when 

you first set up your Mac. This is useful 

for keeping things safe if someone uses 

your Mac without your permission.

Manage logins
In System Preferences, click Users & 

Groups; under your username you can 

add a password or change an existing 

one. In Login Options, make sure you 

turn off Automatic login, too.

Reset user passwords
To reset the password of any account, 

hold ç+R at startup. When the macOS 

Utilities window appears, go to Utilities > 

Terminal, type resetpassword, then 

follow the on-screen instructions.

Firmware password
If you’re worried about passwords being 

reset from Terminal, set a firmware 

password. Hold ç+R at startup, go to 

Utilities > Startup Security Utility, then 

click Turn On Firmware Password.

Root user
This has complete access to your Mac’s 

files, so don’t enable it without a very 

good reason, and be sure to disable it 

afterwards. See bit.ly/mfru for help – 

and give it your own strong password!

FileVault
In System Preferences > Security & 

Privacy, click the FileVault tab, then the 

padlock icon. Type an admin name and 

password, then click Turn On FileVault. 

The Mac then silently encrypts its drive.

Gatekeeper
To change your Gatekeeper settings, 

go to System Preferences > Security & 

Privacy > General. Here you can choose 

whether to allow apps from outside the 

App Store to be installed.
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What can you do to make your iOS devices more secure?

B
ack in March 2018, news 

emerged of a mysterious box 

called GrayKey. It allowed any 

person to gain access to an iOS device’s 

contents, locked or otherwise.

While the device is intended for law 

enforcement use, it highlights an issue 

that’s relevant to everyone: weak device 

passwords can be a real security issue. 

That’s because GrayKey reportedly uses 

a ‘brute force’ attack to repeatedly guess 

the target device’s password until it gets 

it right and gains access.

What can you do? Matthew Green, 

a security researcher at Johns Hopkins 

Information Security Institute, suggests 

iPhone & iPad security
Beyond Touch ID, it’s a good idea to use a lengthy alphanumeric passcode that is difficult to crack.

App downloads
Only get apps from the App 

Store or directly from developers 

approved by Apple. Never tell your 

Mac to run other apps, unless 100% 

confident in the source.

Passcode length
Don’t use a short four-digit 

passcode on iOS. Instead, consider 

increasing it to eight characters 

or more and including numbers, 

symbols and mixed-case letters.

Password managers
Try using Safari’s password 

suggestions or a password manager 

like LastPass. Make sure it’s not a 

word that can be easily associated 

with you or someone you know.

Admin account
Don’t use the main account 

on your Mac day to day – create 

a new standard account instead. 

Add a firmware password to prevent 

any account’s password being reset 

without your permission.

Authentication
Make sure to enable two-

factor authentication on websites 

you use and your Apple ID in order 

to add another layer of security.

System updates
Don’t linger on an old version 

of your device’s operating system – 

download the latest macOS and iOS 

updates to get fixes from Apple to 

plug potential security holes.

TrafficLight
There are browser extensions 

that can alert you to suspicious 

websites. If you’re using Safari, 

try TrafficLight (bitdefender.com).

Don’t get complacent!
Using a Mac or iPhone won’t 

make you invulnerable. Always take 

precautions and secure your Apple 

devices against threats – getting 

complacent can put you at risk.

QUICK TIPS

that increasing the length of your 

password (as well as mixing in 

alphanumeric characters) can help. 

According to his calculations, a  

10-digit password would take GrayKey 

(or other brute-force attackers) 12 years 

to crack on average. A four-digit one, 

on the other hand, would take a mere 

6.5 minutes on average.

App Store downloads
As a further security measure, iOS only 

lets you install apps from the App Store. 

There’s no way to install apps from third-

party websites as you can on a Mac, and 

you can’t override this in iOS’s settings. 

Apple reviews the apps in the App Store, 

although that hasn’t stopped the odd 

scandal (see page 66).

PASSCODE OPTIONS
 You can change your passcode in 

Settings > Touch ID/Face ID & Passcode. 

When doing so, tap Passcode Options for 

a few more choices.

 Tap Custom Alphanumeric Code to 

enter a passcode comprised of letters, 

numbers and symbols. It’s a good idea 

to mix in upper- and lower-case letters.

 If you’d rather stick to numbers, you 

can choose a Custom Numeric Code. 

This can be as long as you like, so it can 

be more secure than a six-digit code.

 The final option is to switch to a four- 

digit passcode. We don’t recommend this 

as it’s trivial for a system like GrayKey to 

crack, or a nearby person to observe.
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Apple ID and iCloud

Apple’s security scandals

Sync your data in safety

 m

G
iven that it houses your notes, 

photos, reminders and much 

more, iCloud is unsurprisingly 

pretty secure. Between your Apple ID, 

iCloud Keychain and Apple’s encryption 

methods, your files are kept safe and 

sound in the cloud.

One simple way to keep your iCloud 

account secure is to set up two-factor 

authentication (2FA). This adds an extra 

layer of security to ensure that someone 

can’t gain access to your account if they 

have your password – they also need a 

code sent to your trusted devices. We’ve 

outlined how to set up 2FA opposite.

Bear in mind that you should set up 

2FA for every Apple ID you have. If you 

signed in to iTunes on an old Windows 

PC years ago, then bought a Mac and 

set up a new Apple ID at a later date, 

you’ll probably now have two Apple IDs, 

and so should set up 2FA for both.

Limiting access by using 2FA is not 

the only way your iCloud data is kept 

safe from threats. There’s also iCloud 

Keychain, Apple’s built-in password 

manager for your Safari usernames 

A
pple’s reputation for super-

tight security has taken a 

hit over the last year or two. 

Of serious concern was a bug involving 

the root user account in macOS. It was 

found that this powerful account could 

be accessed by anyone, simply by typing 

the username ‘root’ followed by a blank 

password on a Mac’s login window, then 

repeatedly hitting the ® key.

In 2015 and 2016, Apple was at the 

centre of a row with the FBI when it 

refused to unlock an iPhone possessed 

by one of the perpetrators of the San 

Bernardino shooting. Apple argued that 

doing so would weaken the security of 

all iPhones and create a backdoor, but 

its critics stated it was hindering the 

investigation of a terrorist incident.

The App Store has also come in for 

criticism over the ability of bogus and 

exploitative apps to gain prominence 

in App Store search results. Apps that 

masquerade as legitimate services but 

charge users inordinate amounts in 

monthly payments have often been 

spotted at the top of iOS search 

results, as reported by the press.

You’ve probably heard of Spectre 

and Meltdown – they were hard 

to miss in the news in January.
 Both are serious vulnerabilities 

affecting huge numbers of modern 

processors, including those in all 

modern Macs, iPhones and iPads 

(Watch is unaffected).

Meltdown targets the way your

operating system and apps are 

isolated from each other, while 

Spectre breaks the separation 

between two apps. Both can be 

patched, but Spectre is harder to 

mitigate (and is harder to exploit).

In order to remove the exploits 

in the future, processors will need 

to be designed differently. Luckily, 

Intel, AMD and ARM have pledged 

to do just that.

Apple was quick to patch the 

vulnerabilities, issuing updates in 

macOS 10.13.2, iOS 11.2 and tvOS 

11.2. Make sure you have them.

and passwords, credit card information 

and Wi-Fi network info. It can also sync 

your account information for a range of 

Apple services like Mail and Messages, 

plus third-party websites, to all your 

Apple devices.

All that data is encrypted by Apple, 

both on your devices and in transit, to 

ensure it cannot be read by 

unscrupulous actors. Because 

these features are integrated 

into Apple’s systems, they’re 

free and easy to use.

Given that it houses your photos, 
notes, reminders and much more, 
iCloud is unsurprisingly secure

Two-factor authentication sends a verification 
code to a trusted device to further ensure security.

If a bug can get past Apple, it just shows how 
important it is to set up your own protection.

 macformat.com  @macformat

Spectre and
Meltdown
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How to Use two-factor authentication in iCloud 

Secure the websites you use

As awareness of online security 

threats has spread, a lot of websites 

have started offering ways to protect 

yourself. As we explain below, one of 

the main ways a lot of websites do this 

is through two-factor authentication 

(2FA), which helps to protect your 

accounts on popular websites like 

Facebook and Amazon. By enabling 

2FA, these websites know that it 

really is you trying to log in, thus 

shutting out anyone trying to gain 

unauthorised access to your account.

As well as that, browsers have 

begun integrating new security 

features. Safari, for example, now 

enables content blockers, which can 

stop malicious code (such as malware 

embedded in adverts) running on your 

Mac or iOS device.

Another good way to keep safe on 

the websites you browse is by using an 

extension like TrafficLight from online 

security firm Bitdefender. As the name 

suggests, it uses a traffic light system 

to quickly show you which websites are 

safe to browse. This can be displayed in 

your search results, helping you to stay 

away from dodgy websites and thereby 

preventing attacks in the first place.

Ideally, you should use a different 

password for every website you use. 

In practice that can be hard to do, but 

Safari makes it easy by suggesting 

tough passwords and automatically 

saving them for you.

Initial setup
Go to System Preferences > iCloud, 

sign in if neccessary, then click Account 

Details. Once you’re there, click the 

Security tab, then click Turn On Two-

Factor Authentication.

Facebook
Click the down arrow at the top right, 

then click Settings. Click Security and 

login on the left, then click Edit next to 

‘Set up two-factor authentication’. Click 

Get Started and follow the instructions 

on the screen, then click Enable to finish 

setting up two-factor authentication.

Use the code
Now, whenever you sign in to iCloud 

you’ll get a notification on your trusted 

devices asking you to allow access. Do 

so and you’ll get a code to enter on the 

other device/iCloud.com to finish up.

Twitter
At the top right, click your profile icon, 

then click ‘Settings and privacy’. Click 

Account, then ‘Set up login verification’, 

then Start. You’ll need to enter your 

Twitter password. Enter your phone 

number – Twitter will text you a code 

to complete the process.

Two-step verification
Two-factor authentication (2FA) is now 

switched on. If you’ve set up two-step 

verification (2SV) and want to update 

to 2FA, turn off 2SV in Security settings 

and set up 2FA, which is more secure.

Amazon
Go to your account settings and click 

‘Login & security’. Under Advanced 

Security Settings click Edit, then Get 

Started next to Two-Step Verification. 

Enter your phone number and click 

Send code. Once you have it, enter the 

code, click ‘Verify code’ and continue. 

A lot of popular websites give you extra layers of safety

Step up your security FEATURE 
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ou can spend a fortune buying 

the latest smart devices for your 

home – high-definition security 

cameras, interactive disco lights, 

and, of course, Apple’s own HomePod with 

Siri voice control. But there are other ways of 

introducing smart tech into your home that 

don’t require you to remortgage the place in 

order to pay for it all.

Smart tech can be expensive, 
especially when it’s from Apple, 
but there are plenty of affordable 
options that won’t break the bank

Y

The smart home is 
here – live the Apple 

dream today!

LIVE 
SMARTER
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A simple smart plug is an affordable 

option that will work with any of your existing 

household appliances, allowing you to turn 

lights and other dumb devices on or off by 

remote control, while low-cost motion sensors 

can provide affordable security for every room 

in your home. It can even be fun to try a few 

simple DIY programming projects to get all 

your smart devices to work together, so here’s 

our guide to the latest smart but affordable 

tech for your Apple Home.
Buying into the smart tech revolution needn’t cost you 
a fortune; there are reasonably priced gadgets out there.

Contact us

 Email your queries 

and your questions to 

letters@macformat.com

 Keep up to date by 

following us on Twitter  

@macformat

 Join the conversation 

at facebook.com/

macformat

 Get the latest 

subscription offers at 

macformat.com
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APPLE HOME Budget smart tech

Most smart lighting systems are costly, as you 

have to start by buying a kit that contains two 

or more light bulbs, plus a special hub (also 

called a bridge or gateway) that connects to 

your router in order to control the lights.

Let there be (affordable) lights 
However, prices have started to come down 

recently, and Philips – the top dog in the smart 

lighting market with its Hue range– now sells a 

Hue White Starter Kit that contains two white 

bulbs and a bridge for just £59.95 (and it works 

with HomeKit for Siri voice control, too).

LIFX takes a different approach with its 

lighting range. Instead of using a hub that 

connects to your router, the LIFX lights have 

all their smart tech (including HomeKit) built 

in to the bulbs themselves. This means that 

you can get started with just a single smart 

light for a specific room or location, such as 

a child’s bedroom, with prices starting at 

just £24.99 for a basic white light bulb, 

or £44.99 for a colour bulb.

Even budget-conscious Ikea 

is getting in on the act, with its 

Tradfri range of smart lights. 

Ikea provides a number of 

options, including its 

Tradfri Gateway Kit, which 

includes two white bulbs 

and a gateway for £65. 

However, it also sells a 

low-cost Motion Sensor 

oice control is the big thing in 

smart home technology at the 

moment and, of course, Apple 

recently got in on the act with 

its HomePod smart speaker. But, in typical 

Apple fashion, the HomePod is far and away 

the most expensive option in this category, 

costing £319 if you want to use Siri to control 

the (still rather limited) range of lights and 

other devices that are compatible with 

Apple’s HomeKit platform. 

It’s Amazon that is really making the 

running here at the moment, though – its 

Alexa voice assistant already works with a 

really wide range of lights, thermostats and 

other devices, and its Echo range of smart 

speakers includes affordable options such 

as the Echo Dot, a little plug-in accessory 

that lets you add voice control to an existing 

speaker for just £49.99. 

Google’s Assistant technology isn’t quite 

so popular, but it has its own low-cost option in 

the form of Google Home Mini at £49. And, if 

you’re a fan of the do-it-yourself Raspberry Pi, 

Google has even launched a version of its 

Assistant software for that, too.

V

From Amazon to Ikea, there’s a range of affordable 
smart devices now available for your home

What about 
HomeKit?

 HomeKit is Apple’s 

smart home platform. 

It enables you to control 

compatible accessories 

from an iOS device. 

You get manual control 

in the Home app and 

using Siri. HomePod, 

iPad and certain Apple 

TV models (see bit.ly/

hkrmte) enable remote 

control and automation.

What about 
heating?

 Smart thermostats 

can be expensive. 

A cheaper alternative 

is a smart valve, such 

as Elgato Eve Thermo 

(£59.95), which can be 

used to control just one 

radiator. Others are 

available, but some only 

work with a companion 

smart thermostat.

FOR LESSFOR LESS

Get started with

Smart tech 
quick-fire 

questions 
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Belkin’s WeMo Insight 
Switch can monitor your 
power consumption.

Explained
IFTTT

 Short for ‘If This, Then 

That’, IFTTT is a free service 

that can be used to link 

smart devices so that they 

work together. There’s a 

free IFTTT app for iOS 

devices, or you can read 

more about it on ifttt.com.
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APPLE HOME Budget smart tech

Kit for just £25. This includes one of the Tradfri 

bulbs, along with a motion sensor that can be 

used to control the light, perhaps illuminating 

the bulb if it detects an intruder during the 

night, or when you’re away on holiday.

Safe and sound
Motion sensors are another inexpensive option 

for your smart home. Security is important to 

everyone, but a good security camera can be 

expensive, often costing £150-£200 for a 

model that provides high-definition video 

recording. Buying several cameras for different 

rooms just isn’t a viable option for most 

people. A simple motion sensor is a more 

affordable alternative – Elgato’s Eve Motion 

sensor is just £44.95. Elgato also sells handy 

little Eve Door & Window sensors for £34.95, 

so you can easily cover several rooms in your 

home for about £100. The Elgato sensors all 

support HomeKit, too – although they do need 

an Apple TV, iPad or HomePod to act as the 

relay point when sending security alerts over 

your home network. 

Alternatively, you can buy a more 

complete security kit, such as Samsung’s 

SmartThings Starter Kit. This is priced 

at £199 on Samsung’s own website, 

although we’ve seen it for less on 

Amazon and some other online stores. 

The SmartThings kit includes a number 

of sensors, 

including a 

motion sensor, door/window sensor, and even 

a ‘presence’ sensor – a kind of smart keyring 

that can help you to keep track of a young 

child or elderly relative – with all the sensors 

controlled by a central hub that connects 

to your router. The SmartThings hub can be 

used to control compatible devices from other 

manufacturers as well, such as security 

cameras and even video doorbells, so this is an 

affordable security kit that also allows you to 

expand your smart home system in the future.

There’s another affordable option for 

adding smart tech to your home. It’s possible 

to buy smart plugs and switches that can be 

used to control existing devices, such as lights, 

speakers, and even washing machines and 

other appliances. These simply allow you to 

turn the power on or off for a particular device 

via remote control, but that can still be handy if 

you want to schedule the lights to keep coming 

on when you’re away on holiday, or only use 

air conditioning at a specific time of day. 

Samsung’s SmartThings kit includes a smart 

plug, but if you don’t want to pay for the entire 

Samsung kit, you can 

buy individual 

smart plugs, such 

as Belkin’s popular 

WeMo Switch for 

as little as £39.99. 

Belkin also 

makes the more 

expensive WeMo 

Insight (£49.99), 

which can monitor 

your power 

consumption, 

helping you to 

save more money 

in the future.

Smart tech 
quick-fire 

questions 
Bluetooth or Wi-Fi?

 Most smart devices 

use Wi-Fi to send 

you messages and 

notifications via your 

home network. However, 

some lights and sensors 

opt for Bluetooth instead – 

which is cheaper, but has 

a more limited range. 

Bluetooth lights and 

sensors often need to 

use an Apple TV, iPad, 

or HomePod as a kind 

of relay in order to send 

you messages over the 

internet when you’re out.

 

What are 

motion sensors?

 There are two main types 

of motion sensor available 

for use in your home. 

A basic motion sensor will 

monitor an entire room, 

and warn you whenever it 

detects any movement at 

all within the room. Door 

and window sensors are 

a bit more specialised, 

focusing just on the 

movement of a door 

or window frame, and 

warning you if an intruder 

enters your home.

Elgato offers a 
range of contact 
and motion sensors 
that notify you if 
someone enters 
your home.
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Create your own smart control

EASY AS PI

The tiny Raspberry Pi computer 

costs as little as £10, and there 

are lots of DIY projects online 

that show you how to use the 

Pi to control smart devices in 

your home. You can connect the 

Pi to an iPad and use the iPad as 

a screen, and even get the Pi 

to work with devices that use 

Apple’s HomeKit software. 

If you’re intimidated by 

programming, then Logitech’s 

Pop (£80) is an easy-to-use 

‘smart button’ that uses simple 

commands to control a variety 

of different devices, including 

lights, blinds, locks and even 

Sonos speaker systems.
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The gadgets that bring light, heat and order 

FIVE OF THE BEST

Philips Hue 
White Starter Kit
£59.95
meethue.com

 It was Philips that really 

got the smart lighting 

market going, and it has 

now released the most 

affordable lighting kit 

we’ve seen. This starter 

kit gives you two smart 

bulbs, and a bridge 

that adds HomeKit 

compatibility. It works 

with Amazon Alexa and 

Google Assistant.

Belkin WeMo 
Switch
£39.99
belkin.com/uk

 Belkin’s Switch plug and 

companion app let you 

schedule activity for 

dumb home appliances. 

You might use it to turn 

on a lamp when you’re 

away or a fan when it’s 

hot, or turn off a clothes 

airer that has no timer. 

It works with Alexa – 

and HomeKit using the 

upcoming WeMo Bridge.

Samsung 
SmartThings 
Starter Kit
£199
smartthings.com

 Shop around and you 

can find this for a much 

lower price. It includes 

three different security 

sensors, a hub and a 

smart plug. The hub 

can also control some 

other manufacturers’ 

devices too, allowing for 

easy extension of your 

smart home system later.

Amazon Echo Dot
£49.99
amazon.co.uk

 Apple’s HomePod is 

a great speaker, but at 

£319, it’s an expensive 

option to gain voice 

control of your home. 

Amazon’s Echo Dot 

isn’t a speaker at all – 

it’s a microphone that 

you plug in to an existing 

speaker in order to use 

the Alexa voice assistant 

through it – at a fraction 

of HomePod’s cost.

You can control Philips’ Hue lighting using 
HomeKit, Amazon Echo and Google Home.

Elgato Eve 
Thermo
£59.95
elgato.com

 Eve Thermo is an 

affordable alternative 

to an expensive smart 

radiator valve. It can be 

used to control just one 

radiator, perhaps in your 

bedroom for cold winter 

mornings, and HomeKit 

support means that it 

can be linked with other 

devices, such as lights 

or motion sensors. 



EDITED BY LUIS VILLAZON 

Inspiring ideas for 
revamping old  

Apple kit

REUSE 
OLD KIT

intage Macintoshes never stop 

being desirable. Long after they 

have retired, there will always be 

a grateful new owner happy to receive a Mac 

512K, Mac SE or Mac Plus from my stockpile. 

Some will be stripped for parts, so that 

another, nearly working Mac can be restored. 

Others will just see their case converted into 

something retro and whimsical. Either way, 

the keyboard is just unwanted ballast. 

Consequently, I have a lot of them piled into 

a large cardboard box. And this is a shame, 

because the early Apple keyboards are just 

as much design classics as the Macs they 

plug into. In MF #310, I converted one of 

them to work with USB and I still use that 

keyboard quite regularly. But even I don’t 

need 11 keyboards! So instead I am going 

to upcycle them into something that will do 

justice to their design-classicky-ness, but 

which won’t take up as much space. It will, 

I assure you, be retro and whimsical…

Repurpose your old keyboards

What’s inside 

74-77
BOARD AGAIN

 Luis scrabbles to think 

of inventive uses for 

his old keyboards

77
TRIPLE CLEAN 

 There’s more than one 

way to clean a keyboard

Contact us

 Email your queries 

and your questions to 

lovemac@macformat.com

 Keep up to date by 

following us on Twitter  

@macformat

 Join the conversation 

at facebook.com/

macformat

 Get the latest 

subscription offers at 

macformat.com

V
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 The original Macintosh computers shipped with a basic keyboard 

that didn’t include a numeric keypad – or even arrow keys! Steve Jobs 

deliberately omitted the latter to force software developers to support 

the mouse. The M0120P numeric keypad attempted to rectify both of 

these oversights, although the arrow keys had an odd layout and had 

to share with some of the maths symbols. It uses a non-standard 4P4C 

connector cable, but even after 35 years, the key action is still one of 

the most satisfying of any keyboard ever.

 CLASSIC APPLE KIT: M0120P

In Luis’s world, 
there’s no such 
thing as redundant.



  

Key conversion LOVE YOUR MAC

Key board games 
QWERTY scores 63 points on a triple word square

 macformat.com  @macformat

A
dmittedly, it might seem like a 

keyboard that you aren’t going 

to type on anymore is completely 

useless. I mean really, at that point it’s just a 

bunch of plastic letter tiles arranged in a 

loose grid. But hang on a second! What else 

uses letter tiles arranged in a grid? Scrabble! 

What could be more retro and whimsical than 

a Scrabble set using keys from vintage Macs?

The first step was to clean the keys. I did 

some tests with different methods of cleaning 

(see this month’s How To guide) and after 

satisfying myself that none of them would do 

any harm to the plastic or the lettering, I went 

for the easiest, and loaded all the keyboards 

into the dishwasher. When they emerged an 

hour later, hot and steamy, I was in awe of how 

clean they were. They looked almost literally 

new! So new, in fact, that I was briefly tempted 

to just list them all on eBay for £20 each. But 

to do that, I’d need to test them and I couldn’t 

do that until they thoroughly dried out. I’ve no 

idea how long it would take for all the water 

inside the case to evaporate, but it’s probably 

at least 48 hours and I’m much too impatient.

Numeracy niggles
A standard Scrabble set has 100 tiles, which 

makes it sound like you would only need 

four keyboards. But of course, the letter 

Who needs 11 keyboards? 
Mac-loving scrabble 
players, that’s who!

If you lose any of the tiles,  
just raid another keyboard!



LOVE YOUR MAC Master of the keys

House husband discovers simple trick for cleaning keyboards: sparkling results from the dishwasher!
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Quick-fire
questions 

distribution isn’t even. There should be 

12 ‘E’ tiles, so to do this properly requires 

12 keyboards and I ‘only’ have 11. I could have 

sanded the lettering off some or all of the 

keys, and relabelled them, but this seemed 

contrary to the spirit of the enterprise (not to 

mention, a lot more work). So I stole an E off 

one of my working Macs (a Performa 6200) 

and left a Post-it on the display to remind 

me where to look, in the unlikely event I ever 

need to use that computer. Removing the 

keys from older Macs is a surprisingly delicate 

operation. The plastic spurs that connect 

them to the switch are brittle after all these 

years, so I had to prise the key up gently, 

like a tomb raider removing the jewelled 

eyes from an ancient statue.

The various keyboards aren’t exactly the 

same, of course. Differences 

in the colour of the plastic 

and letter font are all part of 

the charm, but the different 

mounting mechanisms 

affect how well they perform 

as Scrabble tiles. The best are from the Apple 

Keyboard (M0116) and Apple Keyboard II 

(M0487) that were used on the Macintosh 

Classic and LC models in the late 1980s and 

early 1990s. These have low profile keys 

with nice flat undersides. Next best are the 

mid-1980s compact keyboards with no 

numeric keypad. The keys are a little larger, 

with just a small lug on the underside. The 

keys from my two 1983 Apple Lisas are the 

worst. They have a huge forked prong on the 

bottom that prevents them from lying flat.

Protect the base
I could have cut off all the sticking out bits, 

but this seemed like an unnecessarily brutal 

mutilation. The Lisas are museum pieces 

and, one day, someone with more technical 

skill than me might get them working and 

demand to know why all the keys have been 

circumcised. Instead, I decided to 3D print 

some plastic bases for each key. They will 

connect to all the prongs and lugs, and 

provide a consistent, flat bottom – at the 

expense of wildly varying height.

In order to 3D print the bases, I needed to 

model them in a CAD app, and the easiest way 

to do that was to model the key itself first, and 

design the base from that. Well, maybe not the 

easiest, but certainly the most fun. I spent a 

happy couple of hours obsessing over various 

What if the 
mounting prong 
on the keyboard 

snaps off?
> Provided that enough 

plastic still protrudes 

from the base of the key 

switch, it is sometimes 

possible to 3D print 

(or even hand carve) 

a mounting bracket that 

connects the remaining 

stub to the underside of 

the key. Use two-part 

epoxy to glue it on, for 

maximum strength.

What is the font on 
Apple keyboards?
> The earliest Macs use 

Univers 57 Condensed 

Oblique. In 1999 this 

was replaced with VAG 

Rounded, on the iBook 

and gradually introduced 

across the whole Mac 

line by 2007. If you are 

printing your own 

replacement keys and 

can’t find VAG Rounded, 

Futura Book is a pretty 

close match. Since 2015, 

Apple has used its own 

San Francisco typeface, 

originally designed for 

Apple Watch, and now 

the system font in iOS, 

macOS and tvOS – see 

developer.apple.com/

fonts for more about it.

One day, someone might demand 
to know why all the keys have 
been circumcised

Magnetic keyboard 
tiles are also useful for 
household shopping lists.
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1The hard way
The least invasive approach is to clean 

each keycap individually with a cotton 

bud or a tissue. If you have the patience, 

isopropanol is a good solvent that won’t 

damage the plastic and it is widely 

available on Amazon. Gin or vodka is an 

acceptable substitute, but it isn’t really 

any cheaper and it takes longer to dry.

2The quicker way
If you want to save some elbow 

grease, you can pop all the keys off and 

throw them in the washing machine. Put 

the keys in a pillow case and knot the end 

to reduce the risk of losing any. You can 

use a washing cycle up to 60ºC without 

harming the plastic. Skip the spin cycle 

and fabric conditioner.

3The full monty
If the case is grubby too, or you 

don’t want the hassle of prising off the 

keys, you can wash old keyboards in the 

dishwasher. Put the keyboard face down 

and run the ordinary wash cycle with half 

a dishwasher tablet. Amazingly, the 

electronics in the keyboard will be just 

fine. But give it a few days to dry out.

 HOW TO Restore the finish on an old Mac keyboard 

Farewell, Luis
 Not content with 

transforming Macs, 

Luis is ‘modifying’ 

himself. We’d like to say 

a fond farewell, as Luis 

prepares to take his 

incredible knowledge 

and creativity to the 

world of academia.

subtle curves and angles in Fusion 360 before 

I remembered I was meant to be working.

The bases fit very nicely and I fixed them 

in place with a smear of water-soluble glue, 

so I could soak them off again if I ever wanted 

to restore the keyboards to working order. 

There’s just enough hollow space inside the 

keys to fit one of those tiny, round neodymium 

magnets, so I glued one of those in each key as 

well. With a sheet of metal under the Scrabble 

board, the magnets have just enough holding 

power to stick the tiles in place. So, now I have 

a Travel Scrabble set (provided you don’t 

mind travelling with a large sheet of 2mm 

mild steel). And magnetic letters can also do 

double duty as a fridge magnet poetry set.

Print your own
Since I then also had CAD models for the keys 

themselves, I tried 3D printing a couple for fun. 

I didn’t have the right colour printer filament – 

I don’t think you can even get printer filament 

in the Apple shades of beige and cream – but 

printed in ‘iron grey’ they actually look pretty 

good. I could print replacements for the keys 

I have pinched for Scrabble and still have 

working keyboards! But no, Luis! Remember, 

the reason for this Scrabble project in the 

first place is that I don’t have a use for that 

many keyboards. Still, I could print different 

coloured keys for W, A, S, and D and use one 

as a gaming keyboard…

So, after all that, what have we learned? 

Although the starting point was to upcycle 

some otherwise useless keyboards, I think 

the most important discovery is that no 

keyboard is beyond redemption. Many of 

the older keyboards had already lost a key 

or two over the years. But the magic of 3D 

printing allows us to make functional (if not 

cosmetically identical) replacement parts. 

Provided you already have a 3D printer, this 

is undoubtedly easier than trying to convert 

a modern USB keyboard to work over the 

old ADB interface. And it’s arguably a more 

authentic restoration technique too. And even 

for those of you that prefer to stick with Macs 

built in the last decade, you can take heart 

that no matter how filthy your keyboard gets, 

you can always restore it to pristine condition, 

simply by sticking its keys in the dishwasher.

The CAD model of a classic key is surprisingly complicated.

You could always 3D print 
replacements for all the keys 
you have stolen for Scrabble.
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 Awarded to a 

five-star product 

we believe is truly 

exceptional in its 

category. Given solely at the 

discretion of the Editor.

 Given to a 

hardware or 

software product 

that might not be 

the very best in its category, 

but is noted for affordability.

 Our group test 

winner gets this 

award for being 

the best of its 

kind when pitted against 

other comparable products.

 The MACFORMAT Awards

 Manifesto – our ratings explained
 Our reviews are totally 

independent; we’re not 

affiliated with Apple or 

anyone else, nor are we 

influenced by advertisers. 

You can trust us to give 

an honest assessment 

of a product’s worth.

The prices quoted for 

products are correct at 

the time of writing and are 

the best we can find from 

a reputable online dealer, 

excluding delivery. 

 A brilliant thing in all regards, 

and worth every penny

 Strongly recommended; any 

flaws are only minor concerns

 Worth considering, though 

there may be better options

 Notable flaws; look at 

alternatives as a priority

 A waste of your money and 

everyone’s time; do not buy!

What’s inside 

80-85  
HARDWARE 

 A high-res 360° video 

camera, an instant 

photo printer, a USB-C 

battery, and more

86-87  
ROUND-UP 

 Travel essentials: 

gadgets that will help 

your tech to keep going 

when on the move     

88-91  
GROUP TEST 

 Take note of which 

note-taking app gets 

our seal of approval    

92-95 
MAC SOFTWARE 
 Map your genealogy, 

draw on a digital canvas, 

go on an adventure with 

Lara Croft, and more

96-97  
iOS SOFTWARE 
 Outline ideas easily, 

track your health, and 

play god in the newly 

improved Sims Mobile

Our authoritative reviews 
help you make more 

informed choices

BUYING 
ADVICE

PANASONIC 
LUMIX GX9

p80



APPLE CHOICE Mac hardware

 I’m not sure how to 

feel about the GX9. 

On the one hand, it’s 

equipped with some 

great features and 

performs admirably. On 

the other, it feels almost 

like Panasonic has held 

back from what it could 

have been. That said, 

I’m still impressed by 

what it packs into such 

a small camera body.

Alex says…

The rear display can be tilted 
to give a better viewing angle 

when shooting from the hip.
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Panasonic 
Lumix GX9

 £699.99  FROM Panasonic, panasonic.co.uk  

 FEATURES 20.3-megapixel sensor, Live MOS sensor, 260-shot battery life, 

ISO100 to ISO25600, 4K video at 30fps, 12.4x7.2x4.7cm body

Small size, big performance

T  
his compact, high-performance 

camera uses the same 20.3MP 

Micro Four Thirds sensor that 

was in the GX8, minus the low-pass filter 

from the sensor. This is intended to improve 

fine-detail rendition, with the trade-off that it 

also increases the risk of interference patterns 

in fine textures and details. The image-

stabilisation system has also been enhanced.

The Lumix GX9 comes with 4K video and 

enhanced 4K Photo modes. Here, the camera 

uses its 4K video processing power to capture 

images designed to be exported as 8MP stills. 

The 4K burst mode captures frames at an 

impressive 30fps, and the GX9’s new auto-

marking feature helps you find key moments 

when editing your videos later.

The 4K Post Focus mode is even more 

impressive. In this mode the camera captures 

a short burst using every focus point, and in 

playback mode you can simply tap on the 

picture to choose the focus point you want. 

This enables you to adjust the focus after 

you’ve taken the shot. And new in the Lumix 

GX9 is in-camera focus stacking, so you no 

longer need a computer to merge 

a series of images with different 

focus points into a single photo.

Build and handling
The GX9 is a touch smaller than 

its predecessor, with the chunky 

handgrip replaced by a much more 

streamlined affair. This makes 

it a neat little camera with 

a quality feel, although 

Panasonic has opted to 

drop the weather sealing 

featured on the GX8. 

On the rear is a focus 

lever that can be used to switch between focus 

modes, but there’s no dedicated joystick to 

select your desired focus area – that’s done via 

the touchscreen or the four-way control pad, 

and the latter option is quite a clunky affair.  

In an effort to keep the Lumix GX9 as trim 

as possible, the control buttons sit fairly flush 

with the body; however they’re a bit too flush 

for our liking – we’d rather they were raised 

a bit more to make them easier to press. 

The reliance on menus and icons for some 

adjustments might prove a little irksome for 

some, but the touchscreen is very responsive.

Performance
The electronic viewfinder (EVF) is 

good, but not great. Focusing speeds 

are very quick indeed. The built-in 

image-stabilisation system works 

very well – we found that we could 

happily shoot at 1/8 sec (and in some 

instances even slower) 

and still achieve 

sharp shots. 

A problem not 

unique to the GX9 

is the relatively 

modest battery 

Reviewed by PHIL HALL, ROD LAWTON

The GX9’s mount works with Micro Four Thirds lenses.



Panasonic Lumix GX9 APPLE CHOICE

 A solid camera that 
fits good features into 
a compact body, yet 
with a few niggles 
here and there.

 Compact design

 4K video and photos

 AF selection fiddly

 Not weatherproof

VERDICT
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life of 260 shots (250 shots using the EVF). 

A trade-off for having a compact body is the 

limited size of battery you can squeeze in, 

although that number is 90 shots less than 

Fujifilm’s equally compact X-E3. Panasonic 

is obviously aware that this is an issue, as 

the GX9 features a power-saving mode that 

can eke out 900 shots from the battery. It does 

this by putting the camera into sleep mode 

after it’s been inactive for one second, with 

a half-press of the shutter release required 

to wake the camera up.

Image quality
Panasonic has made good strides in the 

area of colour rendition, and the Lumix GX9 

produces natural-looking JPEG files with 

faithful colours. If you want to shoot mono 

images without having to spend too much 

time on editing, the new ‘L. Monochrome’ 

photo style is a welcome addition. 

The camera delivers very solid 

performance when it comes to image noise. 

At low-sensitivity settings, images are nice 

and clean, with only a hint of luminance 

(grain-like) noise visible at  

mid-range sensitivities if you 

inspect files closely.

At ISO1600/ISO3200, luminance 

noise becomes a bit more of an issue, while 

chroma (colour) noise also starts to creep into 

shots. At ISO6400, noise is noticeable, but 

detail still holds up well in raw files; we’d 

avoid shooting at ISOs above this. 

If you’re shooting JPEGs, the noise-

reduction algorithm is a little too zealous 

for our tastes; noise is certainly reduced, 

but detail is sacrificed a bit too much, with 

high-sensitivity images looking somewhat 

‘waxy’ in places. 

As for dynamic range, there’s plenty 

of flexibility at low sensitivities, allowing 

you to recover a decent amount of shadow 

and highlight detail from raw files. However, 

that flexibility is diminished as you increase 

the ISO, with more noise encroaching in 

shadow areas.

In many ways, the Lumix GX9 takes two 

steps forward over the GX8, but one step 

back. While there’s perhaps a little too much 

reliance on the touchscreen interface for some 

tastes, this is a nice camera and a very solid 

performer – it just doesn’t do quite enough to 

stand out from the crowd.

Fujifilm X-E3 

£849
 

FROM fujifilm.co.uk

 24.3 megapixels

 X-Trans CMOS III sensor

 ISO100 to ISO51200

 4K video at 30fps

 12.1x7.4x4.3cm

ALTERNATIVE CHOICES

Panasonic 
Lumix GX80 

£734
 

 FROM panasonic.co.uk

 16 megapixels

 Live MOS sensor

 ISO100 to ISO25600

 4K video at 25fps

 12.2x7.1x4.4cm
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A 360° camera boasting 5.7K resolution

 £354.99  FROM Yi Technology, yitechnology.com  

 FEATURES 5.7K and 360° video, 4K live streaming, automatic stitching

T  
hese days, in the world of 360° 

cameras, 4K is just not enough. 

Since 360° videos are stretched  

as far as the eye can see, more pixels mean 

better images. This camera comes with 5.7K 

resolution at 30 frames per second (fps). It also 

has a host of manual controls, and streams in 

4K to YouTube. 

A 5.7K resolution won’t produce pin-sharp 

360° images, but the results are good, and we 

only know of one other camera that offers such 

a high resolution – the much pricier Garmin 

VIRB 360. The Yi’s 360° fixed-focus Sony 

IMX377 image sensors capture 5760x2880 

pixels – about 16MP, for both video and stills.

One of the main issues with 360° cameras 

is that it’s impossible for the photographer to 

get out of shot. The Yi 360 VR gets over that by 

taking three separate still images, five seconds 

apart, of you standing in three clearly separate 

positions. Its software can then identify you 

in all three pictures, and remove you from the 

finished composite image.

You can adjust the exposure metering 

mode, exposure compensation, white balance 

and ISO (up to ISO800 for photos, and 

ISO6400 for video), and there’s compatibility 

with external microphones (using a Yi-made 

adapter in the USB-C slot). There’s also the 

option to capture 360° footage in bursts or as 

time-lapses, from images taken at an interval 

of between half a second and 60 seconds, 

while the Yi 360 VR can also shoot at up to 

120fps (at 2K resolution).

Controls and charge
The Yi  360 VR is more substantial in size than 

some 360° cameras, but it slips easily enough 

into a pocket. Sadly, though, it isn’t waterproof. 

On top of the device is a small OLED screen, 

which allows for reasonably easy toggling 

through the menus using two navigation 

buttons, and there’s an on/off switch on the 

side. On the other side is a USB-C port for 

recharging, a micro HDMI output, a microSD 

 Sharp and dynamic 
results – and the rare 

ability to shoot 5.7K 
resolution 360° video.

 Crisp 360° images

 Well-saturated 

and even colours

 Basic auto-stitching

 Not waterproof

VERDICT

card slot, and a removable 1400mAh lithium-

ion battery. There’s a universal tripod/selfie 

stick thread (1/4-inch) on the undercarriage, 

and a tripod is even included in the box.

Battery life is a little short, lasting for about 

50 minutes in our test. It’s best to resist the 

temptation to transfer files between the camera 

and a phone via the Yi 360 VR’s Wi-Fi; rather 

worryingly, this caused our test camera to heat 

up, and quickly used up battery charge.

Image quality is impressive. Both photos 

and videos have well-saturated colours, while 

noise and chromatic aberration are noticeably 

less than you’ll get from cheaper 360° cameras.

Although the Yi 360 VR can perform 

in-camera stitching using a template, it’s not 

very effective; the stitching line is rather 

obvious – particularly problematic if people’s 

faces are positioned along the line.

The companion app is impressive, enabling 

you to control all of the settings on the camera, 

as well as presenting a live feed and offering 

stacks of editing and sharing options.

If you’re a semi-pro videographer wanting 

to experiment with 360° video, the Yi 360 VR 

gives you most of the tools you need. Its 5.7K 

resolution, consistent colour and exhaustive 

manual tweaks are all plus points. It’s highly 

ambitious and great value.

Yi 360 VR 

APPLE CHOICE Mac hardware
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Image quality 
is impressive; 

colours are 
well saturated 
in both photos 

and videos

Reviewed by JAMIE CARTER

The 5.7K resolution is pretty remarkable 
for a 360° camera at this price point.
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Mophie Powerstation USB-C XXL
A chunky battery with a huge capacity

 £119.95  FROM Mophie, uk.mophie.com  

 FEATURES High-capacity battery, USB-C fast charge, priority charge

 A large-capacity 
recharging option, 

with a hefty price tag.

 Can add hours of use

 Quite bulky

VERDICT

The fabric cover 
makes for a stylish 
power pack.

VERDICT

You can specify 
the exact colour 

of each Snugs tip.
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W
ithin the 

Powerstation 

USB-C XXL is a 

19,500mAh rechargeable 

battery. Mophie claims 

this will provide a 13-inch 

MacBook Pro with an 

additional 14 hours of battery 

life. The XXL label is apt. 

At 15x8cm, and weighing 

400g, the power pack is 

hefty. It’s covered in a fabric 

wrap that looks great and 

protects the battery from 

bumps and scratches. 

The Powerstation has 

two sockets: USB-C, and a 

USB-A socket into which you 

can plug an iPhone or iPad 

charger. If you plug the 

USB-C socket into a power 

outlet and connect an iOS 

device, the battery will pass 

through power to charge 

that device before itself. 

Or, you can plug your 

MacBook or MacBook Pro 

into the USB-C port (after 

charging the battery) to get 

a 30W supply. You can even 

power a MacBook and an 

iOS device simultaneously. 

The Powerstation’s battery 

can also be recharged from 

a connected MacBook Pro.

The Powerstation USB-C 

XXL did well in our tests, 

charging our 2016 15-inch 

MacBook Pro’s battery from 

25% to 45% while we used the 

Mac to edit video in iMovie 

for two and a half hours.  

KENNY HEMPHILL

Snugs True Wireless
The ultimate headphones for cable haters?

 £269.95  FROM Snugs Earphones, snugs.com 

 FEATURES Bluetooth 4.2, sweatproof Liquipel nanotechnology, 500mAh built-in battery

T
hese earpieces 

take wireless tech 

a step further by 

offering Snugs’ signature 

custom-fit tips allied to 

a pair of Jabees Beebud 

headphones. Custom-fit 

tips are neat because there’s 

no sound leakage, and audio 

quality is consequently much 

improved, and you get the 

benefit of natural sound 

suppression; Snugs boasts 

a reduction of -30DB.

We’ve always been 

impressed with Snugs’ 

custom tips, but how do they 

fare in the Beebud alliance? 

In terms of audio, sound is 

loud, but muffled, and 

the headphones lack 

liveliness. The Snugs 

tips do their best to 

carry the Beebud, but 

there’s a limit to how 

much you can do with 

a £60 pair of wireless 

headphones. Matched 

to a superior headphone, 

such as the B&O E8, the 

setup would really shine. 

Of course, you can buy 

the Snugs tips separately 

(£169.95) and then add a pair 

of compatible headphones.

Operating the Snugs is 

easy, with a single button on 

each unit offering complete 

control using different 

combinations of presses. The 

included case has a 500mAh 

battery built in, which makes 

charging simple – just click 

them in place. A full charge 

takes less than an hour and 

you get around four hours of 

playback time. EMILY MINA

 The Snugs custom 
tips are good; buy the 

tips and add better 
quality headphones. 

 Amazing fit

 Average sound
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Fujifilm Instax Share SP-3 
A pricey way to catch special moments
 £179  FROM Instax, instax.co.uk 

 FEATURES Wi-Fi, 318dpi square-format prints

T
he Instax Share SP-3 printer 

certainly costs plenty to run, 

with film in packs of 10 costing 

around £9. That’s way more expensive than 

using a photo lab or even a desktop printer.

But the whole point of this printer 

is to produce a handy instant memento. 

On-the-spot photo prints are enjoying a 

significant resurgence for this very reason – 

and the Instax Share SP-3 provides them, 

without the bulk, cost and relative crudeness 

of an instant camera.

Instead, you simply send pictures from 

your smartphone to the printer, via Wi-Fi, 

from the free companion Instax Share app. 

The app has access to your camera roll, so 

there’s no time-consuming import process. 

Colour charm
The SP-3 isn’t exactly pocket-sized, but it’s 

small enough to slip into a shoulder bag 

and is entirely self-contained. It’s powered 

by a rechargeable lithium-ion battery, and a 

coloured LED lamp on the top lets you know 

how much power it has left.

Also on the top is a row of 10 white LEDs 

that correspond to the 10 prints in each film 

pack. Every time you print a picture, an 

LED goes out. Swapping empty film packs 

for fresh ones is easy. You press a button on 

the side to open a large access door – don’t 

do this if you still have unexposed pictures 

 An expensive way 
to quickly capture 

priceless souvenirs. 

 Creates charming 

retro mementos

 Really easy to use

 The printer is costly

 Expensive film packs

VERDICT

The app has 
access to your 

camera roll; 
there’s no 
drawn-out 

import step

inside! – and remove the empty cartridge. 

New cartridges have a protective lightproof 

sheet. When the door is closed, the printer 

automatically removes and ejects this sheet 

ready for your first print.

The colour rendition of the prints is a 

little on warm side and there’s quite a lot of 

contrast, so subtle highlight details tend to 

disappear. These aren’t really issues, though, 

because the Instax Share SP-3 is about 

capturing memories, and the quirky, old-

fashioned look rather adds to their charm.

Given the pretty high cost of both the 

Instax Share SP-3 and its film packs, it’s 

impossible to offer any practical arguments 

for buying the printer. But of course, it’s not 

about the price tag. The appeal is purely 

emotional, offering an easy and permanent 

physical token of a fleeting event. 

ROD LAWTON

With access to your camera roll, the Instax Share SP-3 
can produce prints of special moments in a flash.

Square-format, retro-look prints are really popular, but 
the ability to produce them comes at a modern price.
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High-resolution, triple-driver headphones that rock
 £129.99  FROM Creative, uk.creative.com  FEATURES Triple-driver array, 5-40,000Hz, braided and replaceable cable

T
he Aurvana Trio headphones 

are part of Creative’s premium 

line of high-resolution audio 

products. Before we dive too deep into their 

sound quality, it’s worth mentioning why 

triple-driver headphones are so much better 

than those with a single driver.

Inside each earbud is a triple-driver array; 

two precision-balanced armature drivers 

deliver clear mids and highs, while one 

biocellulose driver exclusively replicates 

accurate and powerful bass – so, instead 

of one driver being forced to produce all 

areas of sound simultaneously, triple-driver 

headphones divide and conquer the full audio 

range, often with spectacular results. These 

headphones have a measured frequency 

response of 5 to 40,000Hz – about double 

what the human ear is capable of hearing.

While the sound quality is substantially 

better with triple-driver headphones, the 

trade-off here is that they might be a bit 

larger than you expect. Due to their size and 

protrusion from the ear a bit, they’re not 

exactly low-profile – and not necessarily the 

kind of headphones you’d want to use while 

lying in bed. That said, in an effort to make 

them as comfortable as possible, Creative 

packs four pairs of replacement tips in every 

box, including one pair of foam eartips that 

better conform to the shape of your inner ear 

and help seal out noise. The supremely light 

 Pricey, but one of 
the best pairs of 

in-ear headphones 
on the market.

 Exceptional clarity

 Extremely comfortable 

 Plasticky inline remote

 On the expensive side

VERDICT

design also means you can keep them in your 

ears for hours without fatigue. 

 

Rollicking highhs
Connecting the earbuds to the right-angle 

3.5mm jack is a braided cable that drastically 

reduces cable noise and, as an added bonus, 

is completely replaceable if it ever begins to 

fray. On it, you’ll also find a (rather plasticky) 

universal inline remote with a built-in mic 

and a pause/play control. 

The sound is great, with crystal clear 

mids, rollicking warm highs, and hearty, 

controlled bass. In fact, Creative’s Aurvana 

Trio headphones are possibly the best-

sounding in-ear headphones we’ve ever tested. 

There’s astounding clarity in nearly all areas, 

helping you pick up on small guitar flourishes 

or cymbal rolls in places you hadn’t heard 

them in the past and, most of the time, can 

even help you distinguish between MP3 

and uncompressed WAV files. 

The clarity and sound reproduction 

smoothes out even the lowest-resolution music 

in your collection, and the broad frequency 

response helps cover the highs, lows and 

everything in between. 

If you have the money for some truly 

spectacular in-ears, these are well worth the 

price. They’re comfortable, sound great and 

offer extreme clarity in nearly all areas of the 

audio spectrum. NICK PINO

Creative Aurvana Trio
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The sound reproduction 
will help you hear details 
you missed before.



With four adjustable compartments, the BentoStack XL 
can keep all your accessories neatly packed away.

 macformat.com  @macformat
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Great gizmos for gregarious globetrotters

Travel accessories

T  
ravelling can be a great 

experience, but it also brings its 

own set of potential problems. 

You can lose your valuable gadgets, run out 

of power and forget to pack the right adaptors – 

not to mention the constant hassle of keeping 

your stuff organised when you try to pack it. 

But fear not, as we’ve rounded up the best 

accessories for the gadget-conscious sightseer. 

With these accessories by your side, you’ll be 

well equipped to head off on your travels with 

your trusty Apple kit in tow.

BentoStack XL

 $49.95 (about £37)  FROM Function 101, 

function101.com  FEATURES Adjustable 

dividers, two silicone straps 

> Instead of haphazardly chucking your 

cables into a bag on your travels, use the 

BentoStack XL. It’s a neat compartmentalised 

box, giving you four adjustable dividers and 

two straps. It’s ideal for storing your cables, 

adaptors, Watch straps and even an Apple 

Pencil. The XL version fits UK adaptors, too.
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 Gadgets on the go APPLE CHOICE

Anker PowerCore 
Speed 20000 PD

 £49.99  FROM Anker, amazon.co.uk  

 FEATURES 20100mAh battery, 

USB-C and USB-A charging ports 

> When you travel, you don’t always 

have easy access to charging points. 

That means you want your devices to last 

as long as possible – which is where the 

Anker PowerCore Speed comes in. It’s 

only small but can power an iPhone 7 six 

times over, an iPad Air 2 twice and even 

a 2016 MacBook once. It also comes with 

USB-C and Micro-USB cables, although 

you’ll need your own Lightning cable.

Tile Slim

 £30  FROM Tile, thetileapp.com  

 FEATURES One-year battery life, 

IP57 water resistance, 2.4mm thickness

 

> It’s a traveller’s worst nightmare: 

losing something valuable in a place 

that’s new and unfamiliar. Make sure 

you avoid that happening with the Tile 

Slim. Pop it in your wallet or bag and 

you’ll be able to track it with an app on 

your iPhone. It works the other way, 

too – tap it twice to make your phone 

ring, so you can find it if it goes astray. 

It’ll also stick to flat surfaces using the 

included adhesive patch.

Apple World Travel 
Adapter Kit

 £29  FROM Apple, apple.com/uk 

 FEATURES Plug adaptors for seven 

different types of plug socket

 

> The last thing you want when 

travelling is to find out you can’t 

charge your devices. Luckily, Apple has 

you sorted with its World Travel Adapter 

Kit. It comes with seven plug designs 

covering North America, Japan, China, 

the UK, Europe, Korea, Australia, Hong 

Kong and Brazil, making charging a cinch 

if you pay any of these places a visit.



NOTE-TAKING 
APPS FOR 
iPAD
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APPLE CHOICE Group test

NOTE-TAKING 

APPS ON TEST…
  Bear Free (Bear Pro £14.99/year)
  Evernote Free (Evernote Premium £44.99/year)
  GoodNotes £7.99
   Notebooks £6.99 (plus £2.99 for PDF Reader)

  OneNote Free
  Whink £4.99

 macformat.com  @macformat

Reviewed by CARRIE MARSHALL

Six apps that will help you record, 
store and keep track of your 
all-important thoughts 



 macformat.com  @macformat JULY 2018 | MACFORMAT | 89

between simple handwriting apps and do-

everything writing environments where you 

could plan, research and write the Great 

American Novel. These are all very good apps, 

but their differences mean they’ll appeal to very 

different people and excel in different ways. 

Some are ideal for grabbing thoughts on the go, 

while others are better suited to a desktop life. 

Some wear flowers in their hair; others are 

suited and booted.

If you intend to do a lot of handwriting, 

we strongly advise you invest in a good stylus, 

or Apple Pencil if your iPad is compatible. 

Good doesn’t necessarily mean 

having to spend a lot: we’ve had 

good results with inexpensive, 

simple styluses. Badly made 

models, especially ones with 

small points, can be a false 

economy; you’ll spend so much 

time correcting tracking errors and missing 

lines that you’d be better off typing instead. 

With a good stylus, handwritten notes are 

wonderful; with a bad one, they’re impossible.

Whatever your preferred input method, take 

note of how we rate the top jotter apps available.

…or lower?
Notes

apple.com

Free

 Apple’s own note-taking 

app is good, especially on 

iPads that support Pencil. 

Naturally, it uses iCloud 

to sync between devices.

3 Drawing tools
Many apps offer simple sketching, 

but the results can be, well, sketchy. Shape 

correction can be helpful, although sometimes 

it tries to correct bits of handwriting, too.

4  Upload limits
If you’re reliant on cloud storage, will you 

run out of space fairly quickly? Is there a data 

transfer limit, or can you sync as many notes 

with as many big images as you like?

5 Mixed media
Will you be happy using a single medium, 

such as handwriting or typed text, or will you 

want to create and store notes that include 

embedded images, files or audio commentary?

6  Room to grow
Will the app you’re considering meet 

your note-taking needs not just today, but also 

in the longer term? Will your existing notes be 

easy to export if you change apps in the future?

Note-taking apps APPLE CHOICE

O
ne of the best things about the 

iPad is its convenience and 

portablility, which is why it’s 

a great platform for taking notes. The 

size, shape and screen are ideal for scribbling, 

wherever you are, and the arrival of high-quality 

styluses such as the Apple Pencil can deliver 

a paper-like experience, backed up by the iPad’s 

connectivity and rich media capabilities.

There’s more than one way to take a note, 

though. Some of us are scribblers; others, touch 

typists. Some of us scrawl comments on photos; 

others prefer to record information using voice 

memos. Some of us are all about the text; others 

mix and match every kind of media. As a result, 

the App Store is packed with apps promising to 

deliver the perfect note-taking experience, in a 

variety of different ways.

The apps we’ve looked at here run the gamut 

Some of us are scribblers; others, 
touch typists. Some of us scrawl 
comments on photos; others record 
information using voice memos

Things to consider…
Everything you need to know before getting started

1 Syncing to other devices
Can you easily get notes onto your Mac 

or your school or office PC, or will you need to 

export your work in a different file format?

2  
Handwriting recognition
Most apps store handwriting as images, 

but if you want to be able to search, you’ll need 

an app that offers optical character recognition.

How we 
tested
 We used our note-

taking apps in the 

toughest environment 

imaginable: on our lap 

in a children’s soft play 

area, trying to scribble 

with a stylus or tap on 

the screen. We also 

took our iPad Pro and 

stylus to night classes, 

and used them for our 

homework. In addition 

to writing notes, we 

imported existing 

documents, notes 

and blog posts 

where possible.

Higher…
PDF Experrt

readdle.com

£9.99

 If your work revolves 

around PDFs, this is the 

app for you; it enables 

you not just to annotate 

but to edit them, too.

Typing up a note is useful, but adding images, sketches 
and audio will make your notes far more memorable.
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 In addition to note creation, all of the 

apps here enable you to add images or 

draw sketches. Notebooks keeps them 

separate where the others embed the 

sketches in specific notes; it collates 

media in a note’s containing folder rather 

than adding them to individual notes. 

Notebooks has a particularly useful 

‘new from pasteboard’ feature that pastes copied text as a new 

note, and you can also get it to grab web pages.

With the free (optional) Office Lens app for both iPhone and 

iPad, OneNote becomes great at capturing written content and 

correcting poorly angled photos of presentations and whiteboards.

Bear and Evernote are straightforward enough with good 

tagging, but we preferred Notebooks and Whink. The former is 

great for collating varied content, and Whink is great for mixing 

up voice annotation, scribbles, handwriting and embedded media.

 Bear and Evernote resemble Apple’s 

own Notes app, and are designed for typed 

notes rather than handwritten ones: for 

handwriting fans, Whink and GoodNotes 

are the apps for you. GoodNotes also gets 

handwriting OCR, so you can search your 

notes’ contents, a feature OneNote hasn’t 

brought across from its desktop sibling – 

although you can always open your iOS-created notes in the 

desktop app later. OneNote is very good at organising all kinds 

of content, though, not just text, and it scales to really big projects.

If it’s flexibility you’re after, Notebooks is the winner here. 

It’s a fully featured writing environment with Markdown 

support, file storage, PDF conversion, ebook creation, task 

management and an optional PDF reader/converter. 

All the apps here offer instant syncing, and all bar Evernote 

are optimised for Apple Pencil. 

 As you might expect, the handwriting-

focused apps – GoodNotes and Whink – 

offer the most paper-like experience. 

We think Whink knocks it out of the 

park: you just start scribbling and the 

app follows what you’re doing, so if you 

realise you need to put in a photo or voice 

memo at a certain point, there’s a long-

press menu to do just that. Using it feels like using magic paper. 

GoodNotes is a little less fluid. 

Evernote is simple enough and the drawing tools are quite 

good (bar an over-enthusiastic line corrector), but Bear is better: 

it’s easy to format, tag, link and embed as you go along, and 

Markdown makes it easy to reuse content in other apps. The other 

apps are simple enough but feel a little overpowered: OneNote is 

very Microsoft Office-y and Notebooks felt a little clunky until 

we set default formatting and note options for quick starts.

 This is an easy win for OneNote: 

Microsoft’s largesse means it’s the only 

app here that’s completely free. Bear and 

Evernote are freemium with in-app 

purchases (Bear Pro is £14.99 a year, 

Evernote Premium a whopping £44.99); 

GoodNotes is a flat £7.99, Notebooks is 

£6.99 (plus £2.99 for the PDF Reader 

module) and Whink is £4.99. So, OneNote is free, while 

GoodNotes and Whink come in at one set price. The others charge 

for different features: Notebooks charges extra for the PDF 

Reader; with Bear Pro, you pay to sync between devices, use 

themes and unlock export options; with Evernote Premium, you 

pay to remove device limits, increase upload limits and use PDF 

annotations. We think Evernote is the toughest sell, because it’s 

really a collaborative working platform for business users and it’s 

priced for deep pockets. The others are all priced more affordably.

TEST RESULTS

TEST RESULTS TEST RESULTS

TEST RESULTS

Test 1 Key features

Test 3 Ease of use Test 4 Value 

Test 2 Extra elements
The main components

Can you jot things down easily? Are the features worth the price?

Features beyond the basics  

Bear  

Evernote  

GoodNotes  

Notebooks 

OneNote  

Whink 

Bear  

Evernote  

GoodNotes  

Notebooks 

OneNote  

Whink 

Bear  

Evernote  

GoodNotes  

Notebooks 

OneNote  

Whink 

Bear  

Evernote  

GoodNotes  

Notebooks 

OneNote  

Whink 

APPLE CHOICE Group test



 How 
do they 
compare?

 I really like Apple’s 

improvements to the 

built-in Notes app, 

so I don’t want to pay 

too much for a third-

party option. I think 

Whink’s £4.99 is a fair 

price, given the ability 

to input in a variety 

of ways and multitask 

with other apps while 

scribbling. I love the 

look of it, too.  

Jo says…

Pencil users: it’s useful for scribbling on 

PDFs, and making and finding handwritten 

notes. It isn’t for power users, 

but it’s practical and useful.

Notebooks is a serious 

tool for serious business, 

while Whink feels more like 

a creative’s canvas. They’re 

both brilliant, flexible and genuinely useful, 

but they’re going to appeal to different people. 

Whink is the one that most appeals to us. 
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L
ike for like, OneNote leaves 

Evernote in the dust. The only 

niggle is that you have to use 

OneDrive to sync its contents. However, 

it’s rather like Microsoft’s other behemoth, 

Word: it can do everything, and sometimes 

you crave something simpler.

Something like Bear, perhaps. It’s a 

brilliant app for writers, and it happens 

to be handy for notes and lists too. It’s very 

good, but limited in this company.

GoodNotes is better for stylus and Apple 

For input flexibility and 
ease of use, Whink takes 
the note-taking top spot

Notebooks is a serious tool for serious 
business, while Whink feels more like 
a creative’s canvas

THE WINNER  
Whink

Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.

Whink is more playful than other apps, but it’s still serious: 
it makes mixed media note-taking utterly effortless.

> THE SPECS > Bear > Evernote > GoodNotes > Notebooks > OneNote > Whink

PRICE
Free  
(Bear Pro £14.99/year)

Free 
(Evernote Premium 
£44.99/year)

£7.99
£6.99 (plus £2.99  
for PDF Reader)

Free £4.99

WEB ADDRESS bear-writer.com evernote.com goodnotes.com dropbox.com onenote.com whinkapp.com

SYNCS VIA iCloud (Bear Pro) iCloud iCloud Dropbox OneDrive iCloud

DESKTOP APP? Yes Yes Yes Yes Yes No

WINDOWS APP? No Yes No Yes Yes No

WEB ACCESS? No Yes No No Yes No

HANDWRITING No No Yes No No Yes

HANDWRITING OCR No No Yes No No No

AUDIO RECORDING No Yes No Yes Yes Yes

MARKDOWN Yes No No Yes No No

SKETCHING Yes Yes Yes Yes Yes Yes

PDF ANNOTATION No No No Yes (additional option) No Yes

KEY FEATURES

NOTE TAKING

EASE OF USE

VALUE FOR MONEY

OVERALL

Note-taking apps APPLE CHOICE
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Genealogy on the Mac is now slicker than ever

 £54.99  FROM Synium Software, syniumsoftware.com  

 NEEDS OS X 10.10 or later

W
hen it comes to 

Mac apps for 

tracing your 

genealogy, nobody does 

it better than Synium. 

As evidence, we submit 

the latest release of 

MacFamilyTree 8, which 

has added so many new 

features over the last two 

years that the developer 

could have easily christened 

it 9.0 and charged accordingly 

for a whole new version.

Thankfully, it chose to roll out all of this 

in a series of free updates, culminating with 

version 8.3, which dramatically improves 

the software’s performance, especially 

while working with the Interactive Tree. 

This feature is our favourite way to edit 

a family tree, and the adoption of Metal 2 – 

graphics acceleration software built in to 

High Sierra – allows for smoother animation 

and improved text rendering.

Graphically ricch
The Interactive Tree benefits from other 

improvements, notably the ability to hide the 

sidebar for viewing across the entire window 

width. Generation separator options make it 

easier than ever to see who’s related at a glance, 

while new Camera settings offer control over 

 Easily worth the dosh 
if you’re starting with 
genealogy, and great 

as a free update.

 Awesome free updates

 New Camera options

 Performs really well

 Limited export options

VERDICT

lighting and shadows over images. At last, 

you can even print out this graphically rich 

overview of your family tree.

While the Interactive Tree benefits the 

most, visuals have been improved across the 

board without losing the app’s look and feel. 

Bloodline and indirect relationship paths 

including adoptions have been added as 

display options, along with six Timeline 

styles that offer a fresh look at tree data in 

a single click. Other new features include 

duplicate detection and merging two 

different GEDCOM or MacFamilyTree 

databases with full control over the results.

All this slickness comes at a price in terms 

of system support – you’ll need a recent Mac, 

capable of running High Sierra. If you’re stuck 

on an older system version, you’re left stranded 

on the previous version of the app.

Likewise, Sierra or later is required for 

CloudTree support, which allows real-time 

collaboration with an unlimited number of 

family members and devices. This sharing 

method is more robust than the former 

version’s ability to sync using iCloud Drive, 

although that option remains.

MacFamilyTree 8.3

Synium has 
rolled out a 
cascade of 

free updates, 
dramatically 

improving 
performance

Reviewed by JR BOOKWALTER

With a free update to MacFamilyTree 8.3, six built-in 
styles make it easy to change the Timeline’s look.

The Interactive Tree mode now offers more ways 
to customise lighting and shadows on images.
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A stylish art app for iOS

A
genda bridges the 

divide between 

note-taking and 

calendar apps, adding a 

project-based workflow.

This approach comes in 

handy for linking notes to 

events. The refined interface 

is designed around your 

agenda, with a collapsible 

pane to view upcoming 

events and jump to related 

notes; you can search across 

all projects at once, filtering 

by date, people or hashtag.

There are sample projects 

to hand, and you can import 

Markdown or Apple Notes. 

The latter is basic – folders 

styluses, such as Adonit’s 

Pixel. The upgrade also adds 

layers, pattern fills and a 

colour mixer. Brushes aren’t 

fully editable as in Procreate, 

but you can alter size and 

opacity. The default settings 

are well judged, from the 

satisfyingly scratchy pen to 

watercolours that mix until 

you ‘dry’ them. A two-finger 

tap activates unlimited 

 Free  FROM Momenta, agenda.com  

 NEEDS macOS 10.12 or later

 Free  FROM Tayasui, tayasui.com 

 NEEDS iOS 9 or later

Undo, so you can experiment 

freely. You can also record 

your drawing process. 

Sketches leaves room for 

improvement: layer-blending 

modes are few, you don’t get 

tone or colour adjustments, 

and the canvas is fixed at 

screen resolution – though 

Retina devices provide 

enough pixels for most 

purposes. ADAM BANKS

 A unique take on Mac 
note-taking that will 
appeal to calendar-

minded users.

 Date-focused notes

 Limited text styling

VERDICT

 Brush editing is 
limited, but overall 

Sketches excels.   

 Easy to get started

 Fixed resolution 

and brush types

are converted to projects, 

but entries lose formatting, 

including links and images. 

New notes offer basic styles 

and formatting, but you can’t 

change font or text size. 

The lack of a companion 

app or collaboration features 

is disappointing, but the 

former should be coming 

soon; notes can be synced 

with other Macs, however.

Agenda

Lox  the hxxx xx  xesx  
xxxx xx xx xx xx xxxxx 
xxxx xxom.

Note-taking, reimagined

Premium features like 

new calendar events, saving 

searches and removing 

watermarks cost $24.99 

(about £20). Additional 

features are worth paying 

for though, as any features 

the developer adds in the 12 

months following purchase 

will be included, and are 

permanently unlocked.  

JR BOOKWALTER

T  
ayasui Sketches 

is an iOS app 

for drawing or 

painting. On the iPad, it has 

a clean, minimal interface, 

with tools down the left side. 

On the iPhone, it’s pared 

down even further, showing 

just one brush and an eraser; 

you can tap to fill the screen 

with more choices.

Used with either a finger 

or a stylus, Sketches adds 

variation and smoothing to 

create stylish strokes. For 

finer control, a £5.99 Pro 

in-app purchase supports 

Apple Pencil and a range of 

third-party pressure-sensing 

Related info makes 
it easy to jump to 
notes linked to 
specific events.

Tayasui Sketches

 macformat.com  @macformat

Mac/iOS software APPLE CHOICE

VERDICT

Tools aren’t fully editable, 
but there’s adequate variety.

The Pro upgrade adds layers 
for more ambitious work.
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APPLE CHOICE Mac software

The combat 
remains highly 

enjoyable; 
stealth and 
action are 

deftly blended
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Rise of the 
Tomb Raider

 £39.99   FROM Feral Interactive, feralinteractive.com   

 NEEDS macOS 10.13.4 or later, 2.3GHz Core i5, see website for graphics cards

It seems that Lara has moved on, 

but has the series developed, too?

T
he opening of Lara Croft’s 

latest adventure had us worried. 

It starts with Lara trudging slowly 

through snow, the only requirement being to 

hold W as the game plays itself around you. 

We had flashbacks to the previous game’s 

interminable, set-piece heavy intro. During 

a cutscene-laden climbing tutorial, we missed 

a prompt, fell and died. We managed it on 

the next try, climbed a bit higher, and had 

to watch another cutscene where Lara falls 

but is fine. Here we go again? Actually, no.

The opener is frustrating, but over 

quickly. Rise then sticks to a mostly consistent 

level of interactivity. There’s still plenty of 

set-piece spectacle, but these pace-breaking 

action segments trust you to read clues and 

react. This is emblematic of Rise as a whole. 

It’s not that Tomb Raider’s missteps have 

been eradicated, but they have been 

dramatically reduced. Slo-mo quick time 

event sequences, awkward conversations, 

and by-the-numbers miniboss fights take up 

a lot less of the 15-or-so hour running time.

Lara’s adventure starts in Siberia, where 

she’s hunting the Divine Source. There’s an 

important difference in the plot this time: 

Lara has initiated her quest. Though things 

soon spiral out of control, she’s no longer an 

unwilling participant in events, which is 

crucial to how she is treated; she no longer 

feels like a victim of her environment.

The story is still clumsy at times, yet much 

better in some regards. Lara has a resolve that 

didn’t exist before, and that means there’s no 

clumsy disconnect between the story of a 

woman traumatised by her actions and the 

gleeful feeling of killing off a camp full of bad 

guys. It’s just as well, because the combat 

remains highly enjoyable. Stealth and action 

are deftly blended. Most foes begin unaware 

of Lara’s presence, giving you scope to creep 

around. With patience, and using objects as 

distractions, it’s possible to systematically 

clear out most patrols. Often, it’s more fun to 

quietly take out a few foes than start a fight.

Crafty croft
Lara has access to a small selection of weapon 

categories – pistol, rifle and shotgun – with 

various styles of each. Most feel good to fire, 

the panicked inaccuracy of the automatic rifle 

being the only real exception. Pistols feel 

lightweight and clinical, while the pump-

action shotgun is chunky and gratifyingly 

deadly. Once again, the bow is the star of 

the show. Having to draw back and charge 

shots provides a nice rhythm to the combat, 

especially when paired with some of the skill 

upgrades. We especially liked the feel of the 

rapid fire skills, which let you instantly fire 

fully charged follow-ups after your first shot. 

Aimed correctly, even heavily-armed guards 

fall with a single salvo.

Lara is now able to craft combat tools 

on the fly. Arrows and special ammo can 

Reviewed by PHIL SAVAGE

In the second outing of 
Lara’s rebooted story, 

she sets her own agenda.

Explore thoroughly and you’ll 
uncover optional tombs that add 
to the longevity and satisfaction.



Rise of the Tomb Raider APPLE CHOICE

 Rise of the Tomb 
Raider is a little too 
streamlined in places, 
but it does a lot to 
improve upon its 
predecessor.

 Captivating setting

 Great opportunities 

to experiment

 One main city

 Story is nothing new

VERDICT

 The oldest Macs 

supported are 27-inch 

iMacs from late 2012 

with a 2GB Nvidia 

680MX chip, though 

lower end Macs (13-inch 

MacBooks and 21.5-inch 

iMacs) need to be more 

recent. The game 

played well enough on 

our MacBook Pro (Late 

2016, 4GB Radeon Pro 

460), but defaulted 

to a mere 1280x800 

resolution. There were 

dips below 30fps, but 

the built-in benchmark 

reported a frame rate 

of 51fps on average.
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or huge cliffs still feels risky, even as the 

interactions involved are slim.

Optional challenge tombs boast some of 

Rise’s most intricate puzzle design. Each is 

short, but they use the standard interactions 

in interesting new ways. If there’s a downside 

to the game’s exploration, it’s that collectibles 

still feel like the end goal rather than a bonus 

along the way. Lara’s route through an area is 

rarely in question, especially due to Survival 

Instinct, an optional view that highlights 

your next objective, pertinent puzzle pieces, 

resources and collectibles.

We miss the cavernous brain teasers of 

Lara’s early adventures. Lara visits plenty of 

ruins this time, but they’re all solved through 

familiar and comfortable interactions. With 

a few notable exceptions, surprise comes 

through spectacle rather than design.

In many ways, Rise is peak sequel design: 

a very similar game with a set of expanded 

and additional systems. But it’s better because 

you spend more time engaging with those 

systems. It doesn’t fully eradicate the 

missteps around the edges of interactivity, 

but it lets you spend longer enjoying the 

core action and exploration.

be created at any point, but you can also use 

things found in enemy camps. A bottle can 

be turned into a Molotov cocktail; a petrol 

can into an improvised explosive device. 

This costs resources you’ve acquired, but we 

were never so low that we couldn’t set light to 

clustered soldiers. You can craft combat tools 

even as you move Lara with the keyboard; 

as usual, we recommend using a non-Apple 

mouse or a gamepad. Moving between cover 

while grabbing a petrol can is frictionless, and 

gives combat a welcome feeling of fluidity.

Columbus, eat your heart out
When not fighting, you’re exploring large, 

open hub areas – sprawling, intricate 

environments that, for the most part, you can 

leisurely pick your way through – the only 

distractions coming from the odd wolf, bear 

or big cat. Navigating uses a standard set of 

interactions, thrown together in various 

combos – jump, swing, grab, attach – each 

requiring a specific key press. It’s a simple, 

streamlined system, and you’ll seldom run 

into problems. It’s a shame there’s not more 

danger, but the presentation does a lot of 

the heavy lifting. Scaling giant buildings 

SYSTEM REQUIREMENTS

Can your 
Mac run it?

Inside and outdoors, 
Rise’s environments 
offer interesting sights.

Afraid of heights? Moments 
like this one are effective, 

but won’t help your nerves!
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A superb app for organising ideas
 £9.99 (Essentials); £38.99 (Pro)  FROM The Omni Group, omnigroup.com  NEEDS iOS 11.2 or later

O
mniOutliner 3 comes in two 

versions: Essentials, which offers 

the basics, and Pro, which adds 

tools for power users. The free trial enables 

you to try both: if you choose Essentials at the 

end of it, you can later upgrade to Pro for £19.99.

The name OmniOutliner is a bit of a 

misnomer, because there’s much more to 

the app than outlining. Think of it more as a 

repository for all your stuff, ranging from your 

project to-do list to study notes or the literary 

masterpiece you’re writing. The Pro version 

includes file attachments, such as images and 

audio recordings, which makes it handy for 

college work and projects involving meetings. 

The app works on both iPad and iPhone; 

using the latter means losing a lot of the space 

available to the bigger iPad app, but it’s useful if 

you’re syncing via Omni’s own OmniPresence 

sync or Apple’s iCloud Drive.

To start using OmniOutliner, you just start 

typing. If you want to indent, tap † or the 

indent button; if you want to go the other way, 

it’s ß and † or the outdent button; and if you 

want a new line, just tap ® or the + button. 

Collapsing and expanding sections is just a 

matter of tapping the arrow next to them.

Straightforward stuff, but it’s what you 

do after you’ve written that’s interesting. For 

example, when you filter, you don’t get the 

 Essentials is great 
for most needs; if you 
outgrow it, upgrading 

to Pro is affordable.

 Essentials is decent

 Export options

 Customisation in Pro

 Pre-filled templates

VERDICT

Think of 
the app as a 

repository for 
all your stuff

traditional highlight in a block of text. The app 

hides all the rows that don’t match, making it 

easier to see what you’re looking for. You can 

select multiple rows to drag and drop, which 

is useful, and in the Pro version you can drag 

images and files as well as text from other apps. 

Pro benefits
There are tons of keyboard shortcuts for 

formatting and highlighting if you’ve got a 

hardware keyboard. You also get a small but 

decent selection of predefined templates – 

although irritatingly they’re pre-populated, so 

you need to delete content to insert your own. 

You can now print and export to PDF, CSV, 

HTML, docx, pptx, and tabbed text. The Pro 

version adds Excel support and OPML links.

Pro also benefits from OmniAutomation 

scripting (as per OmniGraffle and OmniFocus), 

password encryption, custom templates and 

themes. It also offers more styling options, the 

ability to have more than one column, and the 

option to save filters. It’s very powerful and 

feels closer to a dedicated business writing 

app than an outliner.

If you’re a student, Pro is the one to go for; 

it makes managing even the most enormous 

outlines a breeze, and the ability to include 

media is a real plus. For us, though, Essentials 

does enough. CARRIE MARSHALL

OmniOutliner 3

The Pro version is a capable 
writing and presenting tool, with 
support for embedding media.



A pocket-sized life

T
hird-party app 

Gyroscope tries 

to go one better 

than Apple’s Health, by 

integrating data points 

and more into a unified 

personal profile with 

detail–rich report cards.

Initial setup involves 

granting the app permission 

to retrieve data from a 

variety of sources. The more 

sources you allow the better, 

to facilitate this “operating 

system for the human body”.

A good example is the 

way Gyroscope tries to detect 

your sleeping habits. The 

app’s algorithmic AI uses 

and funny interactions, 

and rewards that range 

from money to experience 

points, to new clothing.

There are multiple 

currencies in play, and 

it is with these that you 

buy everything: clothes, 

furniture, even new Sims. 

Without paying for a single 

piece of content, you can 

earn enough to buy that new 

oven you’ve had an eye on, 

and with careful, attentive 

playing, you can rake in the 

simoleons in no time.

 Free  FROM Gyroscope Innovations, gyroscope.pe

 NEEDS iOS 9.3 or later

 Free  FROM Electronic Arts, ea.com  NEEDS iOS 9 or later

The Sims Mobile is 

well made, with custom 

animations and objects that 

are impressively detailed. 

Your Sim will heave a sigh 

when they fail, sweep their 

paramour off their feet, and 

stir a souffle mix with such 

panache that it’s hard not to 

see those people on-screen 

as real life humans. 

It’s a simplified version 

of the Mac game, for sure, 

but that’s not necessarily a 

bad thing – it’s well suited 

to mobile play. KATE GRAY

 Not the full Sims 
experience, but a 

funny, streamlined 
pocket version.

 Beautiful art 

and animations

 Less personality 

than The Sims

VERDICT

 An ambitious 
app that delivers, if 

you sync it with 
multiple apps.  

 Tracks pretty 

much everything

 Not for the 

privacy conscious

VERDICT
step count and combines it 

with data from RescueTime 

to decide if you were asleep. 

It then looks at location data 

from Moves or Foursquare, 

and modifies recorded sleep 

times if it sees locations 

changing during periods that 

it ‘thought’ you were asleep.

We found Gyroscope’s 

sleep/activity tracking to be 

more accurate than the Fitbit 

Gyroscope Health
Track everything about yourself

app alone, but only when all 

data sources were available – 

disabling just one makes 

feedback a lot less insightful.

The plethora of 

customisable report cards 

(some of which require a Pro 

subscription) is impressive, 

and all can be shared with 

fellow Gyroscope users and 

via social media integrations. 

TIM HARDWICK

L  
ike The Sims 

FreePlay released 

seven years ago, 

The Sims Mobile is a 

freemium game.

This version is a focused 

experience, doing away with 

complete freedom of choice 

in favour of ‘stories’ – small 

chapters of life based on 

career, relationship and 

hobbies, with rewards for 

completing each stage. 

Perhaps you’ll be a doctor, 

trying to figure out the 

mysterious Llama Flu, or 

an aspiring foodie learning 

the cooking ropes. Each one 

is accompanied by quirky 

writing, as well as unique 

The Sims Mobile

 macformat.com  @macformat

iOS software APPLE CHOICE

Each report card shows tracked 
data as a visual graph or map.

Everything is 
done through 
‘stories’, which 
are completed 
with daily tasks 
and hangouts.

The more sources you allow, the 
more comprehensive your report.
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 Ever since the famous Bondi Blue iMac 

debuted in August 1998, Apple’s all-in-one 

desktop computer has been setting standards 

in gorgeous design and powerful performance. 

Apple’s innovation was as clear back then as it 

is today – the iMac was the first Macintosh to 

drop the floppy disk in favour of USB, and its 

colourful aesthetic set it apart as a playful 

pretender in a world of staid beige boxes.

Today, Apple is again pushing boundaries 

with the iMac, blessing all of its 27-inch models 

with a massive 5K (5120x2880) resolution and 

a wide P3 colour gamut. Add in Intel Core i5 

and i7 CPUs (configurable from 3.4GHz up to 

4.2GHz), a fast and capacious Fusion Drive, and 

powerful AMD Radeon RX graphics processors, 

and the 27-inch iMac is the desktop system to 

own. At WWDC in June 2017, Apple refreshed 

the entire range of iMacs, with discrete GPUs 

coming to all but the entry-level model, newer 

Intel CPUs, brighter Retina displays and more 

Thunderbolt 3 ports.

 An update in 2014 brought a £100 

price drop to the most affordable 

Mac, but rises in late 2016 added 

£80 back on. The mini comes with 

some interesting talking points: the 

entry-level model has a 1.4GHz dual-

core Intel Core i5 CPU and 4GB of 

memory, making it one of the lowest-

spec Macs around, with a 500GB 

hard drive and no display. 

Higher-end models come with 1TB of 

storage included (Fusion Drive and 

SSD options are available), 8GB of 

memory, a better graphics processor 

and either a 2.6GHz or 2.8GHz Intel 

Core i5 for £679 and £949. Those 

models can be upgraded to a Core 

i7, but there aren’t any quad-core 

options available at the moment. 

Expect updates in 2018. 

 iMac

 Mac mini

 Choose an iMac

W
elcome to MacFormat’s 

Store Guide, the place 

to go to find out about all 

the Apple kit that matters, whether 

you’re looking for your next iPhone 

or a powerful new desktop Mac. 

We’ve highlighted the model of 

each product that’s ideally suited to 

your needs, whether you’re a recent 

convert or a seasoned Apple user. 

So be sure to check our handy tables 

to see which Mac, iPad or iPhone is 

best for you.

We’ve also handpicked the gold 

standard in audio, storage, cameras, 

and many other categories, helping 

you complement your Mac or iOS 

device with the best accessories. 

All of these third-party devices have 

been reviewed in the magazine.

Your complete guide to the best Apple 
hardware and third-party accessories

EDITED BY ALEX BLAKE 

From 
£479

UPDATED

OCT 2014

EXPECTED

2018

 MODEL  KEY SPECIFICATIONS  PRICE

21.5-inch 
3.0GHz  
quad-core  
Intel Core i5

MEMORY 8GB of 2400MHz DDR4
GRAPHICS AMD Radeon Pro 555
STORAGE 1TB (5,400rpm) hard drive
DISPLAY Retina 4K (IPS, P3 gamut) 
ALSO Magic Mouse 2, Magic Keyboard

£1,249

27-inch 
3.4GHz  
quad-core  
Intel Core i5

MEMORY 16GB of 2400MHz DDR4
GRAPHICS AMD Radeon Pro 570
STORAGE 1TB Fusion Drive 
DISPLAY Retina 5K (IPS, P3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£1,929

27-inch 
4.2GHz  
quad-core  
Intel Core i7

MEMORY 16GB of 2400MHz DDR4
GRAPHICS AMD Radeon Pro 580
STORAGE 2TB Fusion Drive 
DISPLAY Retina 5K (IPS, P3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£2,609
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UPDATED

JUNE 2017
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2018



Apple tips 
From Stormfront, your 

local Apple experts

Nuisancee calls

Ellie Otley, Darryl Elkins 
Stormfront.co.uk

You’ll have received a lot of emails 

over the last few months from 

companies asking for your explicit 

permission to keep you on their 

mailing lists. This has been spurred 

on by the General Data Protection 

Regulation (GDPR), which came into 

effect on 25 May. But while good 

companies can be expected to stick 

to this law, not least because the 

fines for breaking the rules are hefty, 

you may yet receive unwanted 

contact from nefarious sources.

When it comes to phone calls 

and text messages, iOS provides 

the ability for third-party services 

to help you filter incoming calls 

and messages using apps like 

Hiya (free, bit.ly/hiyaios). Hiya 

uses a database of spam and 

scam callers’ numbers to warn 

you on the incoming call screen – 

or outright block this sort of 

intrusion. Once you’ve installed an 

app of this kind, you need to turn 

on its services in Settings > Phone  

> Call Blocking & Identification.
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 The baby of Apple’s laptop family, 

the MacBook was updated at WWDC 

2017 to get Intel Kaby Lake processors 

and faster SSDs. Weighing in at just 

0.92kg, it’s Apple’s most lightweight 

laptop but still packs in a 226ppi pixel 

density in its 12-inch Retina display.

The MacBook is powered by an Intel 

Core M processor (configurable to Core 

i5 or i7), which doesn’t require a fan to 

keep cool, so the MacBook runs silently. 

It also features a Force Touch trackpad, 

which can trigger different responses 

as you apply more pressure. All models 

of the MacBook come loaded with 8GB 

of 1866MHz memory, which can be 

boosted to 16GB, and Intel HD Graphics 

615 – an upgrade from the previous HD 

Graphics 515 – and there are 256GB or 

512GB flash storage options. There are 

four colour options: Silver, Space Grey, 

Gold, and Rose Gold.

 Apple debuted the new MacBook Pro 

in October 2016 with an OLED strip of 

app-specific controls called the Touch 

Bar. The Force Touch trackpad was made 

larger to give more room for gestures, 

and the keyboard was also updated to 

have a second-generation version of the 

butterfly keys from the 12-inch MacBook. 

The MacBook Pro range then got a 

further boost at WWDC 2017, when both 

the 13-inch and 15-inch models had their 

processors updated to Intel’s Kaby Lake 

models. The larger of the two also had 

its graphics card upgraded to give more 

powerful Radeon Pro options.

You get two or four Thunderbolt 3 

ports (depending on the model), which 

are also compatible with USB-C devices, 

and through which you can charge the 

MacBook Pro. The 13-inch and 15-inch 

sizes remain, although the entry-level 

13-inch lacks a Touch Bar.

 MacBook  MacBook Pro

 Choose a MacBook Pro

UPDATED

JUNE 2017

EXPECTED

JUNE 2018

UPDATED

JUNE 2017

EXPECTED

2018

 MODEL  KEY SPECIFICATIONS  PRICE

13-inch 
2.3GHz  
dual-core  
Intel Core i5

MEMORY 8GB of 
2133MHz LPDDR3
GPU Intel Iris Plus 640
STORAGE 256GB SSD
Touch Bar No

£1,449

13-inch 
3.1GHz  
dual-core  
Intel Core i5

MEMORY 8GB of  
2133MHz LPDDR3
GPU Intel Iris 650
STORAGE 256GB SSD
Touch Bar Yes

£1,749

15-inch 
2.8GHz  
quad-core  
Intel Core i7

MEMORY 16GB of 
2133MHz LPDDR3
GPU Radeon Pro 555
STORAGE 256GB SSD
Touch Bar Yes

£2,349
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 Choose a MacBook

 MODEL  KEY SPECIFICATIONS  PRICE

12-inch 1.2GHz  
dual-core  
Intel Core m3

MEMORY 8GB of 
1866MHz LPDDR3
GRAPHICS Intel HD 
Graphics 615
STORAGE 256GB SSD

£1,249

12-inch 1.3GHz  
dual-core  
Intel Core i5

MEMORY 8GB of 
1866MHz LPDDR3
GRAPHICS Intel HD 
Graphics 615
STORAGE 512GB SSD

£1,549

12-inch 1.4GHz  
dual-core  
Intel Core i7

MEMORY 16GB of 
1866MHz LPDDR3
GRAPHICS Intel HD 
Graphics 615
STORAGE 512GB SSD

£1,864
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 Apple always had to do something big 

for the iPhone’s tenth birthday, and it’s 

done that with the iPhone X. Sporting a 

glass back to allow wireless charging and 

a gorgeous edge-to-edge, OLED, Super 

Retina display measuring 5.8 inches 

across, it’s big news all over.

Its better cameras don’t just mean 

great photos – they allow for Face ID, 

the face-scanning technology that is the 

latest, safest way to unlock your phone 

(goodbye Touch ID and Home button).

But don’t let the new kid on the block 

overshadow the iPhone 8 and 8 Plus – 

they’re great phones in their own right. 

They get wireless charging too, plus 

revamped cameras, a new A11 Bionic 

chip, and new augmented reality tech.

All new models come in 64GB and 

256GB capacities. The pricing for the 

iPhone 8 starts at £699, the 8 Plus at 

£799 and the iPhone X at £999.

 In March 2018, Apple made a move to 

capture market share in education by 

updating the 9.7-inch iPad. It now comes 

with support for Apple Pencil, and its 

internals have been boosted too.

The 9.7-inch iPad features an A10 

Fusion CPU and M10 motion coprocessor, 

and comes in 32GB and 128GB storage 

sizes. The touch sensor in the display 

now has a higher resolution, allowing it 

to support the Apple Pencil for the first 

time. It’s also got an 8MP rear camera 

and a 1.2MP front-facing camera.

On the software side, the iPad adds 

multitasking features, which are a boon 

for productivity. You can slide a second 

app over the right side of the one you’re 

working in, then dismiss it to get back to 

work. Picture in Picture enables you to 

watch video in a corner of the screen. 

There’s also Split View, which lets you 

work on two apps side by side.

 MODEL  KEY SPECIFICATIONS  PRICE

iPhone SE 
(4-inch 
display)

CAPACITY: 128GB
PROCESSOR: A9
FACE ID No
CAMERA 12MP photos,  
4K video recording

£449

iPhone 8 
(4.7-inch 
display)

CAPACITY: 64GB
PROCESSOR: A11 Bionic
FACE ID No
CAMERA 12MP photos, 
4K video

£699

iPhone X  
(5.8-inch 
display)

CAPACITY: 64GB
PROCESSOR: A11 Bionic
FACE ID Yes
CAMERA 12MP photos 
(dual-camera), 4K video

£999

 MODEL  KEY SPECIFICATIONS  PRICE

7.9-inch 
iPad mini 4

CAPACITY 128GB 
PROCESSOR A8
CONNECTIVITY Wi-Fi
CAMERA 8MP
TOUCH ID Yes

£399

9.7-inch iPad CAPACITY 128GB
PROCESSOR A10
CONNECTIVITY Wi-Fi
CAMERA 8MP
TOUCH ID Yes

£409

12.9-inch 
iPad Pro

CAPACITY 256GB
PROCESSOR A10X
CONNECTIVITY Wi-Fi
CAMERA 12MP
TOUCH ID Yes

£919

 iPhone  iPad

 Choose an iPhone  Choose an iPad
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 The iPad Pro comes in 10.5-inch and 

12.9-inch sizes, packed with either 64GB, 

256GB or 512GB of storage. All models 

are available with the option of mobile 

network connectivity. The Pro’s A10X 

chip is the most powerful in any iOS 

device, and it has an impressive four-

speaker sound system, too. Adding the 

pressure-sensitive Apple Pencil and 

120Hz refresh rate makes it a smooth, 

accomplished drawing tool.

 iPad Pro From 
£619

UPDATED

JUNE 2017

EXPECTED

2018

UPDATED

JUNE 2017

EXPECTED

2018

UPDATED

SEPT 2017

EXPECTED

LATE 2018

 The Watch is Apple’s quiet revolution, 

and it’s now the number one watch in 

the world. Series 3 is meant to cement 

that status quo. To achieve that, Series 3 

lets you make and receive calls from 

your wrist without your iPhone around 

for the first time – the sci-fi dream is 

now a reality. You can also stream Apple 

Music to it – another benefit that means 

you can leave your phone at home.

Performance-wise, the processor has 

seen a 70% speed boost, and the new 

W2 wireless chip is far faster and more 

power efficient. All that, yet the case is 

still the same slimline size.

Apple also introduced new colours 

and bands, plus a new dark grey colour 

for the high-end ceramic model. 

From £329 (Series 3)

UPDATED

SEPT 2017

EXPECTED

SEPT 2018

 Watch
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 Getting a colour-accurate display used 

to cost a pretty penny, but this monitor 

is both impressive and affordable. It hits 

99% of the Adobe RGB gamut – great for 

colour-critical work – and supports 10-bit 

colour. Throw in a host of ports (including 

USB-C), an IPS display and a great price, 

and you have a seriously good screen.

 We love this display. At 32 inches 

diagonally it’s big enough to make its  

4K resolution worthwhile, and its colour 

rendering is excellent – 100% of sRGB, 

93% of Adobe RGB and 97% of the P3 

gamut that Apple’s new MacBook Pro 

uses. It’s big, bold, beautiful and superb 

for productivity and colour work alike.

 With two blazing fast Thunderbolt 3 

ports and a 5Gbps USB-C port to boot, 

the Drobo 5D3 can provide you with rapid 

file transfers to and from your Mac. You 

can load it up with up to five HDDs or 

SSDs of differing capacities, giving you 

plenty of flexibility for storage options. 

It’s pricey, but a worthy investment.

 This router has an awful lot going for it. 

The winner of issue 321’s group test, the 

Asus scored an impressive five stars in 

three out of four categories. It performed 

brilliantly in our tests, has excellent 

connectivity (with both Ethernet and 

ADSL options), and it looks great too. It 

will keep your network powered for years.

 The Eco-Tank ET-2600 has a fairly high 

cost, but its innovative cartridge-free 

design will save you a ton of money 

in the long run. It’s got a scanner and 

copier, plus Wi-Fi and USB connectivity. 

Replacement inks are cheap, working out 

at a mere 0.2p per page for mono text, 

and just 0.35p per page for colour.

 The original TS3 

gave Macs a new level 

of connectivity. Now 

the TS3 Plus offers 

an incredible 14 ports. 

The TS3 Plus is quite 

pricey, but its 10Gbps 

USB-C port and four 

USB-A ports (among others), make it 

our Thunderbolt dock of choice. The 

Thunderbolt 3 port supplies up to 85W, 

so it can even charge a 15in MacBook Pro. 

 This drive is the fastest portable SSD 

we’ve ever tested. Freecom claims its 

write speeds can reach 700MB/sec, but 

in our tests it blazed past that to reach 

713.8MB/sec write speeds and 907.3MB/

sec read speeds, thanks to its USB 3.1 

Gen 2 capability. It’s costly, but worth 

it if you feel the need for speed.

 The Netatmo 

Presence is an 

impressive outdoor 

security camera. Set 

in a sturdy housing, 

it’s built to defy the 

elements. It has a  

built-in floodlight to 

deter intruders, and a 100° field of view 

recorded in 1080p. There’s also an SD 

card included, making it easy to store 

and access your footage.

 Your MacBook 

needs protection, 

and the STM Kings 

backpack is the best 

way to guarantee 

that. Winner of 

MF316’s group test, 

it cleverly suspends 

your MacBook away from the floor to 

prevent bumps. With loads of storage, 

comfortable straps and a snazzy design, 

it’s a great all-rounder.

 MONITOR

Philips 328P6AUBREB
£400 philips.co.uk

 NETWORK STORAGE

Drobo 5D3
£749 drobo.co.uk

 PRINTER

Epson EcoTank ET-2600
£230 epson.co.uk

 ULTRA HD MONITOR

Philips 328P6VJEB 
£530 philips.co.uk

 WIRELESS ROUTER

Asus DSL-AC88U AC3100
£258 asus.com/uk

 IP CAMERA

Netatmo Presence
£250 netatmo.com

 EXTERNAL SSD

Freecom mSSD MAXX 512GB
£269 freecom.com

 THUNDERBOLT DOCK

CalDigit TS3 Plus
£349 caldigit.com/uk

 MACBOOK BAG

STM Kings
£100 stmgoods.com
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 With rich, warm 

sound that works 

with pretty much 

any genre, the KEF 

Egg speakers are 

ideal partners for 

your Mac. They 

support high-quality aptX Bluetooth too, 

making them perfect for wireless 

playback. Quirky design, solid build quality 

and support for external subwoofers 

makes them a great choice.

 If you own an iPhone 

7, you’ll know the 

struggle of trying to 

listen to music and 

charge your phone 

at the same time. 

These in-ear Lightning 

headphones solve that, thanks to their 

built-in charging port. They’ve also got 

great audio quality, excellent noise 

cancellation and will pause your tunes 

when removed from your ears.

 Dash cams help 

record what happens 

when you drive – 

useful if you’re in an 

RTC. If you’re in the 

market for one, this 

cam is one of the best. 

Packed with Wi-Fi, 

GPS logging, Full HD video and a night 

view as well, you get an awful lot for your 

money. There’s even a free 16GB memory 

card included in the box.

 Want a multiroom 

audio system in your 

home? This little speaker 

is your best option, 

hands down. It cleaned 

up in MF309’s group 

test, scoring five stars 

in every test category. 

From top-notch sound to 

tons of great features, the Zipp is a superb 

choice. It even boasts AirPlay for great 

integration with Macs and iOS devices. 

 Don’t be fooled by this 

mic’s small form factor; it 

punches hugely above its 

weight. Its close-up sound 

is intimate and bassy, and 

brings out the best in any 

voice. No matter whether 

you’re recording an 

interview, creating 

a podcast or just jamming with your 

band, its clarity and depth makes it 

easy to recommend.

 Love music as much 

as we do? Then you’ll 

want to get your mitts 

on one of these. It plays 

high-res audio files, 

and absolutely blows 

MP3 files out of the 

water. One listen will 

change the way you hear your audio 

tracks and, unlike other high-res audio 

players, it’s reasonably priced. It really 

will rock your world.

 Packed full of 

tracking features 

for a host of sports, 

and filled with 

genuinely insightful 

metrics, this is a 

fitness smartwatch 

for nearly any 

occasion. Its battery will last you days, 

perfect for the odd weekend hiking trip. 

With all this, it’s not hard to see why it 

won MF308’s group test. 

 DESKTOP SPEAKER

Kef Egg
£349 kef.com

 PORTABLE SPEAKER

Libratone Zipp
£249 libratone.com

 HIGH-RES AUDIO PLAYER

Pioneer XDP-30R
£350 pioneer-audiovisual.eu

 IN-EAR HEADPHONES

Pioneer Rayz Plus
£150 pioneerrayz.com

 PORTABLE BATTERY PACK

Apple iPhone 7 Smart  
Battery Case £99 apple.com/uk

 ACTION CAMERA

GoPro Hero6 Black
£400 gopro.com

 DASH CAM

Transcend DrivePro 230
£156 transcend-info.com

 MICROPHONE

Blue Microphones Raspberry
£170 bluemic.com

 FITNESS SMARTWATCH

Garmin Vivoactive HR
£240 garmin.com

 Despite that silly-

looking hump on its 

back, the official battery 

case for the iPhone 7 is 

rather impressive. It’s 

easy to fit, the buttons 

feel great, and the soft 

inner lining protects your phone against 

scratches. The built-in battery isn’t the 

largest capacity around, yet it has more 

than enough juice for busy days, and the 

bump is surprisingly comfy.

 GoPro’s latest 

action cam 

is a stunner, 

with 4K video 

at 60fps and  

1080p video at a 

whopping 240fps 

for fantastic slow-motion footage. It’s 

waterproof to 10 metres, has improved 

image stabilisation, wider dynamic range 

and better performance in low light than 

its Hero5 Black predecessor, too.
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 PHOTO EDITOR (MAC)

Affinity Photo
£48.99 serif.com

 VIDEO EDITOR (MAC)

Final Cut Pro X 10.3
£299.99 apple.com/uk 

 WEB DESIGN APP (MAC)

RapidWeaver 7
£79 realmacsoftware.com

 WRITING APP (MAC)

Scrivener
About £34 literatureandlatte.com

 UTILITY (MAC)

Carbon Copy Cloner 5
£31.10 bombich.com

 SYSTEM ENHANCEMENT (MAC)

Bartender 3
£11.10 macbartender.com

 OUTLINING APP (iOS)

OmniOutliner 3
£9.99 for Essentials, £38.99 for Premium

omnigroup.com

 PRODUCTIVITY APP (MAC/iOS)

Fantastical 2
£38.99 (Mac), £2.99 (iPhone)  

flexibits.com

 EMAIL MANAGER (MAC/iOS)

Spark
Free sparkmailapp.com

 It’s hard not to love 

Affinity Photo. Whether 

you fancy yourself as 

a seasoned pro or a 

photo novice, you’ll 

find this image editor powerful and easy 

to use. Its interface offers the perfect 

blend of ease of use and quick access to 

powerful features, and its useful batch 

processing is a great addition. An app 

that packs both power and practicality 

for less than £50? We’re in!

 Apple’s Final Cut Pro 

has always been a good 

option for video editors, 

and the latest version 

makes it even better. 

It introduces ‘roles’, which can be 

colour-coded to make your timeline’s 

components easier to navigate, something 

that’s further boosted by the streamlined 

interface. This version also supports the 

Touch Bar and wide colour gamut display 

on recent models of MacBook Pro.

 Ever since Apple stopped 

updating iWeb, Mac users 

have been searching for 

the ideal replacement. 

Well, look no further – 

it’s RapidWeaver. Don’t know how to 

write HTML and CSS code? No worries, 

RapidWeaver lets you design visually 

if you want to. You can build all kinds 

of page and publish to many different 

platforms, and extend the app’s functions 

with thousands of add-ons.

 It’s not often that a 

sequel is even better than 

its predecessor, but 

Scrivener 3 is a great 

example. Version 2 was 

already good, winning MF319’s group test, 

but version 3 adds so much. Its revamped 

interface is hugely customisable, its 

templates are fantastic, managing 

footnotes is a breeze, and the whole app 

is light and speedy. If you write, Scrivener 

is absolutely essential.

 When disaster strikes 

and your hard drive fails, 

having a backup can be 

a lifesaver. This app 

makes creating and 

restoring from backups an absolute 

breeze. It comes with a helpful guided 

restore feature, plus a Cloning Coach that 

monitors what you do and looks out for 

potential problems. If you’re looking to 

clone or back up your hard drive, this is 

the app you need.

 Some apps are so 

simple and effective 

that you don’t know 

how you lived without 

them. Bartender is 

one: it lets you choose what appears in 

the menu bar, and when things appear 

too. You can set triggers, such as an app 

only appearing when it’s updating, and 

rearrange items. Bartender’s settings are 

clear and concise. It sounds simple, but 

it’ll change the way you use your Mac.

 Feeling inbox anxiety? 

The solution could be 

Spark, an email app for 

Mac and iOS. It’s centred 

on a ‘smart inbox’, which 

prioritises your emails based on perceived 

importance – no more losing that vital 

work email among a sea of spam. You can 

snooze messages to be reminded about 

them later, and search your mailboxes by 

expressing yourself in natural language, 

too. And to top it all off, it’s free.

 If you find your 

calendar and reminders 

are getting out of 

control, Fantastical is the 

app for you. It supports 

natural language entry, so that you can 

enter events and reminders as you would 

speak and Fantastical will get to work. It’s 

got a nifty menu bar shortcut, plus a great 

interface, clever calendar management 

and a powerful iOS app to boot. 

 Sometimes you just 

need to get your ideas 

down quickly. For times 

like that, you need to 

get OmniOutliner 3. 

It’s extremely easy to get started, and 

enables you to quickly search and 

reorganise your notes. The Pro version 

adds encryption, automation, custom 

templates and much more. It’s the best 

way to jot down and organise your ideas.



PHOTO STREAM Shot of the month

 

We’re in a brilliant situation here 

at MacFormat Towers, in that 

you photography fans are 

supporting our Photo Stream 

page so enthusiastically, we’re 

struggling to choose individual 

images! This month, we’ve 

actually chosen a collective 

from Greg McMillan as he’s 

posted so many stunning shots. 

Greg actually runs his own 

iPhone photography website 

(shotoniphoneonly.com), so 

be sure to check out more 

of his fantastic shots online.

 

Share your pics with us using 

the hashtag #MacFormat on 

Instagram. In each issue, 

we’ll pick our favourite 

to feature on this page. 

GET ON INSTAGRAM

 Share your images with us by using the 

hashtag #MacFormat and we’ll print the 

best here in the magazine. While you’re 

there, follow @MacFormat (Twitter) and 

@MacFormatUK (Instagram).

 macformat.com  @macformat

WHAT  
TO DO! 

  1 Open an Instagram account.

 2  Follow @MacFormatUK (of course).

 3 Take a picture of, or with, your Apple kit.

 4 Share it on Instagram or Twitter.

 5 Use the hashtag #MacFormat.

 6 Feel the warm glow of an  

appreciative Apple community.

 7 See if you made it onto the  

pages of this very magazine!

 8 Repeat.

The Macmillan… 
… Collective!

BY MCMILLANPHOTO 
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Until next issue… GOODBYE

Adam Banks remembers when Apple swapped its 
own processors for industry-standard Intel chips

S
peaking at the Worldwide 

Developers Conference 

(WWDC) on 6 June 2005, 

Steve Jobs announced to the world that 

the Mac was abandoning the PowerPC 

processor line that Apple had been 

manufacturing in partnership with IBM 

and switching to the rival Intel chips 

used in Windows PCs. Amid much-

discussed delays to the PowerPC 970, aka 

G5, the move wasn’t entirely unexpected. 

But the decision came out of the blue, with 

Jobs revealing Mac OS X had secretly been 

tested on both platforms for years.

Despite the fractious relationship 

between Apple and IBM, PowerPC had 

given the Mac a new lease of life. In 1997, 

an Apple TV commercial showed Intel’s 

Pentium II lumbering along on the back 

of a snail, contrasting its reputation as ‘the 

fastest chip in the world’ with the PowerPC 

G3 – ‘up to twice as fast’. In 1999, Apple 

hailed the Power Mac G4 as ‘the first 

personal computer classified as a weapon 

by the US Government’. The claim, referring 

to a threshold for technology exports set 20 

years earlier, was cheeky, but true.

So, giving up on the G5 looked like 

snatching defeat from the jaws of victory. 

“I don’t know that Apple’s market share can 

survive another architecture shift,” worried 

Insight 64 analyst Nathan Brookwood, 

echoing the views of many. In fact, the 

following decade saw Mac shipments grow 

steadily, while the PC market declined.

Whether sticking with PowerPC would 

have been better or worse, we’ll never know. 

But a year later Jobs was able to report, again 

during WWDC, that the transition — aided 

by the introduction of “universal binaries”, 

allowing developers to release apps that 

worked on both old and new computers – 

was “the best and smoothest in the whole 

history of the industry”. 

Intel transition
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Apple’s shift to Intel chips 
was not entirely unexpected, 
despite previous criticisms.
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